






















































































































































































































































































































































































































































































































































































































































































































































































































































CHAPTER 10 

Guide Script Command Reference 

Specifying "Look For" Help 

10-140 

You can specify the text that appears above the search phrase entry box in the 
Full Access window and the search string using the <Look For Instruction> 
and <Look For String> commands. You can also specify text instructing the 
user to click the Search button and to select a topic using the <Look For Search 
Btn Instruction> and <Look For Results Instruction> commands. 

You can use the <Ignore>, <Exception>, and <Synonym> commands to control 
how Apple Guide searches your index terms when the user directs it to. When 
the user enters text in the search phrase entry box and then clicks Search, Apple 
Guide searches your index terms for a matching entry. You can optionally 
provide a list of words that Apple Guide should ignore (remove from the 
user's entered text string) when searching, a list of words that Apple Guide 
should not stem, and a list of words that are synonymous with another word. 

In general, Apple Guide first 

• removes from the string words that are specified in the ignore list. 

• stems the remaining words, except for words on the exception list. 

• searches the list of synonyms for the parsed phrase and, if it is found, 
replaces it with the equivalent index term and searches the index for this 
phrase. If it finds the phrase in the index, Apple Guide displays the topics 
associated with the matched index term. 

If Apple Guide does not find the phrase in the synonym list, then Apple Guide 

• searches the list of synonyms again, this time for each word in the parsed 
phrase. If it finds a word on the synonym list, it replaces the synonym with 
its equivalent index term. 

• searches the index for the entire phrase (with synonyms for individual words 
replaced by their equivalent index term). If it finds this phrase in the index, 
Apple Guide displays the topics associated with the index term. 

• searches for each word in the list of index terms. If Apple Guide finds a 
matching index term for more than one word in the phrase, Apple Guide 
intersects the results and displays any topics that are common to all words 
in the phrase. 

Specifying "Look For" Help 



CHAPTER 10 

Guide Script Command Reference 

For example, consider the phrase /iHow do I view files?" 

liHow do I Original phrase entered by user 
view files?" 

/iview files" 

uview file" 

11View file" 

Apple Guide removes words on ignore list (assuming uhow", 
lido", and Iii" are on ignore list) 

Apple Guide stems words (does not stem words on exception 
list) 

Apple Guide looks for phrase in synonym list and replaces 
with its index term if found (in this case, /iview file" is not in 
the synonym list) 

If the phrase is found in the synonym list, Apple Guide looks in the index for a 
matching index term and displays the topics associated with the phrase. 

If the phrase is not found in the synonym list, Apple Guide searches again. 

u open" li file" 

/iopen file" 

110pen" 
11file" 

Apple Guide looks for synonyms 

Apple Guide replaces each word with its index term if the 
word is a synonym (assuming "view" is a synonym for 
"open") 

Apple Guide looks for /iopen file" in list of index terms; if it 
doesn't find this term, Apple Guide continues searching 

Apple Guide looks for "open" in list of index terms 

Apple Guide looks for "file" in list of index terms 

If more than one word has a matching index term, Apple Guide displays the 
intersection of topics (if any). If Apple Guide finds a match for only one word, 
it displays a message indicating that it couldn't find an intersection for the 
word that didn't match and instructs the user to narrow the search phrase. 

<Look For Instruction> 

You can use the <Look For Instruction> command to specify a phrase that 
appears above the search phrase entry box in the Full Access window when 
Look For is active. 

<Look For Instruction> lookForlnstruction 
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lookF or Instruction 
A text string that specifies a phrase to display above the search 
phrase entry box. 

Apple Guide displays, above the search phrase entry box, the phrase defined in 
the lookForlnstruction parameter. Two lines of space are available for the Look 
For instruction; Apple Guide automatically wraps the text to fit. You can 
include a return character in the Look For instruction if you want to wrap the 
text at a specific location. If you specify an empty string, Apple Guide does not 
display a Look For instruction. 

This command is optional. If you omit this command, Apple Guide displays 
the phrase, 111. Click the arrow button to begin, then type one or more words to 
search for:" above the search phrase entry box. 

SPECIAL CONSIDERATIONS 

EXAMPLES 

SEE ALSO 

10-142 

The <Look For Instruction> command should appear once at most in your 
source files for a specific guide file. 

#specify a look for instruction 
<Look For Instruction> "1. Click the arrow button, then ~ 
enter a search phrase:" 

For information on specifying instructions for the Search button and the list of 
topics that appear in the Look For window, see the descriptions of the <Look 
For Search Btn Instruction> and <Look For Results Instruction> commands, on 
page 10-143 and page 10-144, respectively. 
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<Look For String> 

DESCRIPTION 

EXAMPLES 

You can use the <Look For String> command to specify the default search 
phrase that appears in the search phrase entry box in the Full Access window 
when Look For is active. 

<Look For String> searchPhrase 

searchPhrase A text string that specifies a phrase to display in the search 
phrase entry box. 

Apple Guide displays, in the search phrase entry box, the phrase defined in the 
searchPhrase parameter. 

This command is optional. If you omit this command, Apple Guide does not 
display any text in the search phrase entry box. 

#specify a default search phrase 
<Look For String> .. Enter string to search for here .. 

<Look For Search Btn Instruction> 

You can use the <Look For Search Btn Instruction> command to specify the 
default instruction that appears above the Search button in the Full Access 
window when Look For is active. 

<Look For Search Btn Instruction> buttonlnstruction 

buttonlnstruction 
A text string that specifies a phrase to display above the Search 
button. 
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Apple Guide displays, above the Search button, the phrase defined in the 
buttonlnstruction parameter. 

This command is optional. If you omit this command, Apple Guide displays 
the phrase "2. Click Search:" above the Search button. 

#specify a default instruction for the Search button 
<Look For Search Btn Instruction> "2. Click the Search button" 

<Look For Results Instruction> 

DESCRIPTION 

You can use the <Look For Results Instruction> command to specify a phrase 
that appears above the list of topics in the Full Access window when Look For 
is the active list and the user has performed a successful search. 

<Look For Results Instruction> resultslnstruction 

resultslnstruction 
A text string that specifies a phrase to display above the list of 
topics. 

Apple Guide displays, above the list of topics, the phrase defined in the 
resultslnstruction parameter. 

This command is optional. If you omit this command, Apple Guide displays 
the phrase 113. Click a phrase, then click OK:" above the list of topics when 
Look For is the active list. 

SPECIAL CONSIDERATIONS 

10-144 

The <Look For Results Instruction> command should appear once at most in 
your source files for a specific guide file. 
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EXAMPLES 

#specify an instruction above list of topics in Look For 
<Look For Results Instruction> 11 3. Click an item, then click OK ... 

SEE ALSO 

<Ignore> 

DESCRIPTION 

For information on specifying the instruction that appears above the search 
phrase entry box, see the description of the <Look For Instruction> command 
on page 10-141. For information on specifying the instruction that appears 
above the Search button, see the description of the <Look For Search Btn 
Instruction> command on page 10-143. 

You can use the <Ignore> command to specify a word or phrase that Apple 
Guide should ignore when parsing a search phrase entered by the user when 
Look For is active. 

<Ignore> ignoreWord 

ignore Word A text string that specifies a word or phrase to ignore when 
parsing the phrase entered by the user in the search phrase 
entry box. 

When a user enters a phrase in the search phrase entry box and then clicks 
Search, Apple Guide parses the entered phrase, removing any words specified 
by <Ignore> commands. (Then it stems common word variations to a root 
word; see the <Exception> command, described next, for more details.) Apple 
Guide also searches the list of synonyms and finally the list of index terms for 
an index term matching the parsed phrase. For example, if the user enters 
"How do I view files" and "How", "do", and "I" are on the ignore list 
(specified by <Ignore> commands), Apple Guide parses these words from the 
entered text, resulting in a search phrase "view files". Apple Guide then stems 
words (except for words in the exception list) in the phrase (resulting in "view 
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file"}, and looks for this phrase in the synonym list. If Apple Guide doesn't find 
the phrase in the synonym list, it continues the search process, as described 
earlier. 

Apple Guide automatically ignores (removes from the search phrase) numerals 
and punctuation marks. Using the previous example, Apple Guide parses the 
similar phrase "How, do I view 3 files?" to "view file". 

#specify words to ignore when parsing the phrase entered 
# by the user in the search phrase entry box 
<Ignore> "a" 
<Ignore> "how" 
<Ignore> "do" 
<Ignore> "I" 
<Ignore> "am" 
<Ignore> "an" 
<Ignore> "are" 
<Ignore> "aren't" 
<Ignore> "aren't" 
<Ignore> "at" 
<Ignore> "be" 
<Ignore> "cann 
<Ignore> "cannot" 
<Ignore> "can't" 
<Ignore> "can't" 
<Ignore> "did" 
<Ignore> "for" 
<Ignore> "in" 
<Ignore> "it" 
<Ignore> "its" 
<Ignore> "it's" 
<Ignore> "it'S 11 

<Ignore> "like" 
<Ignore> "of" 
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<Ignore> "on" 
<Ignore> "or" 
<Ignore> "not" 
<Ignore> "real" 
<Ignore> "really" 
<Ignore> "that" 
<Ignore> "the" 
<Ignore> "this" 
<Ignore> "to" 
<Ignore> "what" 
<Ignore> "why" 

You can use the <Exception> command to specify a word that should not be 
stemmed when Apple Guide parses a search phrase. You typically place a word 
on the exception list only if the stemmed form of the word matches an existing 
index term. 

<Exception> exception Word 

exception Word 
A text string that specifies a word that should not be stemmed 
when Apple Guide parses the search phrase. 

After a user enters a phrase in the search phrase entry box and then clicks 
Search, Apple Guide parses it. After removing any words specified by 
<Ignore> commands, Apple Guide parses the remaining string. When parsing, 
Apple Guide parses common word variations to a root word. If Apple Guide 
incorrectly stems a word, you usually specify the incorrectly stemmed word as 
a synonym for the index term. For example, Apple Guide stems 11 documents" 
to II docum", so you typically specify 11 docum" as a synonym for II documents /I 
using the <Synonym> command. Alternatively, you could prevent 
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Apple Guide from stemming the word udocuments" by placing it on the 
exception list. But it is usually more convenient to use synonyms. 

Thus, you typically use the <Exception> command only if the stemmed form of 
the word matches an existing index term. For example, assume ucustom" and 
"customizing" are defined as two separate index terms. To prevent Apple 
Guide from stemming "customizing" to its root form e~custom"), you can 
include "customizing" on the exception list. Thus, if the user enters 
"customizing" as a search phrase Apple Guide reports the correct matching 
index term. 

Also note that if a word or phrase in the exception list is a synonym (that you 
have specified using the <Synonym> command), Apple Guide replaces it with 
its equivalent index term when parsing. For example, if you have specified the 
word 11 editing" in an <Exception> command and also specified in a 
<Synonym> command that II editing" is synonymous with 11 copy editing", 
when the user enters "editing" in the search phrase, Apple Guide does not 

. stem "editing" but does replace it in the search phrase with "copy editing". 
Apple Guide then looks for an index term matching u copy editing". 

If Apple Guide finds a match, it displays the topics associated with the index 
term. 

SPECIAL CONSIDERATIONS 

EXAMPLES 

10-148 

Apple Guide performs stemming and uses the exception list only for guide 
files that specify the command <World Script> 0, 0. 

#specify exception words (word that shouldn't be stemmed) 
#you usually place an index term on the exception list 
# ONLY when the term would otherwise stem to another 
# index term or whose root form has an alternate meaning 
<Exception> "customizing" 
<Exception> "customize" 
<Exception> "editing" 
<Exception> "edition" 
<Exception> "editions" 
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You can use the <Synonym> command to specify a synonymous term for an 
existing index term. Apple Guide uses the synonym list when parsing a search 
phrase. 

<Synonym> indexTerm, synonym 

index Term 

synonym 

A text string that specifies an existing index term. 

A text string specifying a word or phrase that is synonymous 
with the index term specified in the indexTenn parameter. 

After a user enters a phrase in the search phrase entry box and clicks Search, 
Apple Guide parses it. After removing any words specified by <Ignore> 
commands and, except for words on the exception list, stemming common 
word variations to a root word, Apple Guide examines the list of synonyms for 
the phrase. If the phrase is a synonym specified by a <Synonym> command, 
Apple Guide replaces the synonym with its equivalent index term and searches 
for the phrase in the list of index terms. (Note that at this point in the search, 
Apple Guide searches the list of index terms only if it found the phrase on the 
synonym list.) 

If Apple Guide does not find the phrase in the synonym list, then Apple Guide 
looks in the synonym list again, this time for each word in the parsed phrase. If 
Apple Guide finds a word on the synonym list, it replaces the word in the 
phrase with its equivalent index term. Apple Guide then looks in the index for 
a term matching the parsed phrase (this time any words that are synonyms 
have been replaced by their equivalent index terms). If Apple Guide finds a 
match for the phrase, Apple Guide displays the topics for the index term. If it 
does not find the phrase in the index, Apple Guide searches the list of index 
terms for each word. If Apple Guide finds a matching index term for more than 
one word in the phrase, Apple Guide intersects the results and displays any 
topics that are common to both words. 

By using <Synonym> commands, you can increase the likelihood that the 
search phrase entered by the user will match an index term. For example, you 
can use a <Synonym> command to specify that the index term "copying" has a 
synonym II duplic" (which is the stemmed form of the word II duplicate"). In 
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this case, when the user enters the search phrase "duplicate" Apple Guide 
stems the word to "duplic", finds Jlduplic" on the synonym list and replaces it 
with "copying", then looks in the index for a term matching "copying". 

If Apple Guide finds a match, it displays the topics associated with the index 
term. 

SPECIAL CONSIDERATIONS 

10-150 

Apple Guide first looks in the synonym list for the reduced phrase, and only 
later (if necessary) looks for each word in the synonym list. For example, using 
the synonym list shown in Examples, if the user enters the phrase 11How do I 
open a file and print it?", Apple Guide parses this search phrase to "open file 
print" and looks for this phrase in the synonym list. Apple Guide does not find 
this phrase in the synonym list. Note that in this case Apple Guide does not 
replace "open file" with "opening" because Apple Guide looks in the synonym 
list for the entire phrase, not for phrases within the phrase. 

Because the phrase "open file print" isn't in the synonym list, Apple Guide 
looks in the list again, this time for each word ("open", "file", and "print"). 
The word 110pen" is a synonym (for "opening"), "file" is a synonym (for 
11documents"), and 11print" is a synonym (for 11printing"). Mter replacing each 
word with its equivalent index term (if any), the parsed phrase becomes 
"opening documents printing". Apple Guide looks in the index for this phrase, 
and in this example, does not find an index term for the phrase. So Apple 
Guide looks in the index for each word in the phrase and displays the 
intersection of the result. 

If no topics are common to both words, Apple Guide instructs the user to 
narrow the search. For example, the user might narrow the search to "How do 
I open a file?" In this case, Apple Guide reduces the phrase to "open file" and 
does replace the phrase with its equivalent index term, 11 opening". 

Note that for a multi-word index term that contains one or more words that are 
synonyms, you need to create a synonym which is an exact equivalent of the 
index term. For example, assume the synonym list is as shown in Examples. 
Because this list doesn't include a synonym for the index term 11 file server", 
when the user enters this phrase Apple Guide looks in the synonym list for 
the entire phrase. If it fails to find a synonym for the entire phrase, it looks 
in the synonym list for each word, replacing "file" with "documents". Apple 
Guide then looks in the index for the phrase "documents server". If it fails to 
find the phrase in the index, it then looks in the index for each word and 
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intersects the results. Thus, as demonstrated in this example, Apple Guide will 
not report a successful search for the phrase "file server". Therefore, you must 
create a synonym which is an exact equivalent of the index term 

<Synonym> "file server", "file server" 

In summary, you only need to create a synonym that is an exact equivalent of 
the index term if the index term contains multiple words, and one or more 
words in the phrase are synonyms for other index terms. 

#specify words that are synonymous with existing index term 
#specify an existing index term, then the synonym 
<Synonym> "copying", "clone" 
<Synonym> "copying", "duplic" 
<Synonym> "copying", "copy" 
<Synonym> "copying", "Copy command" 
<Synonym> "deleting", "Clear command" 
<Synonym> "deleting", "cut" 
<Synonym> "deleting", "Cut command" 
<Synonym> "deleting", "delet" 
<Synonym> "deleting" , "delete" 
<Synonym> "deleting", "get rid" 
<Synonym> "documents", "docum" 
<Synonym> "documents", "file" 
<Synonym> "memory", "RAM" 
<Synonym> "memory", "memory available 11 

<Synonym> "opening", "double click" 
<Synonym> "opening", "open" 
<Synonym> "opening", "Open command 11 

<Synonym> "opening", "open file" 
<Synonym> "openingn, "execute" 
<Synonym> "opening", 11 run" 
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<Synonym> .. Page Setup", .. landscape .. 
<Synonym> .. Page Setup", .. landscape print" 
<Synonym> .. Page Setup", "page format" 
<Synonym> "Page Setup", "Page Setup command" 
<Synonym> "Page Setup", "paper size .. 
<Synonym> "Page Setup", "portrait .. 
<Synonym> 11 Page Setup", .. printer choice .. 
<Synonym> .. Page Setup", "printer option .. 
<Synonym> 11 Page Setup", "print choice" 
<Synonym> 11 Page Setup", "print option" 
<Synonym> .. pop-up menu", .. pop up" 
<Synonym> 11 pop-up menu", .. pop up menu" 
<Synonym> 11 pop-up menu", .. popup" 
<Synonym> 11 pop-up menu", "popup menu" 
<Synonym> .. printer drivers .. , .. print driver" 
<Synonym> "printer drivers .. , .. print software .. 
<Synonym> "printer drivers .. , "printer driver .. 
<Synonym> "printer drivers", "printer software" 
<Synonym> "printing .. , "print" 
<Synonym> "printing .. , "printer .. 
<Synonym> "printing", "print file" 
<Synonym> 11 printing .. , "print window" 
<Synonym> "printing", "Print command" 
<Synonym> .. printing", "ImageWrit" 
<Synonym> "printing", "LaserWrit" 
<Synonym> .. printing", "spool" 
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10-152 

You can dynamically adjust the display of panels according to conditions that 
you specify by using the commands described in this section. For these 
commands (<If>, <Skip ff>, <Make Sure>, and <Start Making Sure>), you can 
specify as a condition function any condition defined with the <Define Context 
Check> command as well as Guide Maker's two built-in condition functions, 
checkBoxState and radioButtonState. 
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You can use the <If> command to specify a condition that determines whether 
statements that follow it are executed. 

<If> condition 

condition A condition function, either single or compound, that returns a 
Boolean value. Guide Script provides several built-in condition 
functions, such as radioButtonState and checkBoxState. 
You can also define your own condition functions using the 
<Define Context Check> command. 

You can use the <If> command, in combination with the <End If> command, to 
specify conditional execution of one or more commands. You can also use an 
<Else> command with an <If> command. Apple Guide executes the statements 
between an <If> command and an <End If> (or <Else>) command only if the 
condition evaluates to TRUE. Apple Guide executes the statements between an 
<Else> command and an <End If> command only if the condition evaluates to 
FALSE. 

This is the general structure of conditional execution: 

<If> condition 
statement(s) 

<Else> 
statement(s) 

<End if> 

#executed if true 

#executed if false 

You typically use conditional statements to dynamically adjust the sequence of 
panels presented to the user by specifying conditions that check the current 
state of user settings (such as radio buttons or checkboxes), other settings (such 
as the current date), or the state of the user's environment (such as whether a 
particular folder is open). 

You can specify a single condition function or combine several condition 
functions into a compound condition using Guide Script's built-in compound 
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operators AND, OR, and NOT; you can also use parentheses to further qualify the 
condition. For example: 

#example of AND functionA ( ) AND functionS() 
#example of OR functionA ( ) OR functions ( ) 
#example of NOT functionA ( ) AND NOT(functionB()) 
#example of all 

functionA() AND (NOT(functionB()) OR functionC()) 

The Standard Setup file defines various context checks (such as OpenWindow, 
InSystemFolder, and ControlPanelWinActi ve) that you can use to 
specify a condition in the <If> command (and also in the <Skip If>, <Make 
Sure>, and <Start Making Sure> commands). 

SPECIAL CONSIDERATIONS 

EXAMPLES 

Every <If> command must be balanced with a corresponding <End If> 
command. You cannot nest <If> commands more than four levels deep. 

<Define Sequence> "How do I create an index?" 
<Panel> "1st panel always display" 
<If> radioButtonState("Sook Index", "1st panel always display") 

<Panel> "Panel 2 if true" 
<Panel> "Panel 3 if true" 

<Else> 
<Panel> "Panel 2 if false" 
<Panel> "Panel 3 if false" 

<End if> 
<Panel> "last panel always display" 

<End Sequence> 
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<Define Sequence> "How do I create an index?" 
<Panel> "Index Choices 2" 
<If> radioButtonState("Book Index", "Index Choices 2") 

<Panel> "How do I create a book index?" 
<Else> 

<Panel> "How do I create a chapter index?" 
<End if> 

<End Sequence> 

<Define Sequence> "How do I create an index example 2?" 
<Panel> "Index Choices 2" 
<If> radioButtonState("Book Index", "Index Choices 2") 

<Panel> "Book index:intro" 
<Skip If> myCheckTemplateisOpen("index") 

<Panel> "index template:open" 
<Panel> "Book index:create" 

<End if> 
<End Sequence> 

<Define Sequence> "How do I create an index example 3?" 
<Panel> "Index Choices 2" 
<If> radioButtonState("Book Index", "Index Choices 2") 

<Panel> "Book index:intro" 
<If> NOT myCheckTemplateisOpen("index") 

<Panel> "index template:open" 
<Panel> "index template:create new" 

<End if> 
<Panel> "Book index:create" 

<End if> 
<End Sequence> 
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<Define Sequence> "How do I add a word to the dictionary?" 
<Panel> "AddWords intro" 
#OpenWindow is a context check defined in Standard Setup file 
<If> NOT OpenWindow( 'WAVE', "Dictionary") 

<Panel> "AddWords open dictionary" 
<End if> 
<Make Sure> OpenWindow( 'WAVE', "Dictionary"), "SwContinueSeq" 

<Panel> "AddWords summary" 
<End Sequence> 

SEE ALSO 

<Else> 

DESCRIPTION 

10-156 

For information on the <Define Context Check> command, see page 10-172. 
For information on the <End If> command, see page 10-158. The <Else> 
command is described next. 

You can use the <Else> command to specify statements to execute when a 
condition specified by a previous <If> command evaluates to FALSE. 

<Else> 

You can use the <Else> command, preceded by an <If> command, to specify 
conditional execution of one or more commands. Use the <End If> command 
to signal the end of the conditional execution of the <Else> branch of the 
condition. Apple Guide executes the statements between an <If> command and 
an <Else> command only if the condition evaluates to TRUE. Apple Guide 
executes the statements between an <Else> command and an <End If> 
command only if the condition evaluates to FALSE. 

This is the general structure of conditional execution: 
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<If> condition 
statement(s) 

<Else> 
statement(s) 

<End if> 

#executed if true 

#executed if false 

You typically use conditional statements to dynamically adjust the sequence of 
panels presented to the user by specifying conditions that check the current 
state of user settings (such as radio buttons or checkboxes), other settings (such 
as the current date), or the state of the user's environment (such as whether a 
particular folder is open). 

SPECIAL CONSIDERATIONS 

EXAMPLES 

Every <Else> command must be preceded with a corresponding <If> 
command and followed by an <End If> command. 

<Define Sequence> "How do I create an index?" 
<Panel> "1st panel always display" 
<If> radioButtonState("Book Index", "1st panel always display") 

<Panel> "Panel 2 if true" 
<Panel> "Panel 3 if true" 

<Else> 
<Panel> "Panel 2 if false" 
<Panel> "Panel 3 if false" 

<End if> 
<Panel> "last panel always display" 

<End Sequence> 
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<Define Sequence> "How do I create an index?" 
<Panel> "Index Choices 2" 
<If> radioButtonState("Book Index", "Index Choices 2") 

<Sequence> "How do I create a book index?" 
<Else> 

<Sequence> "How do I create a chapter index?" 
<End if> 

<End Sequence> 

SEE ALSO 

<End If> 

DESCRIPTION 

10-158 

For information on the <Define Context Check> command, see 
page 10-172. For information on the <If> command, see page 10-153. 

You use the <End If> command to specify the end of a sequence of commands 
in a conditional execution. 

<End If> 

You can use the <End If> command, in combination with an <If> command, to 
specify conditional execution of one or more commands. You can also use an 
<Else> command with an <If> command. Apple Guide executes the statements 
between an <If> command and an <End If> (or <Else>) command only if the 
condition evaluates to TRUE. Apple Guide executes the statements between an 
<Else> command and an <End If> command only if the condition evaluates to 
FALSE. 

This is the general structure of conditional execution: 
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<If> condition 
statement(s) 

<Else> 
statement(s) 

<End if> 

#executed if true 

#executed if false 

SPECIAL CONSIDERATIONS 

EXAMPLES 

Every <If> command must be balanced with a corresponding <End If> 
command. You cannot nest <If> commands more than four levels deep. 

<Define Sequence> "How do I create an index?" 
<Panel> "1st panel always display" 
<If> radioButtonState("Book Index", "1st panel always display") 

<Panel> "Panel 2 if true" 
<Panel> "Panel 3 if true" 

<Else> 
<Panel> "Panel 2 if false" 
<Panel> "Panel 3 if false" 

<End if> 
<Panel> "last panel always display" 

<End Sequence> 

<Define Sequence> "How do I create an index?" 
<Panel> "Index Choices 2" 
<If> radioButtonState("Book Index", "Index Choices 2") 

<Sequence> "How do I create a book index?" 
<Else> 

<Sequence> "How do I create a chapter index?" 
<End if> 

<End Sequence> 
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<Skip If> 

DESCRIPTION 

10-160 
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For information on the <li> and <Else> commands, see page 10-153 and 
page 10-156, respectively. 

You can use the <Skip If> command to specify a condition that determines 
whether the next panel should be displayed. 

<Skip If> condition 

condition A condition function, either single or compound, that returns a 
Boolean value. Guide Script provides several built-in condition 
functions, such as radioButtonState and checkBoxState. 
You can also define your own condition functions using the 
<Define Context Check> command. 

You can use the <Skip li> command to specify conditional display of the panel 
specified in the following <Panel> command. Apple Guide skips the panel 
(does not display it) only if the condition evaluates to TRUE. Apple Guide 
displays the panel if the condition evaluates to FALSE. 

This is the general structure of conditional display of a panel: 

<Skip If> condition 
#skip this panel if condition is true, display if false 

<Panel> "skip panel if condition true" 
#continue with other commands 
#always show this panel 
<Panel> "example panel" 

You typically use conditional statements to dynamically adjust the sequence of 
panels presented to the user by specifying conditions that check the current 
state of user settings (such as radio buttons or checkboxes), other settings (such 
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as the current date), or the state of the user's environment (such as whether a 
particular folder is open). 

You can specify a single condition function or combine several condition 
functions into a compound condition using Guide Script's built-in compound 
operators AND, OR, and NOT; you can also use parentheses to further qualify the 
condition. For example: 

#example of AND functionA ( ) AND functionS() 
#example of OR functionA ( ) OR functionS() 
#example of NOT functionA ( ) AND NOT(functionS()) 
#example of all 

functionA ( ) AND (NOT(functionS()) OR functionC()) 

SPECIAL CONSIDERATIONS 

If a <Skip If> command immediately precedes a <Make Sure> command, the 
<Make Sure> command is not evaluated if the <Skip If> condition is true. For 
example: 

<Skip If> condition 
#skip this panel (and any <Make Sure> commands) if condition is 
# true; if false, evaluate <Make Sure> commands 
<Make Sure> makeSureCondition, oopsSeq #eval if condition false 
<Make Sure> makeSureCondition2, oopsSeq #eval if condition false 

<Panel> "skip panel if condition true" 
#continue with other commands 
#always show this panel 
<Panel> "example panel" 

EXAMPLES 

<Define Sequence> "How do I use the dictionary?" 
#check whether the dictionary file is already open -
#if it isn't open, tell the user how to open it 
#(isDictionaryOpen is application-defined context check) 
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<Skip If> isDictionaryOpen("SurfWriter Dictionary") 
<Panel> "instruct user how to open dictionary" 

<Make Sure> isDictionaryOpen("SurfWriter Dictionary"), "SwContSeq" 
<Panel> "how to use the dictionary" 

<End Sequence> 

<Define Sequence> "How do I add a word to the thesaurus?" 
<Panel> "AddWords intro" 
#OpenWindow is a context check defined in Standard Setup file 
<Skip If> OpenWindow( 'WAVE', "Thesaurus") 

<Panel> "AddWords open thesaurus" 
<Make Sure> OpenWindow('WAVE', "Thesaurus"), "SwContinueSeq" 

<Panel> "AddWords summary" 
<End Sequence> 

SEE ALSO 

For information on the <Define Context Check> command, see page 10-172. 

<Make Sure> 

10-162 

You can use the <Make Sure> command to specify a condition that must be 
true in order for the next panel to be displayed and to specify a sequence to 
display (the sequence to display is referred to as an Oops or Continue 
sequence) if the condition isn't true. 

<Make Sure> condition, oopsOrContinueSequenceName 

condition A condition function, either single or compound, that returns a 
Boolean value. Guide Script provides several built-in condition 
functions, such as radioButtonState and checkBoxState. 
You can also define your own condition functions using the 
<Define Context Check> command. 

Specifying Conditional Execution 



DESCRIPTION 

CHAPTER 10 

Guide Script Command Reference 

oopsOrContinueSequenceName 
A text string specifying the sequence name of the sequence to 
display if the condition evaluates to FALSE. 

You can use the <Make Sure> command to specify conditional display of the 
panel specified in the <Panel> command that follows it. Apple Guide displays 
the panel only if the condition evaluates to TRUE. Apple Guide displays the 
specified sequence if the condition evaluates to FALSE. 

If the condition is false, the sequence Apple Guide displays is referred to as an 
Oops sequence (if the sequence instructs the user to correct the problem) or a 
Continue sequence (if the sequence performs the task for the user). Note that 
Apple Guide does not display the sequence title of an Oops or Continue 
sequence. Instead, Apple Guide displays the main sequence title as the Oops or 
Continue sequence title. 

Oops sequences should follow special rules. An Oops sequence should 
generally consist of one panel, giving the user information on how to correct 
the problem. Use a tag and indented body format for panels in an Oops 
sequence. Use the tag "Oops" or its localized equivalent. You should also 
provide an OK button centered under the panel text. You should provide a 
function that, when the user clicks the OK button in a panel of an Oops 
sequence, either returns the user to a previous panel giving instructions on 
how to correct the problem, or closes the Oops sequence and returns the user to 
the next panel in the original sequence. You can use the GoBack event function 
to do this. 

Continue sequences should also follow special rules. A Continue sequence 
should consist of one panel, telling the user that Apple Guide is performing the 
task for them. Use the full format for panel text and provide a Continue button 
centered under the panel text. To perform the task for the user, your panel 
definition typically includes an <On Panel Show> command. When Apple 
Guide displays a Continue panel with this command, it executes the specified 
event function, which should perform the task for the user. For example, an 
event function might send one or more Apple events to direct the target 
application to accomplish the task. You should also provide a function that 
closes the Continue sequence and returns the user to the next panel in the 
original sequence when the user clicks the Continue button in a panel of a 
Continue sequence. You can use the GoBack event function to do this. 
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This is the general structure of conditional display of a panel using the <Make 
Sure> command: 

<Make Sure> condition, oopsOrContinueSequenceName 
#(if condition is false, 
# display the oopsOrContinueSequenceName sequence) 
# if condition is true, display this panel 

<Panel> "show panel if condition true" 
#continue with other commands 
#always show this panel 
<Panel> "example panel" 

You typically use the <Make Sure> command to ensure that a particular 
condition is true before allowing the user to continue. You define an Oops 
sequence to guide the user toward correcting the problem and a Continue 
sequence if you can perform the task for the user. For example, if a panel 
requires that a particular window be open, you can use a <Make Sure> 
command with a condition function that tests whether the window is open. 
If so, the user can continue with the next panel. Otherwise, you can either 
provide an Oops sequence that instructs the user to open the window before 
continuing or provide a Continue sequence that opens the window for the user. 

The <Make Sure> command applies only to the next panel in the sequence 
(however, the GoBack function may update the condition, as explained in the 
following paragraphs). You can combine <Make Sure> and <Skip If> 
commands and apply them to a single panel. You should not compound 
functions in the condition parameter for the <Make Sure> command. Instead, 
if needed you can apply several <Make Sure> conditions, each with their own 
Oops or Continue sequence, to a single panel. 

To apply a Make Sure condition to several panels, use the <Start Making Sure> 
and <End Making Sure> commands. 

When the user clicks a navigation arrow to move to the next panel and the next 
panel is preceded by a <Make Sure> command, Apple Guide checks the 
condition associated with the <Make Sure> command before displaying the 
next panel. If the condition is false, Apple Guide displays the associated Oops 
or Continue sequence. If you use the GoBack event function, when the user 
clicks OK in the Oops sequence or Continue in the Continue sequence the 
GoBack function determines whether the condition has been met. If so, the 
GoBack function returns the user to the next panel in the original sequence. 
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If the condition has not been met, then the GoBack function works backwards 
from the original panel until it finds a panel that it can show. 

For example, consider a sequence that contains these statements: 

<Panel> "first panel" 
<Make Sure> conditionl, oopsSequenceName 
# if condition! is true, display this panel 

<Panel> "show panel if condition true" 
#continue with other commands 
<Panel> 11 Some panel" 
<Make Sure> condition2, oops2SequenceName 
# if condition2 is true, display this panel 

<Panel> "example panel" 

If the condition specified by condition1 is true, Apple Guide displays the 
following panel and other panels as the user navigates through them. If the 
user is viewing the panel named "some panel" in this example and then clicks 
the right arrow to navigate to the panel named "example panel", Apple Guide 
evaluates the condition specified by condition2. If the condition is true, Apple 
Guide displays the next panel ("example panel"). If the condition isn't true, 
Apple Guide displays the sequence named oops 2 SequenceName and allows 
the user to correct the problem. If the user fixes the problem and then clicks 
OK, the GoBack function proceeds to the next panel ("example panel"). If the 
user clicks OK but has not fixed the problem, the GoBack function returns to 
"some panel". 

The Oops sequence should tell the user how to correct the problem associated 
with the condition. Apple Guide hides the current panel while the Oops 
sequence is displayed. Once the user satisfies the condition specified in the 
<Make Sure> command, you can close the Oops sequence and return to the 
original sequence (the panel following the <Make Sure> command). 

The Continue sequence should inform the user that Apple Guide is performing 
the task for the user. Note that if the user clicks the Continue button before the 
task completes, Apple Guide may return the user to a previous panel rather 
than the next panel in the sequence. Thus, your Continue panel should always 
instruct the user to wait until the task completes before clicking the Continue 
button. Once the task is complete and the user clicks Continue, you can close 
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the Continue sequence and return to the original sequence (the panel following 
the <Make Sure> command). 

The file Standard Setup is provided with Guide Maker. This file defines the 
GoBack function. If you include the Standard Setup file in your build file, you 
can automatically use the GoBack function as needed in your source files. 

The Standard Setup file also defines various context checks (such as 
OpenWindow, InSystemFolder, and ControlPanelWinActive) that you 
can use to specify a condition in the <Make Sure> command (and also in the 
<If>, <Skip If>, and <Start Making Sure> commands). 

SPECIAL CONSIDERATIONS 

EXAMPLES 

10-166 

You cannot apply a <Make Sure> condition to the first panel in a <Jump> 
sequence. For this reason, be careful when applying <Skip If> and <Make 
Sure> commands to introductory panels because the restriction on the <Make 
Sure> command applies to any panel that may appear first. 

If you specify more than one <Make Sure> command for a panel, Apple Guide 
evaluates the conditions in the reverse order from the way they appear in your 
source file. That is, the <Make Sure> command closest to the <Panel> 
command is evaluated first. 

#sequence definition for an Oops sequence 
<Define Sequence> "instruct user to open dictionary" 

<Sequence Prompt Set> NONE 
<Define Panel> "Oops panel: Open dictionary .. 

<Format> 11 0opsTag" #a defined format 
Oops 

<Format> 11 00psTextn #a defined format 
You need to open the SurfWriter Dictionary. 
Click OK for instructions (or open the 
dictionary, then click OK). 

<Standard Button> .. OK .. , Center, GoBack() 
<End Panel> 

<End Sequence> 
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#sequence definition that uses <Make Sure> and Oops 
<Define Sequence> "How do I use the dictionary?" 

<Panel> "intro to dictionary" 
#now make sure that the dictionary file is open before 
# allowing the user to go to the next panel; 
# if it isn't open, tell the user how to open it 
# by providing an Oops sequence 
#(isDictionaryOpen is application-defined context check) 
<Make Sure> isDictionaryOpen( 11 SurfWriter Dictionary~~), 

"instruct user to open dictionary" #oops seq. 
<Panel> 11 finding a word in the dictionary" 

<Panel> 11 Special dictionaries" 
<End Sequence> 

#sequence definition for a Continue sequence 
<Define Sequence> "open dictionary for the user" 

<Seq Nav Button Set> NONE 
<Define Panel> "Continue panel: Opening dictionary" 

<Format> 11 Full" #a defined format 
Please wait a moment. Apple Guide is assisting you by 
opening the SurfWriter dictionary. 

#this 3D button (Continue) is in Standard Resources 
<3D Button> 1070, 1072, Center, GoBack() 
#use prompt text: 11 Wait until the dictionary is open, 
#then click Continue." 
<Panel Prompt> "Wait while AG opens dictionary" 
#specify event function that Apple Guide executes 
# upon showing the panel; specify your own event 
# function or a built-in event function 
<On Panel Show> DoScript("openSWDictionary 11

) 

<End Panel> 
<End Sequence> 
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#sequence definition that uses <Make Sure> and Continue 
<Define Sequence> "How do I use the dictionary?" 

<Panel> "intra to dictionary" 
#now make sure that the dictionary file is open before 
# allowing the user to go to the next panel; 
# if it isn't open, open it for the user 
# by providing a Continue sequence 
#(isDictionaryOpen is application-defined context check) 
<Make Sure> isDictionaryOpen("SurfWriter Dictionary"), 

"open dictionary for the user" #continue seq. 
<Panel> "finding a word in the dictionary" 
<Panel> "special dictionaries" 

<End Sequence> 

For information on the <Define Context Check>, <Define Event>, and <On 
Panel Show> commands, see page 10-172, page 10-178, and page 10-185. 

<Start Making Sure> 

10-168 

You can use the <Start Making Sure> command to specify a condition that 
must be true for all panels preceding the next <End Making Sure> command in 
order for each panel to be displayed. Like the <Make Sure> command, you also 
specify an Oops or Continue sequence to display if the condition isn't true. 

<Start Making Sure> condition, oopsOrContinueSequenceName 

condition A condition function, either single or compound, that returns a 
Boolean value. Guide Script provides several built-in condition 
functions, such as radioButtonState and checkBoxState. 
You can also define your own condition functions using the 
<Define Context Check> command. 
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oopsOrContinueSequenceName 
A text string specifying the sequence name of the sequence to 
display. 

You can use the <Start Making Sure> command to specify conditional display 
of all panels that precede the next <End Making Sure> command. Apple Guide 
displays a panel only if the condition evaluates to TRUE. Apple Guide displays 
the specified sequence if the condition evaluates to FALSE. 

This is the general structure of conditional display of a panel using the <Make 
Sure> command: 

#specify a condition that must be true for all panels 
# between <Start Making Sure> and <End Making Sure> 
<Start Making Sure> condition, oopsOrContinueSequenceName 
#for each panel, display the panel if the condition is true 
(if condition is false, display oopsOrContinueSequenceName seq.) 

<Panel> "show panel 1 if condition true .. 
<Panel> "show panel 2 if condition still true .. 
<Panel> "show panel 3 if condition still true" 

<End Making Sure> 
#always show this panel 
<Panel> .. example panel .. 

You typically use the <Start Making Sure> command to ensure that a particular 
condition is true for a series of panels. You define an Oops sequence to guide 
the user toward correcting the problem before allowing the user to continue. 
You define a Continue sequence to perform the task for the user. For example, 
if all panels in a series require that a particular window remain open, you can 
use a <Start Making Sure> command with a condition function that tests 
whether the window is open. If it is, the user can continue with the next panel. 
Otherwise, you can either provide an Oops sequence that instructs the user to 
open the window before continuing or provide a Continue sequence that opens 
the window for the user. 

The <Start Making Sure> command applies to all panels preceding an <End 
Making Sure> command. You can also apply <Make Sure>, <If>, and <Skip If> 
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commands to any panel in the sequence. You should not compound functions 
in the condition parameter for the <Start Making Sure> command. Instead, if 
needed you can apply several <Start Making Sure> conditions, each with their 
own Oops or Continue sequence, to a single panel. 

Apple Guide continues to update conditions specified in <Start Making Sure> 
commands as the user moves through a sequence. 

Apple Guide hides the current panel while the Oops or Continue sequence is 
displayed. Once the condition specified in the <Start Making Sure> command 
is performed and the user clicks OK or Continue, you can close the Oops or 
Continue sequence and return the user to the original sequence (the panel 
following the <Make Sure> command). 

SPECIAL CONSIDERATIONS 

You cannot apply a <Start Making Sure> condition to the first panel in a 
<Jump> sequence. Be careful when applying <Skip If> commands and <Start 
Making Sure> commands to introductory panels; the restriction on the 
<Start Making Sure> command applies to any panel that may appear first. 

A <Start Making Sure> command must always be matched by a following 
<End Making Sure> command. 

If you specify a series of commands that includes a <Start Making Sure> 
command, a <Jump Sequence> command, and an <End Making Sure> 
command, the <Start Making Sure> condition will not apply to any panels 
referenced through the <Jump Sequence> command. 

EXAMPLES 

<Define Sequence> "How do I use the dictionary?" 
<Panel> "intra to dictionary" 
#specify a condition that must be true for all panels 
# between <Start Making Sure> and <End Making Sure> 
#(isDictionaryOpen is an application-defined context check) 
<Start Making Sure> isDictionaryOpen("SurfWriter Dictionary"), 

10-170 

"instruct user to open dictionary" #oops 
<Panel> "finding a word in the dictionary" 
<Panel> "finding synonyms in the dictionary" 
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<Panel> "getting a list of adverbs from the dictionary" 
<End Making Sure> 

<End Sequence> 

SEE ALSO 

For information on the <Define Context Check> command, see page 10-172. 

<End Making Sure> 

DESCRIPTION 

You can use the <End Making Sure> command to end the condition checking 
specified in a previous <Start Making Sure> command. 

<End Making Sure> 

The <End Making Sure> command specifies the end of condition checking 
begun by a previous <Start Making Sure> command. Apple Guide stops 
evaluating the condition specified by a <Start Making Sure> command when it 
encounters an <End Making Sure> command. 

SPECIAL CONSIDERATIONS 

A <Start Making Sure> command must always be matched by a following 
<End Making Sure> command. 

EXAMPLES 

<Define Sequence> "How do I use the dictionary?" 
<Panel> "intro to dictionary" 
#specify a condition that must be true for all panels 
# between <Start Making Sure> and <End Making Sure> 
#(isDictionaryOpen is an application-defined context check) 
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<Start Making Sure> isDictionaryOpen("SurfWriter Dictionary"), 
"instruct user how to open dictionary" #oops 

<Panel> "finding a word in the dictionary" 
<Panel> "finding synonyms in the dictionary" 
<Panel> "getting a list of adverbs from the dictionary" 

<End Making Sure> 
<End Sequence> 

SEE ALSO 

For information on the <Start Making Sure> command, see page 10-168. 

Defining and Using Context Checks 

You can define your own condition functions (context checks) using the 
<Define Context Check> command. In addition, Guide Maker provides two 
built-in condition functions, checkBoxState and radioButtonState. You 
can specify condition functions in the <If>, <Skip If>, <Make Sure>, and <Start 
Making Sure> commands. 

<Define Context Check> 

10-172 

You can use the <Define Context Check> command to define a context check 
that you can use in later commands to dynamically adjust the display of panels. 

<Define Context Check> contextCheckName, codeResSpec [, targetApp) 
[ , additionalParam ] [ , additionalParam ] 
[ , ... ] 

contextCheckName 
A text string specifying the name of this context check. The 
name must be a single-word string (no spaces) and should be as 
descriptive as possible. 
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codeResSpec A four-character sequence specifying the resource name of an 
external code module that contains the code that performs the 
context check. (An external module must have a four-character 
resource name, a resource type of I extm I , and a resource 10 
greater than 2000.) 

targetApp A four-character sequence specifying the signature of the target 
application or the constant FRONT. This parameter is optional. If 
it is omitted, Apple Guide uses FRONT as the default. 

additionalParam 
One or more additional parameters, of the form 

data type [:default value] 

where data type is a constant with an optional default value. To 
specify the data type, use one of these constants: 
SHORT 
LONG 
PSTRING 
LPSTRING 
OS TYPE 

To specify a default value, include a colon followed by the value 
after the data type. By default, if you specify a value as SHORT 
or LONG, the value is treated as a decimal number. To specify a 
hexadecimal number, precede the number by Ox. If you provide 
a default value for a parameter, then the caller does not specify 
this parameter when the context check is used in another 
command. 

For strings, you should specify LPSTRING if you intend for the 
string to be localized. Guide Maker's Localize utility extracts 
from the <Define Context Check> command strings that are 
specified by LPSTRING but not strings specified by PSTRING. 

Avoid providing a default value if you specify LPSTRING or 
PSTRING as the data type of the additional parameter. Instead, 
require that the caller of the context check provide this 
information. 

The <Define Context Check> command defines a context check. You typically 
use a context check to dynamically adjust the display of panels based on 
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conditions that Apple Guide or your context check can detect. For example, 
Guide Maker provides two built-in context checks, checkBoxState and 
radioButtonState, that return the state of a checkbox or radio button. 

After defining a context check, you can reference the context check in <If>, 
<Skip If>, <Make Sure>, and <Start Making Sure> commands. 

Apple Guide passes parameters specified in additionalParam and following 
parameters to the context check. The context check should take the appropriate 
action and then return a value of TRUE or FALSE. 

The file Standard Resources is provided with Guide Maker. This file contains 
external code modules, defined as resources of type ' extm' . The Standard 
Setup file contains <Define Context Check> commands that reference each 
external module. The context checks defined by these commands can be used 
to specify a condition in <If>, <Skip If>, <Make Sure>, and <Start Making 
Sure> commands. 

#define a context check called "isSomethingActive" 
#(with resource name 'MyEM') 
# that has 3 parameters: the first (short) and 
# third (long) are specified by the context check to have 
# default values of 10 and 30 
# the second parameter is of type LPSTRING and the caller 
# is required to provide this value 
<Define Context Check> "isSomethingActive", 'MyEM', 'WAVE', 

SHORT:lO, LPSTRING, LONG:30 
<Define Sequence> "using the ruler" 

<If> isSomethingActive("Objectl") 
<Panel> "Panel to display if context check is true" 

<Else> 
<Panel> "Panel to display if context check is false" 

<End If> 
<End Sequence> 
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For information on the <If>, <Skip If>, <Make Sure>, and <Start Making Sure> 
commands, see page 10-153, page 10-160, page 10-162, and page 10-168, 
respectively. 

checkBoxState 

DESCRIPTION 

You can use Guide Maker's built-in context check for checkboxes, 
checkBoxState, to determine the state of a checkbox. 

checkBoxState (button Title, panelName) 

button Title 

panelName 

A string specifying the checkbox's title, as defined in a 
<Checkbox> command. 

A string specifying on which panel the checkbox appears. 

The checkBoxState context check returns the state of the specified checkbox. 
It returns TRUE if the checkbox state is on, FALSE if the checkbox is off. You 
usually use the checkBoxState context check in conjunction with <If>, 
<Else>, or <Skip If> commands. 

EXAMPLES 

<Define Panel> "Index Choices 2" 

Index choices: 

<Checkbox> "Include See Also entries", TRUE 
<Checkbox> "Include starting and ending page ranges", FALSE 

<End Panel> 
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<Define Sequence> "How do I create an index?" 
<Panel> "Index Choices 2" 
<If> checkBoxState("Include See Also entries", ~ 

"Index Choices 2") 
<Panel> "How do I create See Also entries?") 

<End if> 
<If> checkBoxState("Include starting and ending page ranges", ~ 

"Index Choices 2") 
<Panel> "How do I create page ranges for an index entry?" 

<End if> 
<End Sequence> 

SEE ALSO 

For information on the <If>, <Else>, and <Skip ff> commands, see page 10-153, 
page 10-156, and page 10-160, respectively. For information on the <Checkbox> 
command, see page 10-69. 

radioButtonState 

DESCRIPTION 

10-176 

You can use Guide Maker's built-in context check for radio buttons, 
radioButtonState, to determine the state of a radio button. 

radioButtonState (buttonTitle, panelName) 

button Title 

pane/Name 

A string specifying the radio button's title, as defined in a 
<Radio Button> command. 

A string specifying on which panel the radio button appears. 

The radioButtonState context check returns the state of the specified radio 
button. It returns TRUE if the radio button is on, FALSE if the radio button is 
off. You usually use the radioButtonState context check in conjunction 
with <If>, <Else>, or <Skip If> commands. 
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<Define Panel> "Index Choices 2 .. 
#Label for this group of radio buttons 
What type of index do you want to create? 

<Radio Button> "Book Index .. , TRUE 
<Radio Button> "Chapter Index", FALSE 

<End Panel> 

<Define Sequence> "How do I create an index? .. 
<Panel> .. Index Choices 2 .. 
<If> radioButtonState( .. Book Index .. , .. Index Choices 2 11

) 

<Panel> .. How do I create a book index? .. 
<Else> 

<Panel> .. How do I create a chapter index?" 
<End if> 

<End Sequence> 

For information on the <If>, <Else>, and <Skip If> commands, see page 10-153, 
page 10-156, and page 10-160, respectively. For information on the <Radio 
Button> command, see page 10-64. 

Specifying Events 

You can specify an event function and associate it with a particular panel by 
using the commands described in this section. This section also describes 
Guide Maker's built-in event functions. 

Specifying Events 10-177 

• G> 
c: 
c: 
(1) 

en 
(') 
::::!. 

"S 
0 
0 
3 
3 
p) 
:::J c. 
:D 

~ 
<D 
:::J 
(') 
(1) 



CHAPTER 10 

Guide Script Command Reference 

<Define Event> 

DESCRIPTION 

10-178 

You can use the <Define Event> command to define an event function for use 
with the following commands: <Standard Button>, <3D Button>, <Define Nav 
Button>, <Hot Text>, <Hot Rectangle>, <Hot Object>, <On Panel Create>, <On 
Panel Destroy>, <On Panel Show>, and <On Panel Hide>. 

<Define Event> event Name, targetApp, eventClass, even tiD 
[ , IOPTData 1 [ , optKey] [ , opt Data] 

event Name 

targetApp 

event Class 

even tiD 

IOPTData 

opt Key 

opt Data 

A text string specifying the name of this event function. 

A four-character sequence specifying the signature of the target 
application or the constant FRONT. You can use the constant 
FRONT to specify the frontmost application. You can use the 
signature 1 s * * * I to send an Apple event to Apple Guide. 

A four-character sequence that identifies the event class. 

A four-character sequence that identifies the event ID. 

A short integer that provides data for the I IOPT I keyword. 
This parameter is optional. If you provide it, Guide Maker adds 
to the Apple event a parameter whose keyword is I IOPT I and 
whose data contains the value you specify in the IOPTData 
parameter. 

A four-character sequence that identifies an additional keyword 
for the event. This parameter is optional. 

A string providing additional data for the Apple event 
parameter whose keyword is specified by optKey. This 
parameter is optional. If you provide the opt Key and opt Data 
parameters, Guide Maker adds to the Apple event a parameter 
whose keyword is specified by optKey and whose data contains 
the value you specify in the optData parameter. 

The <Define Event> command defines an event function. You typically 
associate an event function with another button-defining command, such as 
<Standard Button> or <3D Button>. Event functions are used to send an Apple 
event to a target application, requesting it to perform some action. When the 
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user clicks a button, Apple Guide calls the event function associated with that 
particular button and then sends the event to the specified target application. 

In addition to specifying the event class and event ID, you can add two Apple 
event parameters to the event you send by using the IOPTData, optKey, and 
optData parameters. One parameter is identified by the ' !OPT' keyword, and 
you provide data for this Apple event parameter in the IOPTData parameter. In 
the optKey parameter, you provide the keyword for the second parameter and 
in the optData parameter you provide data for this Apple event parameter. 

For example, if an event requires a direct object, specify the keyword for the 
direct object in the optKey parameter and specify its data in the optData 
parameter. Optionally, you can allow the caller of the event function to provide 
the data for the opt Data parameter. If you do this, the event definition must 
leave the opt Data parameter blank, and the caller must provide a string 
surrounded by quotes inside of the parentheses of the event function. As an 
example, for an event function called doOpenDocmt, the caller specifies the 
data for the direct object like this: doOpenDocmt ( "HD: Reports 
folder: Quarter 1 Report" ) . 

Guide Maker provides the following built-in event functions: DoScript, 
GoPanel,LaunchNewSequence,LaunchNewSequenceNewWindo~ 

PlaySound, QuitTopicOops, and StartTopicOops. Each built-in event 
function corresponds to a specific Apple event that is directed to Apple Guide. 

Apple Guide also supports a number of other events. These events are defined 
in the Standard Setup file. If your build file includes the Standard Setup file, 
then you can specify any of the events defined in that file. 

#define doButtonlAction as an event function that sends to 
# the app with signature 'WAVE' (SurfWriter) the Apple event 
#defined by event class 'sfwr' and event ID 'actl' 
<Define Event> "doButtonlAction", 'WAVE', 'sfwr', 'actl' 

<Define Panel> "Example Panel" 
<Standard Button> "Create Chapter Index", Point(SO,lOO), 

doButtonlAction() 
<End Panel> 
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#define doOpenDocmt as an event function that sends to 
# the app with signature 'WAVE' (SurfWriter) the 
# Open Documents event. Note that the Open Documents event 
# expects a direct object (the name of the file to open) 
# as a parameter. This event definition specifies the keyword of the 
# direct object and the caller specifies its data. 
<Define Event> "doOpenDocmt", 'WAVE', 'aevt', 'odoc' ,,'----' 

<Define Panel> "Example Panel 3" 
To accomplish this task, do this: 
Very informative instructions here. 

#place Open button left-justified on panel 
<3D Button> "OpenButtonUpPict", "OpenButtonDownPict", LEFT, ., 

doOpenDocmt("HD:SurfWriter folder:SampleReport 11
) 

<End Panel> 

#define an event function that sends to 
# the app with signature 'WAVE' (SurfWriter) the Apple event 
#defined by event class 'sfwr' and event ID 'act2' 
# This event expects two parameters: the number 2530 is the 
#data for the 'IOPT' keyword; the other additional parameter has 
# the keyword 'kysf' and "info for kysf parameter" as data. 
<Define Event> "doButton2Action", 'WAVE', 'sfwr', 'act2', ., 

2530, ., 
'kysf', "info for kysf parameter" 

<Define Panel> "Example Panel" 
<Standard Button> "Create Chapter Index", Point(50,100),., 

doButton2Action() 
<End Panel> 
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For information on Guide Maker's built-in event functions, see "Built-in Event 
Functions" on page 10-188. For information on the <Standard Button> and 
<3D Button> commands, see page 10-57 and page 10-60, respectively. For 
information on specifying event functions for hot objects, see "Creating Hot 
Items" beginning on page 10-119. For information on specifying event 
functions for the <On Panel Create> and related commands, see page 10-183. 

<Define Event List> 

DESCRIPTION 

You can use the <Define Event List> command to specify a sequence of events 
(an event list). You can use an event list as a parameter for the 
<Standard Button>, <3D Button>, <Define Nav Button>, and 
<On Panel Create> commands. 

<Define Event List> eventListName 1 event1 [ 1 event2] [ 1 event3] 
[ I event4] [ 1 eventS] [ 1 event6 ] 

eventListName A text string specifying the name of this event list. 

event1 A name of an event function. Include any parameters expected 
by the function in parentheses following its name. 

event2 -event6 
The parameters event2 through event6 can each specify the name 
of an event function (and any parameters expected by the 
function in parentheses following its name). These parameters 
are optional. 

The <Define Event List> command specifies one or more event functions. You 
typically associate an event list with another button-defining command, such 
as <Standard Button> or <3D Button>. When the user clicks a button, Apple 
Guide calls the event function or event list associated with that particular 
button. Event lists are usually used to perform a series of actions, such as 
sending one or more Apple events to a target application, requesting it to 
perform various actions. 
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You can specify up to six event functions in an event list. All events in an event 
list must be static, that is, they cannot require any parameters from the caller 
(other than the parameters already provided in the specification of the event in 
the event list). 

Guide Maker provides these built-in event functions: DoScript, GoPanel, 
LaunchNewSequence,LaunchNewSequenceNewWindo~PlaySound, 

StartTopicOops, and Qui tTopicOops. 

Apple Guide also supports a number of other events, defined in the Standard 
Setup file. If your build file includes the Standard Setup file, then you can 
specify any of the events defined in that file. 

SPECIAL CONSIDERATIONS 

EXAMPLES 

SEE ALSO 

10-182 

Any event functions specified in parameters eventl through event6 must refer to 
a event function defined with the <Define Event> command or to one of Guide 
Maker's built-in event functions. 

#an event list specifying a series of event functions 
<Define Event List> "ClickAndGo", PlaySound(lOOO), 

LaunchNewSequence("My sequence name"), 
doMyButtonAction(), 
DoScript("AppleScriptOne 11

) 

<Define Panel> "Example Panel" 
<Standard Button> "Create Chapter Index", Point(SO,lOO), 

ClickAndGo() 
<End Panel> 

For information on Guide Maker's built-in event functions, see ~~Built-in Event 
Functions" on page 10-188. For information on the <Standard Button> and <30 
Button> commands, see page 10-57 and page 10-60, respectively. 
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<On Panel Create> 

DESCRimON 

EXAMPLES 

You can use the <On Panel Create> command to define an event function that 
Apple Guide executes before displaying a panel. 

<On Panel Create> eventFunction 

eventFunction An event function or event list. 

The <On Panel Create> command defines an event function or event list for a 
panel. Apple Guide executes the event function when Apple Guide creates the 
panel to which it is attached. Apple Guide executes the event function before 
displaying the panel on the screen. Event functions are usually used to send an 
Apple event to a target application, requesting it to perform some action. 

You can use multiple <On Panel Create> commands per panel. Apple Guide 
executes any event functions in the order in which the <On Panel Create> 
command appears in your panel definition. 

#define doExamplePanelAction as an event function that sends to 
#the app with signature 'WAVE' (SurfWriter) the Apple event 
#defined by event class 'sfwr' and event ID 'actl' 
<Define Event> "doExamplePanelAction", 'WAVE', 'sfwr', 'actl' 

<Define Panel> "Example Panel" 
<On Panel Create> doExamplePanelAction() 
<On Panel Create> PlaySound(lOOO) 

<End Panel> 
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For information on Guide Maker's built-in event functions, see 1/Built-in Event 
Functions" on page 10-188. For information on the <Define Event> and <Define 
Event List> commands, see page 10-178 and page 10-181, respectively. 

<On Panel Destroy> 

DESCRIPTION 

EXAMPLES 

You can use the <On Panel Destroy> command to define an event function that 
Apple Guide executes when destroying a panel. It executes the event after 
removing the panel from the screen. 

<On Panel Destroy> eventFunction 

eventFunction An event function or event list. 

The <On Panel Destroy> command defines an event function or event list for a 
panel. Event functions are usually used to send an Apple event to a target 
application, requesting it to perform some action. Apple Guide executes the 
event function when Apple Guide destroys the panel to which it is attached. 

You can use multiple <On Panel Destroy> commands per panel. Apple Guide 
executes any event functions in the order in which the <On Panel Destroy> 
command appears in your panel definition. 

#define doExamplePanelAction as an event function that sends to 
#the app with signature 'WAVE' (SurfWriter) the Apple event 
#defined by event class 'sfwr' and event ID 'actl' 
<Define Event> "doExamplePanelAction" 1 'WAVE' 1 'sfwr' 1 'actl' 
<Define Panel> "Example Panel" 

<On Panel Destroy> doExamplePanelAction() 
<On Panel Destroy> PlaySound(lOOO) 

<End Panel> 
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For information on Guide Maker's built-in event functions, see "Built-in Event 
Functions" on page 10-188. For information on the <Define Event> and <Define 
Event List> commands, see page 10-178 and page 10-181, respectively. 

<On Panel Show> 

DESCRIPTION 

You can use the <On Panel Show> command to define an event function that 
Apple Guide executes when opening a panel and when expanding a panel. 

<On Panel Show> eventFunction [, firstOrAlways] 

eventFunction An event function or event list. 

firs tOr Always A constant that indicates whether Apple Guide should execute 
the event function only when it first shows the panel (FIRST) or 
both when it first shows the panel and whenever the panel is 
expanded (ALWAYS). This parameter is optional. If you omit this 
parameter, Apple Guide uses ALWAYS as the default. 

The <On Panel Show> command defines an event function or event list for a 
panel. Apple Guide executes the event function, based on the first Or Always 
parameter, when Apple Guide shows or expands the panel to which it is 
attached. Event functions are usually used to send an Apple event to a target 
application, requesting it to perform some action. 

You can use multiple <On Panel Show> commands per panel. Apple Guide 
executes event functions in the order in which the <On Panel Show> command 
appears in your panel definition. 

You typically use the <On Panel Show> command to perform a task that is 
required by a Continue panel. One of the parameters to the <Make Sure> 
command is the sequence to display if the specified condition isn't true. In this 
case, Apple Guide displays the sequence, showing the first panel in the 
sequence. If you include an <On Panel Show> command in this panel 
definition, Apple Guide executes the specified event function. This event 
function should perform the task for the user. 
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#simple panel that plays a sound when opened or expanded 
<Define Panel> "Example Panel" 

#always play a sound when panel is opened and also 
# when it is expanded 
<On Panel Show> PlaySound(1000), ALWAYS 

<End Panel> 

#sequence definition for a Continue sequence 
<Define Sequence> "open dictionary for the user" 

<Seq Nav Button Set> NONE 
<Define Panel> "Continue panel: Opening dictionary" 

<Format> "Full" #a defined format 
Please wait a moment. Apple Guide is assisting you by 
opening the SurfWriter dictionary. 

#this 3D button (Continue) is in Standard Resources 
<3D Button> 1070, 1072, Center, GoBack() 
#use prompt text: "Wait until the dictionary is open, 
#then click Continue." 
<Panel Prompt> "Wait while AG opens dictionary" 
#specify event function that Apple Guide executes 
# upon showing the panel; specify your own event 
# function or a built-in event function 
<On Panel Show> DoScript("openSWDictionary 11

) 

<End Panel> 
<End Sequence> 

#sequence definition that uses <Make sure> and Continue 
<Define Sequence> "How do I use the dictionary?" 

<Panel> "intra to dictionary~~ 
#now make sure that the dictionary file is open before 
# allowing the user to go to the next panel 
#if it isn't open, open it for the user 
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# by providing a Continue sequence 
#(isDictionaryOpen is application-defined context check) 
<Make Sure> isDictionaryOpen("SurfWriter Dictionary"), 

"open dictionary for the user" #continue seq. 
<Panel> "finding a word in the dictionary .. 

<Panel> .. special dictionaries" 
<End Sequence> 

For information on Guide Maker's built-in event functions, see 1/Built-in Event 
Functions" on page 10-188. For information on the <Define Event> and <Define 
Event List> commands, see page 10-178 and page 10-181, respectively. For 
information on the <Make Sure> command, see page 10-162. 

<On Panel Hide> 

DESCRIPTION 

You can use the <On Panel Hide> command to define an event function that 
Apple Guide executes when hiding a panel. 

<On Panel Hide> eventfunction [, firstOrAlways] 

eventFunction An event function or event list. 

firs tOr Always A constant that indicates whether Apple Guide should execute 
the event function only when it first hides the panel (FIRST) or 
both when it first hides the panel and whenever the panel is 
minimized (ALWAYS). This parameter is optional. If you omit 
this parameter, Apple Guide uses ALWAYS as the default. 

The <On Panel Hide> command defines an event function or event list for a 
panel. Apple Guide executes the event function, based on thefirstOrAlways 
parameter, when Apple Guide hides the panel to which it is attached. Hiding a 
panel refers to Apple Guide either closing the panel or minimizing the panel. 
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Event functions are usually used to send an Apple event to a target application, 
requesting it to perform some action. 

You can use multiple <On Panel Hide> commands per panel. Apple Guide 
executes event functions in the order in which the <On Panel Hide> command 
appears in your panel definition. 

<Define Panel> "Example Panel" 
#play a sound the first time Apple Guide hides the panel 
<On Panel Hide> PlaySound(lOOO), FIRST 

<End Panel> 

For information on the <Define Event> and <Define Event List> commands, 
see page 10-178 and page 10-181, respectively. Guide Maker's built-in event 
functions are described next. 

Built-in Event Functions 

10-188 

Guide Maker provides the following built-in event functions: DoScript, 
GoPanel,LaunchNewSequence,LaunchNewSequenceNewWindo~ 

PlaySound, StartTopicOops, and Qui tTopicOops. 

Apple Guide also supports a number of other events, defined in the Standard 
Setup file. H your build file includes the Standard Setup file, then you can 
specify any of the events defined in that file. 

You can specify an event function when using the following commands: 
<Standard Button>, <3D Button>, <Define Nav Button>, <Hot Text>, <Hot 
Rectangle>, <Hot Object>, <On Panel Create>, <On Panel Destroy>, <On Panel 
Show>, and <On Panel Hide>. 

The built-in event functions and their parameters are described here. 
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DoSeript(scriptResource) 

scriptResource A resource ID of a 1 sept 1 resource previously specified in a 
<Resource> command or the filename of a compiled script that 
resides in the same folder as the help source files. Apple Guide 
runs the referenced script when it invokes the DoSeript event 
function. The DoSer ipt event function can also be accessed 
using the name DoAppleSeript. 

GoPanel(panelNumber) 

panelNumber A panel number identifying a panel in a sequence. Panels are 
numbered beginning with 1 for the first panel in a sequence, 2 
for the second panel, and so on. Apple Guide displays the panel. 

LaunehNewSequenee(sequenceName) 

sequenceName A text string specifying the sequence to launch. Apple Guide 
closes the current topic, if any, and continues with the named 
sequence. Calling this event function closes the current access 
window or panel and opens a new one. The guide file of the 
target application must already be open before calling this event 
function. 

LaunehNewSequeneeNewWindow(sequenceName) 

sequenceName A text string specifying the sequence to launch. Apple Guide 
does not close the current topic but instead opens a new 
window. The guide file of the target application must already be 
open before calling this event function. 

PlaySound(soundResource) 

soundResource A resource ID or resource name of a 1 snd 1 resource 
previously specified in a <Resource> command, or the filename 
of a System 7 sound file that is in the same folder as your help 
source files. Apple Guide plays the sound resource 
asynchronously when it invokes the Playsound event function. 
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StartTopicOops(sequenceName) 

sequenceName A text string specifying the Oops sequence to launch. Apple 
Guide hides the current topic and opens the Oops sequence in a 
new window. The guide file of the target application must 
already be open before calling this event function. 

Qui tTopicOops( [pane/Number]) 

pane/Number A panel number identifying a panel in a sequence. Panels are 
numbered beginning with 1 for the first panel in a sequence, 2 
for the second panel, and so on. The pane/Number parameter is 
optional. If it is provided, Apple Guide closes the Oops topic 
and returns to the specified panel. If it is omitted, Apple Guide 
closes the Oops topic and returns to the parent topic. 

Working With Mixin Guide Files 

You can modify or add content to an already existing guide file by creating a 
Mixin guide file. The source file for a Mixin guide file must contain a <Mixin> 
command and optionally, a <Mixin Match> command. A main guide file may 
also contain a <Mixin Match> command to specify which Mixin guide files can 
be mixed in with it. 

This section describes the commands you can use in your Mixin source file to 
replace, delete, or add content to a main guide file. 

<Replace Sequence> 

10-190 

You can use the <Replace Sequence> command to specify a sequence in a main 
guide file that is to be replaced by a new sequence in a Mixin guide file. 

<Replace Sequence> oldSequenceName, newSequenceName 

oldSequenceName 
A text string specifying the name of the sequence in the main 
guide file. 
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newSequenceName 
A text string specifying the name of the sequence in the Mixin 
guide file. 

When Guide Maker compiles a source file for a Mixin guide file and encounters 
a <Replace Sequence> command, it looks for a sequence specified by the 
oldSequenceName parameter in the main guide file. If it finds the sequence, it 
replaces it with the sequence specified by the newSequenceName parameter. 

SPECIAL CONSIDERATIONS 

EXAMPLES 

SEE ALSO 

The <Replace Sequence> command can be used only in the source file for a 
Mixin guide file that also includes the <Mixin> command. To use the <Replace 
Sequence> command, you must specify a SYM file in the symName parameter 
of the <Mixin> command. 

<Replace Sequence> "creating index markers", -. 
"New creating index markers .. 

For information on the <Mixin> command, see page 10-19. To modify or add 
new topic areas, topics, or index entries to an existing guide file, you can use 
the commands <Insert Topic Area Header>, <Insert Topic Area Topic>, <Insert 
Index Header>, and <Insert Index Topic>, as described on page 10-192, 
page 10-193, page 10-195, and page 10-196, respectively. 
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<Insert Topic Area Header> 

DESCRIPTION 

You can use the <Insert Topic Area Header> command to insert a header from 
a Mixin guide file and associate this new header with an existing topic area in a 
main guide file. 

<Insert Topic Area Header> header 1 topicArea [ 1 sortOrder] 

header 

topicArea 

sortOrder 

A text string specifying a new header. 

A text string specifying the topic area in a main guide file. Apple 
Guide associates the new header with the specified topic area. 

A value specifying where the new header should appear in the 
list of headers for the specified topic area. You can use the 
constant FIRST or LAST to sort the header at the beginning or 
end of existing headers for the specified topic area. You can also 
specify in this parameter a text string of the header that should 
immediately precede the new header. This parameter is 
optional. If you omit it, Apple Guide uses LAST as the default. 

When Guide Maker compiles a source file for a Mixin guide file and encounters 
an <Insert Topic Area Header> command, it looks for a topic area specified by 
the topicArea parameter in the main guide file. If it finds the topic area, it 
associates the new header with it and inserts the header into the list of headers 
according to the sort order specified by the sortOrder parameter. 

To define the topics for a new header, use the <Insert Topic Area Topic> 
command. 

SPECIAL CONSIDERATIONS 

10-192 

The <Insert Topic Area Header> command can be used only in the source file 
for a Mixin guide file that also includes the <Mixin> command. To use the 
<Insert Topic Area Header> command, you must specify a SYM file in the 
symName parameter of the <Mixin> command. 
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#in a Mixin guide file, specify a new header for an 
# existing topic area in a main guide file 
<Insert Topic Area Header> 11 When should I", .., 

"Setting Options", FIRST 

For information on the <Mixin> command, see page 10-19. For information on 
the <Topic Area>, <Header>, and <Topic> commands, see page 10-125, 
page 10-135, and page 10-137, respectively. 

<Insert Topic Area Topic> 

You can use the <Insert Topic Area Topic> command to insert a topic from a 
Mixin guide file and associate this new topic with an existing topic area in a 
main guide file. 

<Insert Topic Area Topic> topic, seq Name, topicArea [ , sortOrder] 

topic 

seq Name 

topicArea 

sort Order 

A text string specifying a new topic. 

A text string specifying the sequence name associated with the 
new topic. 

A text string specifying the topic area in a main guide file. Apple 
Guide associates the new topic with the specified topic area. 

A value specifying where the new topic should appear in the list 
of topics for the specified topic area. You can use the constant 
FIRST or LAST to sort the topic at the beginning or end of 
existing topics for the specified topic area. You can also specify 
in this parameter a text string of the topic that should 
immediately precede the new topic. This parameter is optional. 
If you omit it, Apple Guide uses LAST as the default. 
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DESCRIPTION 

CHAPTER 10 

Guide Script Command Reference 

When Guide Maker compiles a source file for a Mixin guide file and encounters 
an <Insert Topic Area Topic> command, it looks for a topic area specified by 
the topicArea parameter in the main guide file. If it finds the topic area, it 
associates the new topic with it and inserts the topic into the list of topics, 
according to the sort order specified by the sortOrder parameter. 

To define a header for a new topic, use the <Insert Topic Area Header> 
command. 

SPECIAL CONSIDERATIONS 

EXAMPLES 

SEE ALSO 

10-194 

The <Insert Topic Area Topic> command can be used only in the source file for 
a Mixin guide file that also includes the <Mixin> command. To use the <Insert 
Topic Area Topic> command, you must specify a SYM file in the symName 
parameter of the <Mixin> command. 

#in a Mixin guide file, specify a new topic for an 
# existing topic area in a main guide file 
<Insert Topic Area Topic> "change the default font?", -. 

"How do I change the default font?", -. 
"Setting Options", -. 
.. change the standard footer?" 

For information on the <Mixin> command, see page 10-19. For information on 
the <Topic Area>, <Header>, and <Topic> commands, see page 10-125, 
page 10-135, and page 10-137, respectively. 
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Guide Script Command Reference 

<Insert Index Header> 

DESCRIPTION 

You can use the <Insert Index Header> command to insert a header from a 
Mixin guide file and associate this new header with an existing index term in a 
main guide file. 

<Insert Index Header> header, indexTerm [, sortOrder] 

header 

indexTerm 

sort Order 

A text string specifying a new header. 

A text string specifying the index term in a main guide file. 
Apple Guide associates the new header with the specified index 
term. 

A value specifying where the new header should appear in the 
list of headers for the specified index term. You can use the 
constant FIRST or LAST to sort the header at the beginning or 
end of existing headers for the specified index term. You can 
also specify in this parameter a text string of the header that 
should immediately precede the new header. This parameter is 
optional. If you omit it, Apple Guide uses LAST as the default. 

When Guide Maker compiles a source file for a Mixin guide file and encounters 
an <Insert Index Header> command, it looks for an index term specified by the 
indexTerm parameter in the main guide file. If it finds the index term, it 
associates the new header with it and inserts the header into the list of headers, 
according to the sort order specified by the sortOrder parameter. 

To define the topics for a new header, use the <Insert Index Topic> command. 

SPECIAL CONSIDERATIONS 

The <Insert Index Header> command can be used only in the source file for a 
Mixin guide file that also includes the <Mixin> command. To use the <Insert 
Index Header> command, you must specify a SYM file in the symName 
parameter of the <Mixin> command. 
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EXAMPLES 

SEE ALSO 

CHAPTER 10 

Guide Script Command Reference 

#in a Mixin guide file, specify a new header for an 
# existing index term in a main guide file 
<Insert Index Header> "When should I", ~ 

"Math operations", FIRST 

For information on the <Mixin> command, see page 10-19. For information on 
the <Index>, <Header>, and <Topic> commands, see page 10-128, page 10-135, 
and page 10-137, respectively. 

<Insert Index Topic> 

10-196 

You can use the <Insert Index Topic> command to insert a topic from a Mixin 
guide file and associate this new topic with an existing topic area in a main 
guide file. 

<Insert Index Topic> topic, seqName, indexTerm [, sortOrder] 

topic 

seq Name 

indexTerm 

sortOrder 

A text string specifying a new topic. 

A text string specifying the sequence name associated with the 
new topic. 

A text string specifying the index term in a main guide file. 
Apple Guide associates the new topic with the specified index 
term. 

A value specifying where the new topic should appear in the list 
of topics for the specified topic area. You can use the constant 
FIRST or LAST to sort the topic at the beginning or end of 
existing topics for the specified topic area. You can also specify 
in this parameter a text string of the topic that should 
immediately precede the new topic. This parameter is optional. 
If you omit it, Apple Guide uses LAST as the default. 
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DESCRIPTION 

CHAPTER 10 

Guide Script Command Reference 

When Guide Maker compiles a source file for a Mixin guide file and encounters 
an <Insert Index Topic> command, it looks for an index term specified by the 
indexTerm parameter in the main guide file. If it finds the index term, it 
associates the new topic with it and inserts the topic into the list of topics, 
according to the sort order specified by the sortOrder parameter. 

To define a header for a new topic, use the <Insert Index Header> command. 

SPECIAL CONSIDERATIONS 

EXAMPLES 

SEE ALSO 

The <Insert Index Topic> command can be used only in the source file for a 
Mixin guide file that also includes the <Mixin> command. To use the <Insert 
Index Topic> command, you must specify a SYM file in the symName 
parameter of the <Mixin> command. 

#in a Mixin guide file, specify a new topic for an 
# existing index term in a main guide file 
<Insert Index Topic> "use hexadecimal numbers?", ..., 

"When should I use hexadecimal numbers?", .., 
"Math operations", FIRST 

For information on the <Mixin> command, see page 10-19. For information on 
the <Index>, <Header>, and <Topic> commands, see page 10-128, page 10-135, 
and page 10-137, respectively. 
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CHAPTER 10 

Guide Script Command Reference 

<Delete Topic Area> 

DESCRIPTION 

You can use the <Delete Topic Area> command to specify that a topic area 
defined in a main guide file should not be displayed if the main guide file is 
mixed in with your Mixin guide file. 

<Delete Topic Area> topicArea 

topicArea A text string specifying the topic area that should not be 
displayed when the mixin is mixed in with the main guide file. 

If a Mixin guide file includes a <Delete Topic Area> command, when Apple 
Guide mixes in the main guide file with the Mixin, the topic area specified by 
the topicArea parameter will not be shown in the list of topic areas when Topics 
is active. If the main guide file is not mixed in with the Mixin guide file, the 
topic area is shown in the list. 

SPECIAL CONSIDERATIONS 

EXAMPLES 

SEE ALSO 

10-198 

The <Delete Topic Area> command can be used only in the source file for a 
Mixin guide file that also includes the <Mixin> command. To use the <Delete 
Topic Area> command, you must specify a SYM file in the symName parameter 
of the <Mixin> command. 

#do not show this topic area if the main guide file is 
# mixed in with this guide file 
<Delete Topic Area> "Printing" 

For information on the <Mixin> command, see page 10-19. For information on 
the <Topic Area>, <Header>, and <Topic> commands, see page 10-125, 
page 10-135, and page 10-137, respectively. 
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Guide Script Command Reference 

<Delete Topic Area Header> 

DESCRIPTION 

You can use the <Delete Topic Area Header> command to specify that a header 
associated with a topic area defined in a main guide file should not be 
displayed if the main guide file is mixed in with your Mixin guide file. 

<Delete Topic Area Header> topicArea, topicAreaHeader 

topicArea A text string specifying the topic area associated with the header. 

topicAreaHeader 
A text string specifying the header that should not be displayed 
when the Mixin guide file is mixed in with the main guide'file. 

If a Mixin guide file includes a <Delete Topic Area Header> command, when 
Apple Guide mixes in the main guide file with the Mixin guide file, the topic 
area header specified by the topicAreaHeader parameter will not be displayed. If 
the main guide file is not mixed in with the Mixin guide file, the topic area 
header is displayed. 

SPECIAL CONSIDERATIONS 

EXAMPLES 

The <Delete Topic Area Header> command can be used only in the source file 
for a Mixin guide file that also includes the <Mixin> command. To use the 
<Delete Topic Area Header> command, you must specify a SYM file in the 
symName parameter of the <Mixin> command. 

#do not show this header if the main guide file is mixed in 
# with this guide file 
<Delete Topic Area Header> "Printing", "How do I" 
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SEE ALSO 

CHAPTER 10 

Guide Script Command Reference 

For information on the <Mixin> command, see page 10-19. For information on 
the <Topic Area>, <Header>, and <Topic> commands, see page 10-125, 
page 10-135, and page 10-137, respectively. 

<Delete Topic Area Topic> 

DESCRIPTION 

You can use the <Delete Topic Area Topic> command to specify that a topic 
associated with a topic area defined in a main guide file should not be 
displayed if the main guide file is mixed in with your Mixin guide file. 

<Delete Topic Area Topic> topicArea, topicAreaTopic 

topicArea A text string specifying the topic area associated with the topic. 

topicAreaTopic 
A text string specifying the topic that should not be displayed 
when the Mixin guide file is mixed in with the main guide file. 

If a Mixin guide file includes a <Delete Topic Area Topic> command, when 
Apple Guide mixes in the main guide file with the Mixin guide file, the topic 
specified by the topicAreaTopic parameter will not be displayed. If the main 
guide file is not mixed in with the Mixin guide file, the topic is displayed. 

SPECIAL CONSIDERATIONS 

10-200 

The <Delete Topic Area Topic> command can be used only in the source file for 
a Mixin guide file that also includes the <Mixin> command. To use the <Delete 
Topic Area Topic> command, you must specify a SYM file in the symName 
parameter of the <Mixin> command. 
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SEE ALSO 

CHAPTER 10 

Guide Script Command Reference 

#do not show this topic if the main guide file is mixed in 
# with this guide file 
<Delete Topic Area Topic> "Printing", "select a printer? 11 

For information on the <Mixin> command, see page 10-19. For information on 
the <Topic Area>, <Header>, and <Topic> commands, see page 10-125, 
page 10-135, and page 10-137, respectively. 

<Delete Index> 

DESCRIPTION 

You can use the <Delete Index> command to specify that an index term defined 
in a main guide file should not be displayed if the main guide file is mixed in 
with your Mixin guide file. 

<Delete Index> indexTerm 

indexTerm A text string specifying the index term that should not be 
displayed when the mixin is mixed in with the main guide file. 

If a Mixin guide file includes a <Delete Index> command, when Apple Guide 
mixes in the main guide file with the mixin, the index term specified by the 
indexTerm parameter will not be shown in the list of index terms when Index is 
active. If the main guide file is not mixed in with the Mixin guide file, the index 
term is shown in the list. 

SPECIAL CONSIDERATIONS 

The <Delete Index> command can be used only in the source file for a Mixin 
guide file that also includes the <Mixin> command. To use the <Delete Index> 
command, you must specify a SYM file in the symName parameter of the 
<Mixin> command. 
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EXAMPLES 

SEE ALSO 

CHAPTER 10 

Guide Script Command Reference 

#do not show this index term if the main guide file is 
# mixed in with this guide file 
<Delete Index> "printer drivers" 

For information on the <Mixin> command, see page 10-19. For information on 
the <Topic Area>, <Header>, and <Topic> commands, see page 10-125, 
page 10-135, and page 10-137, respectively. 

<Delete Index Header> 

DESCRIPTION 

10-202 

You can use the <Delete Index Header> command to specify that a header 
associated with an index term in a main guide file should not be displayed if 
the main guide file is mixed in with your Mixin guide file. 

<Delete Index Header> indexTerm, indexHeader 

indexTerm A text string specifying the index term associated with the 
header. 

indexHeader A text string specifying the header that should not be displayed 
when the mixin is mixed in with the main guide file. 

If a Mixin guide file includes a <Delete Index Header> command, when Apple 
Guide mixes in the main guide file with the mixin, the header specified by the 
indexHeader parameter will not be shown in the list of headers for the specified 
index term. If the main guide file is not mixed in with the Mixin guide file, the 
header is shown in the list. 
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Guide Script Command Reference 

SPECIAL CONSIDERATIONS 

EXAMPLES 

SEE ALSO 

The <Delete Index Header> command can be used only in the source file for a 
Mixin guide file that also includes the <Mixin> command. To use the <Delete 
Index Header> command, you must specify a SYM file in the symName 
parameter of the <Mixin> command. 

#do not show this index term if the main guide file is 
# mixed in with this guide file 
<Delete Index Header> .. printer drivers", "Bow do I" 

For information on the <Mixin> command, see page 10-19. For information on 
the <Topic Area>, <Header>, and <Topic> commands, see page 10-125, 
page 10-135, and page 10-137, respectively. 

<Delete Index Topic> 

DESCRIPTION 

You can use the <Delete Index Topic> command to specify that a topic 
associated with an index term in a main guide file should not be displayed if 
the main guide file is mixed in with your Mixin guide file. 

<Delete Index Topic> indexTerm, indexTopic 

indexTerm 

indexTopic 

A text string specifying the index term associated with the topic. 

A text string specifying the topic that should not be displayed 
when the mixin is mixed in with the main guide file. 

If a Mixin guide file includes a <Delete Index Topic> command, when Apple 
Guide mixes in the main guide file with the mixin, the topic specified by the 
indexTopic parameter will not be shown in the list of topics for the specified 

Working With Mixin Guide Files 10-203 

I 



CHAPTER 10 

Guide Script Command Reference 

index term. If the main guide file is not mixed in with the Mixin guide file, the 
topic is shown. 

SPECIAL CONSIDERATIONS 

EXAMPLES 

SEE ALSO 

10-204 

The <Delete Index Topic> command can be used only in the source file for a 
Mixin guide file that also includes the <Mixin> command. To use the <Delete 
Index Topic> command, you must specify a SYM file in the symName 
parameter of the <Mixin> command. 

#do not show this index term if the main guide file is 
# mixed in with this guide file 
<Delete Index Topic> "printer drivers", "choose a printer" 

For information on the <Mixin> command, see page 10-19. For information on 
the <Topic Area>, <Header>, and <Topic> commands, see page 10-125, 
page 10-135, and page 10-137, respectively. 
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APPENDIX A 

Guide Script 
Com.m.and Abbreviations 

Most Guide Script commands can be specified by their full name or an 
abbreviation. Abbreviations for all Guide Script commands are shown here, in 
alphabetical order of the full command name. 

Table A-1 Command abbreviations 

Full command name 

<3D Button> 

<Allow Prompts> 

<App Creator> 

<AppLogo> 

<AppText> 

<Balloon Menu Text> 

<Build Sequence> 

<Checkbox> 

<Coach Mark> 

<Comment> 

<Default Format> 

<Default Nav Button Set> 

<Default Prompt Set> 

<Define AppleScript Coach> 

<Define Context Check> 

Abbreviated 
command name 

<3DB> 

<AP> 

<AC> 

<AL> 

<AT> 

<BMT> 

<BS> 

<CB> 

<CM> 

# 

<DefaultNBS> 

<DefaultPS> 

<DAC> 

<DCC> 

continued 
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Guide Script Command Abbreviations 

Table A-1 Command abbreviations (continued) 

Abbreviated 
Full command name command name 

<Define Event> <DE> 

<Define Event List> <DEL> 

<Define Format> <DF> 

<Define Item Coach> <DIC> 

<Define Menu Coach> <DMC> 

<Define Nav Button> <DNB> 

<Define Nav Button Set> <DNBS> 

<Define Object Coach> <DOC> 

<Define Panel> <DP> 

<Define Prompt Set> <DPS> 

<Define Sequence> <DS> 

<Define Text Block> <DTB> 

<Define Transparent Format> <DTF> 

<Define Window Coach> <DWC> 

<Delete Index> <DI> 

<Delete Index Header> <DIH> 

<Delete Index Topic> <DIT> 

<Delete Topic Area> <DTA> 

<Delete Topic Area Header> <DTAH> 

<Delete Topic Area Topic> <DTAT> 

<Dimmable Button Data> <DBD> 

<Else> 

<End If> <EI> 

<End Making Sure> <EMS> 
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Guide Script Command Abbreviations 

TableA-1 Command abbreviations (continued) 

Full command name 

<End Panel> 

<End Sequence> 

<End Text Block> 

<Exception> 

<Format> 

<Gestalt> 

<Header> 

<Help Menu> 

<Hot Object> 

<Hot Rectangle> 

<Hot Text> 

<Howdy> 

<If> 

<Ignore> 

<Include> 

<Index> 

<Index Instruction> 

<Index Sorting> 

<Insert Index Header> 

<Insert Index Topic> 

<Insert Sequence> 

<Insert Topic Area Header> 

<Insert Topic Area Topic> 

Abbreviated 
command name 

<EP> 

<ES> 

<ETB> 

<EXC> 

<HM> 

<HO> 

<HR> 

<HT> 

<IGN> 

<II> 

<IS> 

<IIH> 

<liT> 

<IS> 

<ITAH> 

<IT AT> 

continued 
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Guide Script Command Abbreviations 

Table A-1 Command abbreviations (continued) 

Full command name 

<Jump Sequence> 

<Launch New Sequence> 

<Look For Instruction> 

<Look For Results Instruction> 

<Look For Search Btn Instruction> 

<Look For String> 

<Make Sure> 

<Max Height> 

<Min Height> 

<Mixin> 

<Mixin Match> 

<On Panel Create> 

<On Panel Destroy> 

<On Panel Hide> 

<On Panel Show> 

<Panel> 

<Panel Prompt> 

<PICT> 

<Quick Time> 

<Radio Button> 

<Radio Button Launch New Seq> 

<Replace Sequence> 

<Resource> 

<Seq Nav Button Set> 

Abbreviated 
command name 

<JS> 

<LNS> 

<LFI> 

<LFRI> 

<LFSBI> 

<LFS> 

<MS> 

<MM> 

<OPC> 

<OPD> 

<OPH> 

<OPS> 

<PP> 

<QT> 

<RB> 

<RBLNS> 

<RS> 

<SNBS> 
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Guide Script Command Abbreviations 

Table A-1 Command abbreviations (continued) • Abbreviated 
Full command name command name 

<Sequence Prompt Set> <SPS> 

<Skip If> <51> 

<Sorting> 

<Standard Button> <SB> 

<Starting Res Number> <SRN> 

<Start Making Sure> <SMS> 

<Startup Window> <SW> 

<Synonym> <SYN> 

<Topic> 

<Topic Area> <TA> 

<Topic Areas Instruction> <TAl> 

<Topics Instruction> <Tl> 

<Version> 

<World Script> <WS> 
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APPENDIX B 

Guide Script Conunands and 
Param.eters Quick Reference 

A summary of all Guide Script commands and their parameters, in 
alphabetical order, follows. 

Table B-1 Commands quick reference 

Command 

<3D Button> 

<Allow Prompts> 

<App Creator> 

<App Logo> 

<App Text> 

<Balloon Menu Text> 

<Build Sequence> 

<Checkbox> 

<Coach Mark> 

<Conunent> or # 

<Default Format> 

<Default Nav Button Set> 

<Default Prompt Set> 

Parameters 

buttonUpPict 1 buttonDownPict 1 

buttonLoc 1 buttonEvent 
[ 1 b&wUp] [ 1 b&wDown] 

allow 

creator 

colorLogo [ 1 B&WLogo ] 

string 

balloon Text 

sequenceName 1 seqResiD 

checkBoxTitle 1 checkBox State 
[ 1 seqTrue] [ 1 seqFalse] 
[ 1 checkBoxAnchor] 
[ , checkBoxFont] 

coach~rkName 

format Name 

navButtonSetName 

promptSetName 

continued 
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Guide Script Commands and Parameters Quick Reference 

Table B-1 Commands quick reference (continued) 

Command 

<Define AppleScript Coach> 

<Define Context Check> 

<Define Event> 

<Define Event List> 

<Define Format> 

<Define Item Coach> 

<Define Menu Coach> 

<Define Nav Button> 

<Define Nav Button Set> 

Parameters 

coachMarkName [, coachStyle] 
, AppleScriptiD 

contextCheckName, codeResSpec 
[ , targetApp ] [ , additionalParam ] 
[ , additionalParam ] [ , . .. ] 

event Name, targetApp, 
eventClass, eventiD 
[ , IOPTData] [ , optKey] 
[, opt Data] 

eventListName, eventl 
[ , event2 ] [ , event3 ] 
[ , event4] [ , eventS] 
[, event6] 

formatName, columnCoords 
[ , txFnt] [ , txSize] 
[, txStyle] 
[ , txColor ] [ , txAlign ] 
[ , alignPrompt] 

coachMarkName [ , targetApp ] 
[ , coachStyle] 
[, target Window] , target/tern 
[ , iternRectangle ] 

coachMarkName [ , targetApp] 
[ , coachStyle] , targetMenu 
[ , target/tern ] 
[ , iternCoachColor] 
[ , iternCoachStyle] 

buttonName, buttonUpPict, 
buttonDownPict, dimmedButtonPict, 
buttonEvent [ , b&wUp ] 
[, b&wDown] [, b&wDimmed] 

navButtonSetName 
[ , leftNavButton] 
[ , midNavButton ] 
[ , rightNavButton ] 
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Guide Script Commands and Parameters Quick Reference 

Table B-1 Commands quick reference (continued) 

Command 

<Define Object Coach> 

<Define Panel> 

<Define Prompt Set> 

<Define Sequence> 

<Define Text Block> 

<Define Transparent Format> 

<Define Window Coach> 

<Delete Index> 

<Delete Index Header> 

<Delete Index Topic> 

<Delete Topic Area> 

<Delete Topic Area Header> 

<Delete Topic Area Topic> 

<Dimmable Button Data> 

<Else> 

<End If> 

<End Making Sure> 

<End Panel> 

Parameters 

coachMarkName 1 targetApp 
[ 1 coachStyle 1 [ 1 objectName 1 

panelName 

promptSetName I 
promptFirstPanel 1 

promptMiddlePanel 1 

promptLastPanel 1 

promptForPanels With Controls 

sequenceName [ 1 seqDisplayTitle 1 

textBlockName 

JormatName 1 columnCoords 
[ 1 txFnt] [ 1 txSize 1 
[ 1 txStyle 1 [ 1 txColor] 
[ 1 txAlign 1 [ 1 alignPrompt 1 

coachMarkName [ I targetApp 1 
[ 1 coachStyle 1 [ , target Window 1 
1 window Rectangle [ 1 rectOrigin] 

index Term 

indexTerm 1 indexHeader 

indexTerm 1 indexTopic 

topicArea 

topicArea, topicAreaHeader 

topicArea, topicAreaTopic 

buttonName I sequenceName 

continued 
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Guide Script Commands and Parameters Quick Reference 

Table B-1 Commands quick reference (continued) 

Command 

<End Sequence> 

<End Text Block> 

<Exception> 

<Format> 

<Gestalt> 

<Header> 

<Help Menu> 

<Hot Object> 

<Hot Rectangle> 

<Hot Text> 

<Howdy> 

<If> 

<Ignore> 

<Include> 

<Index> 

<Index Instruction> 

<Index Sorting> 

<Insert Index Header> 

<Insert Index Topic> 

<Insert Sequence> 

<Insert Topic Area Header> 

<Insert Topic Area Topic> 

Parameters 

exception Word 

format Name 

selector, requiredValue 

header Phrase 

itemString, helpType 
[ , helpCmdKey] 

event Function 

hotRect, eventFunction 

hot Text, whichOccurrence, 
eventFunction 

howdyTextBlockName 

condition 

ignore Word 

sourceFileName 

indexTerm [ , visible 1 [ 1 key 1 

indexlnstruction 

ordering Key 

header, indexTerm [ , sortOrder 1 

topic I seq Name, indexTerm 
[ , sortOrder 1 

sequenceName 

header, topicArea [, sortOrder1 

topic, seq Name, topicArea 
[ 1 sortOrder 1 
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Guide Script Commands and Parameters Quick Reference 

Table B-1 Commands quick reference (continued) 

Command 

<Jump Sequence> 

<Launch New Sequence> 

<Look For Instruction> 

<Look For Results 
Instruction> 

<Look For Search Btn 
Instruction> 

<Look For String> 

<Make Sure> 

<Max Height> 

<Min Height> 

<Mix in> 

<Mixin Match> 

<On Panel Create> 

<On Panel Destroy> 

<On Panel Hide> 

<On Panel Show> 

<Panel> 

<Panel Prompt> 

<PICT> 

<QuickTime> 

<Radio Button> 

Parameters 

sequence Name 

sequence Name 

look.Forlnstruction 

resultslnstruction 

buttonlnstruction 

searchPhrase 

condition, 
oopsOrContinueSequenceName 

height 

height 

symNameOrStartResNum 

matchingCreator 

event Function 

eventFunction 

eventFunction [ , firstOr Always] 

eventFunction [ , .firstOrAlways] 

panel Name 

promptSetName 

pictGraphic, location [ , b&wPict] 

QTMovie, location, QTcontroller 
[ , moviePict ] 

buttonTitle, buttonS tate 
[ , seqTrue] [ , seq False] 
( , buttonAnchor] [ , buttonFont] 

continued 
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Table B-1 Commands quick reference (continued) 

Command 

<Radio Button Launch New Seq> 

<Replace Sequence> 

<Resource> 

<Seq Nav Button Set> 

<Sequence Prompt Set> 

<Skip If> 

<Sorting> 

<Standard Button> 

<Starting Res Number> 

<Start Making Sure> 

<Startup Window> 

<Synonym> 

<Topic> 

<Topic Area> 

<Topic Areas Instruction> 

<Topics Instruction> 

<Version> 

<World Script> 

Parameters 

button Title, buttonS tate 
[ , seqTrue 1 [ , seqFalse 1 
[ , buttonAnchor 1 [ , buttonFont 1 

oldSequenceName, 
newSequenceName 

fileName, res Type 
[ , whichResource 1 

navButtonSetName 

promptSetName 

condition 

method 

button Title, buttonLoc, 
buttonEvent [ , buttonFont 1 

resiD 

condition, 
oopsOrContinueSequenceName 

window Type, accessScreenOptions 

indexTerm, synonym 

topicPhrase, sequenceName 

topicAreaPhrase [ , mixinOrder 1 

topicArealnstruction 

topicslnstruction 

long V ers1 BottomOfGetlnfo, 
shortVers1ForFinderListViews 
[, longVers2TopOfGetlnfo1 

scriptCode, regionCode 
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This appendix provides a specific example-using SurfWriter Guide-to help 
guide you through the process of scripting your source files. This appendix 
integrates much of the information provided up to now, by showing a specific 
implementation of a guide file. Read this appendix when you're ready to start 
scripting your source files. 

This appendix shows the guide file for the SurfWriter application and includes 
the source files containing the Guide Script commands used to create this guide 
file. It takes you through each source file used to create SurfWriter Guide, 
giving explanatory text where necessary. 

The source files used in this example are also provided online on the CD-ROM 
accompanying this book, in the folder Apple Guide:Authoring:Documentation: 
Example Source Files Appdx C. You can find the compiled guide file in the 
folder Apple Guide:Authoring:Documentation:Example Guide. 

Getting Started 

Figure C-1 illustrates the structure of the source files for SurfWriter Guide. 
These source files can be grouped into three distinct areas: files that specify 
setup information, files that provide help content, and files that provide Index 
and Look For content. 

Getting Started C-1 
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Figure C-1 The organization of the source files for SurfWriter Guide 

SurfWriter 
Guide build file 

0 

Setup information 

"Setup and Access Window.src" 
"Standard Setup DCCs.src" 

Help content 

"Topic Areas and Topics.src" 
"Sequence Definitions.src" 
"Panel Definitions.src" 
"DCC SW.src" 
"Event functions SW.src" 
"CoachMarks SW.src" 

Index and Look For content 

"Index entries.src" 
"Ignore List.src" 
"Exception List.src" 
"Synonym List.src" 

The rest of this section describes the files used to specify the initial setup 
information and gives explanatory text where necessary. "Help Content" 
beginning on page C -11 and "Index and Look For Content" beginning on 
page C-39 describe other files used to create SurfWriter Guide and give 

Getting Started 
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additional information related to the specific commands specified in the 
source files. 

SurfWriter Guide Build File 
The source files for SurfWriter Guide are organized in small sections, to make 
the files convenient to use and easier to manage. For example, separate files 
are used for SurfWriter Guide's index terms, synonym list, ignore list, and 
exception list. Similarly, the source files containing sequence and panel 
definitions are organized so that their information can be readily accessed. 

The build file for SurfWriter Guide is shown in Listing C-1. The rest of the 
sections in this appendix elaborate on these files. 

Listing C-1 A build file ("Build file SURF.src" file) 

#the following file specifies event, nav button, & format definitions 
# plus prompts, coachmarks, Help menu info, and 
# the type of access window 
<Include> "Setup and Access Window.src" 
#the following file specifies the standard context checks 
<Include> "Standard Setup DCCs.src" 
#the following file specifies application-defined context checks 
<Include> "DCC SW.src" 
#the following file specifies application-defined event functions 
<Include> "Event functions SW.src" 
#the following file specifies coachmarks 
<Include> "CoachMarks SW.src" 
#the following files specify the guide file content 
<Include> "Topic Areas and Topics.src" 
<Include> "Sequence Definitions.src" 
<Include> "Panel Definitions.src" 
#use the following file only if you have an XTND translator installed 
#<Include> "Panels with Styleinfo.src" 
#the following files specify the guide file index and Look For content 
<Include> "Index entries.src" 
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<Include> "Ignore List.src" 
<Include> "Exception List.src" 
<Include> "Synonym List.src" 

C-4 

Using Standard Files 
Included on the CD-ROM that accompanies this book are two files that are 
separate from the SurfWriter Guide source files but that are commonly used 
in creating guide files. These two files, Standard Setup and Standard Resources, 
are in the Standard Includes folder, which is located in the Apple 
Guide:Authoring folder. These two standard files are typically used as 
templates. For example, SurfWriter Guide uses information from these 
two files and customizes the information when necessary, as described in 
"Customizing the Setup Information" beginning on page C-5. 

The Standard Setup File 

The Standard Setup file contains the Guide Script commands that give basic 
information about a guide file, such as 

• the name of the guide file as it appears in the Help menu 

• the balloon text for the guide file's menu item 

• the application associated with the guide file 

• the type of access window (full, single, or simple) and the access screen that 
is initially active (howdy, Topics, Index, or Look for) 

• howdy text for the initial access window 

• application logo information for the access window 

• Finder version resources (to display in the Get Info box of the guide file) 

• prompt set definitions, including the default prompt set 

• navigation bar button definitions, including the Huh? and GoStart buttons, 
as well as the default navigation bar button set 

• format definitions, including the Full, Tag, and Body formats 

• specifications of the maximum and minimum height allowed for a panel 

Getting Started 
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• event definitions for the Huh? button ("DoHuh"), the GoStart button 
("GoStart"), and the Continue or OK buttons in Continue and Oops panels 
("GoBack") 

• context check definitions for the external modules provided in the Standard 
Resources file 

By editing the Standard Setup file, you can quickly create a guide file that 
already has standard elements (such as the Huh? and GoStart buttons) 
defined and customize specific elements (such as your guide file's menu item, 
application logo, howdy text, and type of access window) as appropriate for 
your guide file. 

The Standard Resources File 

The Standard Resources file contains: 

• I PICT I resources for the Continue, Huh?, and GoStart buttons 

• templates of 1 PICT 1 resources for an application logo 

• 
1 extm 1 resources (external modules) containing the code for the context 
checks defined in the Standard Setup file 

Customizing the Setup Information 
The file "Setup and Access Window.src" specifies the basic setup information 
for SurfWriter Guide. It is based on the Standard Setup file, with additions that 
are specific for this guide file. Note that the file "Standard Setup OCCs.src" 
contains the context check definitions from the Standard Setup file. 

Listing C-2 through Listing C-6 show the "Setup and Access Window.src" file. 

Navigation Information and Formats 

As shown in Listing C-2, the "Setup and Access Window.src" file first imports 
the resources from the Standard Resources file, then defines the same events, 
navigation buttons, and formats as the Standard Setup file. It also defines 
additional formats specific to SurfWriter Guide. 

Getting Started C-5 

G) 
c: a: 
(1) 

I» 
::::::J a. 
&f 
(/) 
0 c: a 
(1) 

:n 
(i) 
rn 



APPENDIX C 

SurfWriter Guide and Its Source Files 

Listing C-2 Events, navigation buttons, and formats (from the "Setup and Access 
Window.src" file) 

<Resource> "Standard Resources", ALL 

#these events & definitions are also defined in "Standard Setup" 
<Define Event> "DoHuh", 's***', 'help', 'dhuh' 
<Define Event> "GoStart", 's***', 'help', 'stac' 
<Define Event> "GoBack", 's***', 'help', 'gobk' 

<Define Nav Button> "Huh?", 1101, 1111, 1121, DIMMABLE 
<Define Nav Button> "GoStart", 1103, 1113, 1123, GoStart() 
<Define Nav Button Set> "Std nav bar", "GoStart", "Huh?" 

<Define Format> "Tag", Column(6,0,54),"Espy Sans Bold",10,plain,, 
right, false 
<Define Format> "Body", Column(6,65,330),"Espy Serif",10,plain,, 
left, true 
<Define Format> "Full", Column(6,11,330), 11 Espy Serif",10,plain,,Left, 
false 
#if you use styles in your help content and your source files are 
# styled text, omit "plain" from format 
<Define Format> "Full2",Column(6,11,330),"Espy Serif",10,,,Left,false 
<Default Format> "Full" 
#define other formats that specify style information (if your 
# source files are plain text rather than styled text) 
# (these formats are used only with the "CreateCustomintro" panel) 
<Define Format> "PlainText", Column(6,7,330),"Espy Serif", 
10,plain,,,false 
<Define Format> "UnderlineText", Column(20,41,11S),"Espy Sans Bold", 
10,underline,,,false 
<Define Format> "PlainTextReset", Column(20,116,330),"Espy Serif", 
lO,plain,,,false 
<Define Format> "PlainTextNormal", Column(34,7,330),"Espy Serif", 
10,plain,,,false 
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Prompt Sets 

Listing C-3 defines the prompt sets used by SurfWriter Guide. 

Listing C-3 Prompt sets (from the "Setup and Access Window.src" file) 

#Define your prompt sets. 
#Provide four strings to <Define Prompt Set>; the strings specify 
# prompts for: 
# 1. the first panel in a sequence 
# 2. any middle panel in a sequence that does not have 
# radio buttons, checkboxes, or standard buttons 
# 3. the last panel in a sequence 
# 4. any panel with controls (radio buttons, checkboxes, 
# or standard buttons) 
# 
<Define Prompt Set> "standard" , "To begin, click the right arrow.", 
"Do this step, then click the right arrow.", "Do this step, then 
you're done.", "Make your choice, then click the right arrow." 

<Define Prompt Set> "standard2" , "To begin, click the right arrow.", 
"Click the left arrow to go back or the right arrow to continue.", 
"That's all, you're done!", "Make your choice, then click the right 
arrow." 

<Default Prompt Set> "standard2" 

<Define Prompt Set> "introprompts" , "To begin, click the right 
arrow • II I II II I II II I II II 

<Define Prompt Set> "doThisprompt" , "Do this step, then click the 
right arrow.", "Do this step, then click the right arrow.", " ", "Do 
this step, then click the right arrow." 
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<Define Prompt Set> "YouAreDone" , II II " ","That's all, you're 
done.", II II 

<Define Prompt Set> "YouAreDone2" , 
done.", "That's all, you're done." 

II II II II "That's all, you're 

<Define Prompt Set> "continuePrompt" , "After the dictionary opens, 
click Continue.", "After the dictionary opens, click Continue.", 
"After the dictionary opens, click Continue.", " " 

<Define Prompt Set> "Defn&HuhPrompts" , "Read this information, then 
you're done.", "Read this information, then you're done.", "Read this 
information, then you're done.", II II 

Help Menu Information 

Listing C-4 defines the information specific to SurfWriter's Help menu (the 
menu item text and balloon text for the guide file). 

Listing C-4 Help menu information (from the "Setup and Access Window.src" file) 

# *************** Help menu information ************************* 
#define how the name of this guide file should appear in 
# SurfWriter's Help menu 
#the menu item name is "SurfWriter Guide" 
#the guide file for this menu item is of type HELP 
#if you use the cmd like this, it does NOT give you Cmd-Key symbol 
# or ? in the Help menu 
#<Help Menu> "SurfWriter Guide", HELP 
#therefore, specify the command like this 
<Help Menu> "SurfWriter Guide", HELP, "?" 

#use this command to specify the text that appears for this guide file 
#in your application's Help menu; that is, when the cursor is in 
# the SurfWriter Guide menu item and Balloon Help is on, 
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# the Finder displays this text in a help balloon 
<Balloon Menu Text> 11 Provides information and instructions to assist 
you in accomplishing specific tasks with SurfWriter" 

#To specify that your guide file appear only in the Help menu 
#of your application, use this command and specify your application's 
# creator, for example: 
# <App Creator> 'WAVE' 

Access Window Information 

Listing C-5 defines the access window information for SurfWriter Guide. Note 
that because this source file specifies the <App Logo> command, the Standard 
Resources file must not contain 'PICT' resources with resource IDs 501 and 
502 (these resources have been removed from the Standard Resources file 
provided in the Example Source Files Appdx C folder). This guide file uses a 
Full Access window with howdy text initially active, as shown by the <Startup 
Window> command. 

Listing C-5 Access window startup (from the "Setup and Access Window.src" file) 

# ***********Access window startup information**************** 
#Define either SurfWriter app logo or app text. 
#Apple Guide displays the app logo or app text 
# in the upper-left corner of SurfWriter Guide's Full Access window. 
#<App Text> 11 SurfWriter Guide 11 

#if you choose to use app logo instead, 
#define the filename that contains a PICT of your app's logo 
#for example, <App Logo> "MyAppLogoPict", "MyAppLogoB&WPict" 
#(Note that the file "Standard Resources" contains templates with 
# PICT resource IDs 501 and 502 that you can modify appropriately and 
#use as the application logo picture associated with your guide). 
#If you modify the PICT resources with IDs 501 and 502 then import the 
# "Standard Resources" file, you can omit the <App Logo> command. 
#If you store your app logo in a separate file, 
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# then remove the PICT resources with resource IDs 501 and 502 
# from the "Standard Resources .. file. 

<App Logo> "SurfWriter App Color Logo", 11 SurfWriter App B&W Logon 

#define startup window, this is the window that Apple Guide 
# first displays when the user chooses the menu item SurfWriter Guide 
# If you specify a full access window, you can display HOWDY info 
# OR you can specify which of the three buttons is initially active 
# this example specifies HOWDY 
<Startup Window> FULL, HOWDY 

#You can choose FULL, SINGLE, or PRESENTATION as the startup window 
#Full access windows allow topics, index, and look for, and Howdy 
#Single access windows allow only topics and howdy 
#Presentation allows a single sequence only 

#define the text for the Howdy screen 
<Define Text Block> "Howdy Text .. 
Welcome to personal help for SurfWriter. 

To start, click Topics, Index, or Look For. 

Topics shows general categories and Index lists key words. 
Look For lets you search for help according to key words you type. 

To learn basic skills, choose the 
Tutorial item from the ? menu. 
<End Text Block> 

#now specify the defined howdy text 
<Howdy> 11 Howdy Text" 
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Finder Version Information 

Listing C-6 provides customized strings for the Finder version resources. 

Listing C-6 Finder version information (from the "Setup and Access Window.src" 
file) 

# *****************Finder file information********* 
#Specify the version strings that appear in the Finder Get Info window 
# for your guide file 
<Version> "SurfWriter Guide 1.0 ©Apple Computer, Inc.", "1.0" 

Help Content 

This section focuses on SurfWriter Guide by describing its source files for topic 
areas and topics, sequences, panels, coachmarks, context checks, and event 
functions. illustrations of SurfWriter Guide's access window and panels are 
also shown, so that you can map this onscreen help to SurfWriter Guide's 
source file content. 

Topic Areas and Topics 
The file "Topic Areas and Topics.src" specifies the topic areas and topics for 
SurfWriter Guide. Figure C-2 shows these topic areas and shows the topics 
for one specific topic area, "Using the Dictionary". 
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Figure C-2 The access window with Topics selected 

1. Click a topic ar ea: 2. Click a phrase. then click OK: 

Copying & Pastin {} v How do I plliiriiiiiiilil••••fl add a word to the dictionary? 
Fonts look up a word in the aJCtionary? 
Format ting create a custom dictionary? 
Opening & Savini! Documents add or remove a dictionary? 
Printing v Why can't I 
Setting Preferences open the dictionary? 
Styles v Definitions 
Scripting custom dictionary 
Using the Tooibar standard dict ionary 
Writing Excellent Prose 

OK 

The Guide Script commands that define the topic areas for SurfWriter Guide's 
access window are shown in Listing C-7. For each topic area, the associated 
headers and topics are also defined. SurfWriter Guide provides two complete 
topic areas, "Using the Dictionary" and "Using the Toolbar". Other topic areas 
use placeholders for topics, so that the source file is easier to follow. 

Listing C-7 Topic areas and topics ("Topic Areas and Topics.src" file) 

#define topic areas when the user chooses the Topics button, 

# Apple Guide displays t h e topic areas define d 

# by <Topic Area> commands 

#Apple Guide displays topic areas on t he left side of a full 

# access screen 

# Topic areas are often followed by <Header> commands 

# and <Topic> commands 

# You use header commands to group one or more topics 

# in the same category 
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#Headers are not required --
# you can choose to have all topics with no groupings by headers 
# or you can have headers with each topic grouped with a header 
#Note that a topic area MUST have at least 1 topic associated with it 

# A header command defines the bold headers that Apple Guide displays 
# in the right column when the user selects its associated topic area 

# A topic command defines a topic that Apple Guide displays 
# in the right column; the topic can either appear by itself or 
# have a header associated with it 
#Note that you should either have all single topics or 
# have all topics grouped with headers 
#Apple Guide expands and compresses the topics under a header 
# when the user clicks the triangle to the left of the header 

#topic areas are displayed in the same order as they appear 
# in the source file 

#Tip: You can use style or color information in Guide Script 
# commands to make your source files easier to read 

<Topic Area> "Copying & Pasting" #topic area on left column of screen 
<Header> 11 How do I" #header for right column when user 

# chooses "Copying & Pasting" 
#topics displayed/expanded/etc with "Copying & Pasting" 

<Topic> "placeholder for topic?","SequenceGeneric" 
<Topic> "another placeholder for topic?","SequenceGeneric" 
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<Topic Area> "Using the Dictionary" 
<Header> "How do I" 

<Topic> "add a word to the dictionary?","SequenceAddWords" 
<Topic> 11 look up a word in the dictionary?","SequenceGeneric" 
<Topic> "create a custom dictionary?", 

11 SequenceCreateCustomDictionary" 
<Topic> "add or remove a dictionary?","SequenceGeneric" 

<Header> "Why can't I" 
<Topic> "open the dictionary?","SequenceGeneric" 

<Header> "Definitions" 
<Topic> 11 Custom dictionary","SequenceDefnCustomDictionary" 

<Topic> "standard dictionary","SequenceDefnStdDictionary" 

<Topic Area> "Fonts" 
<Header> "How do I" 

<Topic> "placeholder for topic?","SequenceGeneric" 
<Topic Area> "Formatting" 

<Header> "How do I" 
<Topic> "placeholder for topic?","SequenceGeneric" 

<Topic Area> "Opening & Saving Documents" 
<Header> "How do I" 

<Topic> "placeholder for topic?","SequenceGeneric" 
<Topic Area> "Printing" 

<Header> "How do I" 
<Topic> "placeholder for topic?","SequenceGeneric" 

<Topic Area> "Setting Preferences" 
<Header> "How do I" 

<Topic> "placeholder for topic?","SequenceGeneric" 
<Topic Area> "Styles" 

<Header> "How do I" 
<Topic> "placeholder for topic?","SequenceGeneric" 

<Topic Area> "Scripting" 
<Header> "How do I" 

<Topic> "placeholder for topic?","SequenceGeneric" 
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<Topic Area> "Using the Toolbar" 
<Header> "How do I" 

<Topic> "use the tools in the toolbar?","Toolbar" 
<Topic Area> "Writing Excellent Prose" 

<Header> "How do I" 
<Topic> "placeholder for topic?","SequenceGenericu 

Sequences 
This section focuses on the file "Sequence Definitions.src", which specifies the 
sequences for each topic in SurfWriter Guide. The main sequences for each 
topic area are shown in Listing C-8 through Listing C-12. 

The Placeholder Sequence 

SurfWriter Guide uses the placeholder sequence shown in Listing C-8 for all 
topics other than those associated with "Using the Dictionary" and "Using the 
Toolbar". Thus, the guide file displays all topic areas and topics, while allowing 
the actual sequences to be added incrementally. 

Listing C-8 Placeholder sequence (from the "Sequence Definitions.src" file) 

#Here's a sequence definition used as a placeholder 
<Define sequence> "SequenceGeneric", 11 How do I *do this task*?" 
<SNBS> "Std nav bar" 

<Panel> "PanelGeneric" 
<End sequence> 

"How do I use the tools in the toolbar?" Sequence 

The sequence definition shown in Listing C-9 specifies the navigation button 
set for the sequence and then lists all the panels that are part of the sequence. 
This sequence has one panel ("Tools with Tip") that launches another sequence 
if the user clicks the panel's Tip button. The sequence "Toolbar TipSeq" shows 
the sequence for the Tip panel. 
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Listing C-9 Sequence for "How do I use the tools in the toolbar?" (from the 
"Sequence Definitions.src" file) 

#A sequence defn for a topic of the topic area "Using the Toolbar" 
<Define sequence> 11 Toolbar", "How do I use the tools in the toolbar?" 

<SNBS> "Std nav bar" 
<Panel> "Use Tools" 
<Panel> "Tools 2" 

<Panel> "Tools 3" 

<Panel> "Tools with Tip" 
<Panel> 11 Tools 411 

<End sequence> 

#A sequence defn for a Tip of "How do I use the tools in the toolbar?" 
<Define sequence> "Toolbar TipSeq", "Tip: How do I use the tools in 
the toolbar?" 

<SNBS> "Std nav bar" 
<Panel> "Toolbar Tip" 

<End sequence> 

"How do I add a word to the dictionary?" Sequence 

The sequence definition shown in Listing C-10 includes one <Skip If> 
command and three <Make Sure> commands. The second panel in the 
sequence is skipped if the condition specified in the command is true. This 
sequence uses Continue panels, as shown by the <Make Sure> commands. If 
the condition specified in the <Make Sure> command is not true, a Continue 
panel is displayed. (See the source file on the CD-ROM for an example of a 
sequence that uses an Oops panel.) See Figure C-4 on page C-25 for an 
illustration of the panels in this sequence. 
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Listing C-10 Sequence for "How do I add a word to the dictionary?" (from the 
----------=- "Sequence Definitions.src" file) 

#A sequence defn for a topic of the topic area "Using the Dictionary" 
<Define sequence> "SequenceAddWords", "How do I add a word to the 
dictionary?" 

<SNBS> "Std nav bar" 
<Panel> "AddWordsl" 

<Skip If> ActiveWindow( I ttxt I, "Dictionary") AND ActiveAppis (I ttxt I) 
<Panel> "AddWords2" 

<Make Sure> ActiveAppis( 1 ttxt 1
), "SWContinuePanelSeq" 

<Make Sure> ActiveWindow( 1 ttxt 1
, "Dictionary"), "SWContinuePanelSeq" 

<Panel> "AddWords3" 
<Make Sure> ActiveWindow( 1 ttxt 1

, "Dictionary"), "SWContinuePanelSeq" 
<Panel> "AddWords4" 

<End sequence> 
#*******************Example of a Continue sequence*************** 
#A sequence definition for a Continue sequence in the above topic, 
# "How do I add a word to the dictionary?" 
<Define Sequence> "SWContinuePanelSeq", "Oops" 

<Panel> "SWContinuePanel" 
<End Sequence> 

"How do I create a custom dictionary?" Sequence 

SurfWriter Guide includes the topic "How do I create a custom dictionary?" 
The sequence for this topic includes a panel containing radio buttons, as shown 
in Figure C-3. 
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Figure C-3 A panel with radio buttons 

s::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::ts 
How do I create a custom dictionary? 

Which do you want to do? Click one: 

0 manually create a custom dictionary 
® automatically create a custom dictionary 

Make your choice, then click the right arrow. 

SurfWriter Guide allows the user to create a custom dictionary either 
automatically or manually. To implement this, a panel with radio buttons 
is used and the sequence definition (shown in Listing C-11) includes an <ll> 
command that tests the state of a radio button and then branches accordingly. 

When using SurfWriter Guide, if the user chooses to create a custom dictionary 
automatically (by clicking the appropriate radio button then clicking the right 
arrow button), the <ll> command and the statements immediately following 
the <If> command are executed (see Listing C-11). Note that the panels in this 
branch include <Skip ll> and <Make Sure> commands. This source file uses 
the Activewindow, OpenWindow, and ActiveAppis condition functions 
(these context checks are defined in the Standard Setup file) to determine 
whether the folder is active and if not, it automatically activates or opens 
the folder for the user. 

The panels corresponding to the user choosing the manual method follow the 
<Else> command. The ActiveWindow and ActiveAppis condition functions 
are also used in this branch to determine whether a particular window is active 
and open. Both branches use Continue panels if Acti veWindow returns false. 
Note that it's important that SurfWriter Guide determine not only whether 
a window is open but also whether it is active, especially when using 
coachmarks for a window. Otherwise, the coachmark may be drawn in 
an inappropriate window. 

Finally, Listing C-11 shows that the sequence uses a common closure panel, 
which is presented to the user no matter which branch they chose. See 
Figure C-5 on page C-29 and Figure C-6 on page C-30 for illustrations of 
the panels in this sequence. 
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Listing C-11 Sequence for "How do I create a custom dictionary?" (from the 
---------=- "Sequence Definitions.src" file) 

#A sequence defn for a topic of the topic area "Using the Dictionary" 
<Define sequence> 11 SequenceCreateCustomDictionaryn, 11 How do I create 
a custom dictionary?~~ 

<SNBS> 11 Std nav barn 
<Panel> 11 CreateCustomintro 11 

<Panel> 11 CreateCustomDecision 11 

#branch based on state of radio buttons in previous panel 
<IF> radioButtonState( 11 automatically create a custom dictionary~~, 
11 CreateCustomDecision") 
#if user chose ~~automatically" do this sequence of panels 
<Skip If> Activewindow( 1 MACS 1

, "SurfWriter Scripts 11
) AND 

ActiveAppiS( 1 MACS 1
) 

<Panel> 11 CreateCustomAuto1 11 

<Make Sure> Activewindow( 1 MACS 1
, "SurfWriter Scripts"), 

11 SWContinueSeqCustomAutol" 
<Make Sure> OpenWindow( 1 MACS 1

, 
11 SurfWriter Scripts"), 

11 SWContinueSeqCustomAutol 11 

<Make Sure> ActiveAppis( 1 MACS 1
), "SWContinueSeqCustomAutol" 

<Panel> 11 CreateCustomAuto2 11 

<Else> 
#if user chose 11 manually 11 do this sequence of panels 

<Skip If> Activewindow( 1 ttxt 1 , "Dictionary") AND ActiveAppis ( 1 ttxt 1 ) 

<Panel> "CreateCustomManuall 11 

<Make Sure> ActiveAppis( 1 ttxt 1
) 1 

11 SWContinuePanelSeq 11 

<Make Sure> Activewindow( 1 ttxt I , 
11 Dictionary 11

), 

11 SWContinueSeqCustomManuall" 
<Panel> 11 CreateCustomManual2" 

<Make Sure> ActiveAppis( 1 ttxt 1
), "SWContinuePanelSeq" 

<Make Sure> ActiveWindow( I ttxt I, "Dictionary"), 
11 SWContinueSeqCustomManual1 11 

<Panel> 11 CreateCustomManual3 11 

<End If> 
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#common closure panel 
<Panel> "CreateCustomAllDone" 

<End sequence> 

#A sequence definition for a Continue sequence in the topic, 
# "How do I create a custom dictionary (automatically)?" 
<Define Sequence> "SWContinueSeqCustomAutol", "Oops" 

<Panel> "SWContinuePanelCustomAutol" 
<End Sequence> 
#A sequence defn for another Continue sequence in the topic, 
# "How do I create a custom dictionary (manually)?" 
<Define Sequence> "SWContinueSeqCustomManuall", "Oops" 

<Panel> "SWContinuePanelCustomManuall" 
<End Sequence> 

The remaining sequence definitions used by panels of the sequence "How do I 
create a custom dictionary?" are self-explanatory and are shown in Listing C-12. 

Listing C-12 Sequence definitions for Huh?, Definition, and Related Topics (from the 
------------'=' "Sequence Definitions.src" file) 

#A sequence defn for "Definition:AppleScript" 
<Define sequence> "Defns:AppleScript", "Definition: AppleScript" 

<SNBS> "Std nav bar" 
<Panel> "HotT AppleScript" 

<End Sequence> 

#A sequence definition for a Huh? sequence 
<Define sequence> "HuhCompareManualAndAuto", "Comparison of manual 
and automatic methods" 

<SNBS> "Std nav bar" 
<Panel> "CompareManualAndAuto" 

<End Sequence> 
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#A sequence defn for a Tip sequence of creating a custom dictionary 
<Define sequence> "Tip:CustomDictionary", "Tip: How do I create a 
custom dictionary?" 

<SNBS> "Std nav bar" 
<Panel> 11 TipForCustomDictionary" 

<End sequence> 

#A seq defn for Related Topics sequence of creating custom dictionary 
<Define sequence> "Related Topics:CustomDictionary", "Related Topics: 
Bow do I create a custom dictionary?" 

<SNBS> "Std nav bar" 
<Panel> "RelatedTopicsForCustomDictionary" 

<End sequence> 

#A sequence definition for a Huh? sequence 
<Define sequence> "BuhScriptsFolder", "Scripts in the SurfWriter 
Scripts folder" 

<SNBS> "Std nav bar" 
<Panel> "ScriptsFolder" 

<End sequence> 

#Bere•s a seq defn for the panel that defines "Standard Dictionary" 
<Define sequence> "SequenceDefnStdDictionary", "Definition: standard 
dictionary" 

<SNBS> "Std nav bar" 
<Panel> "PanelDefineStandardDictionary" 

<End sequence> 

#Bere•s a sequence defn for the panel that defines "Custom Dictionary" 
<Define sequence> "SequenceDefnCustomDictionary", "Definition: custom 
dictionary" 
<SNBS> "Std nav bar" 

<Panel> "PanelDefineCustomDictionary" 
<End sequence> 
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Panels 

This section focuses on the file II Panel Definitions.src", which specifies the 
panels for SurfWriter Guide. 

The Placeholder Panel 

SurfWriter Guide uses the placeholder panel shown in Listing C-13 for all 
topics other than those associated with "Using the Dictionary'' and "Using the 
Toolbar". Thus the guide file displays a generic panel for these topics. In this 
way, the actual content of the panels can be added incrementally and at a later 
time. 

Listing C-13 Placeholder panel (from the "Panel Definitions.src" file) ---------------= 

<Define Panel> "PanelGeneric" 
Placeholder for information that you supply. 
<End Panel> 

"How do I use the tools in the toolbar?" Panels 

The panel definitions shown in Listing C-14 are simple examples of various 
Apple Guide features. They show how to place a standard button on a panel, 
how to use the Tag and Body formats, how to specify prompts, and how to use 
a Tip or Related Topics button to launch a new sequence. 

Listing C-14 Panels for "How do I use the tools in the toolbar?" (from the 
------------------=: "Panel Definitions.src" file) 

<Define Panel> "Use Tools" 
<Panel Prompt> "introToolsprompts" 
The SurfWriter toolbar contains tools that you use to create and 
manipulate graphics. 

For an overview of each tool in the toolbar, click Toolbar Tour. For 
background information on graphics, click Designing Graphics. 

C-22 Help Content 



APPENDIX C 

SurlWriter Guide and Its Source Files 

#When you specifically place an object you place it relative to the 
#current pen location. Note that the current pen location isn't reset 
#after an object is absolutely placed. The current pen location's 
# horizontal coordinate is the left edge of the current format; 
# the vertical coordinate corresponds to the last object not 
# specifically placed using coordinates. 
#it's (x, y) 
#The first button is placed 50 pixels to the right and 20 pixels 
# down of the current pen location; the second button is placed 50 
# pixels to the right and 80 pixels down of the current pen location. 
<Standard Button> "Toolbar Tour", Point(50,20), doNothingEvent() 
<Standard Button> "Designing Graphics", Point(50,80), doNothingEvent() 
<End Panel> 

<Define Panel> "Tools 2" 
<Panel Prompt> "doThisprompt" 
<Format> "Tag" 
Do This 
<Format> "Body" 
Click the Pencil icon in the toolbar. 
<End Panel> 

<Define Panel> "Tools 3" 
#panel that shows default features 
<Panel Prompt> NONE 

<End Panel> 
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<Define Panel> "Tools with Tip" 
#panel that shows a Tip button 
<Panel Prompt> "doThisprompt 11 

<Format> "Tag" 
Do This 
<Format> "Body" 
Click the Pen icon in the toolbar. 

For information about quickly selecting tools, click the Tip button. 

<Standard Button> "Tip", RIGHT, LaunchNewSequenceNewWindow("Toolbar 
TipSeq") 
<End Panel> 

<Define Panel> "Toolbar Tip" 
<Panel Prompt> "Defn&HuhPrompts" 
You can also select tools by using Command-key equivalents. See the 
Shortcuts Guide for a complete list of these keys. 
<End Panel> 

<Define Panel> "Tools 4" 
<Panel Prompt> "YouAreDone2" 
<Format> "Tag" 
Do This 
<Format> "Body" 
Close the toolbar. 

<Standard Button> "Related Topics .. , CENTER, doNothingEvent() 
<End Panel> 

"How do I add a word to the dictionary?" Panels 

SurfWriter Guide includes the topic "How do I add a word to the dictionary?" 
Figure C-4 shows illustrations of the panels associated with this topic. 
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Figure C-4 "How do I add a word to the dictionary?" panels 

ti:l:m:m:::m:::mm::::mm:::::::::::::::::::::::::::::::::::::::::::::m:m::::::::::::::::::: ai 

How do I add~ .word to the dictionary? 

Surtwriter comes with the Surtwriter dictionary, 
which you can use to check the spelling in your 
documents. 

To begin, click the right arrow. 

s:m:::m::::::::::mm::m:::::::::::::::::::::::::m:::::::::::::::::::m::::::::::::::::::::::: Iii 
liow do. I "tid.~ word ~o the diCtiQn~fy?. ' • •· 

Do This Choose Dictionary from the Utilities menu to 
open the Dictionary window. 

Do this step, then click the right arrow. 

GIJ)J Huh? 

How do I add a word to the dictionary?. 

Do This 

Iii ::m:::mm:m::::;:::::::m:::::::::::::::::mm:::::::::::::::::mm:m::::::::::::::::::::: SJ 

How do I add a word to the dictionary? 

Your word is now part of the Surtwriter dictionary. 

That's all, you're done. 

The panel definitions for this topic (see Listing C-15) show use of coachmarks 
and show how to implement a Continue panel. Note that to perform an action 
for the user, the Continue panel includes an <On Panel Show> command that 
specifies an event function. This guide file uses the DoAppleScript built-in 
event function to execute a specified script. This particular script opens a file 
containing a picture of the dictionary. Note that this guide file was originally 
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designed for use with the SurfWriter application; however, for illustrative 
purposes SimpleText is used in this example. 

Listing C-15 Panels for "How do I add a word to the dictionary?" (from the 
-----------=- "Panel Definitions.src" file) 

<Define Panel> "AddWordsl" 
<Panel Prompt> "introprompts" 

SurfWriter comes with the SurfWriter dictionary, which you can use to 
check the spelling in your documents. 
<End Panel> 

<Define Panel> "AddWords2" 
<Panel Prompt> "doThisPrompt" 

<Coach Mark> "UtilsOpenDictionary" 
<Format> "Tag" 
Do This 
<Format> "Body" 
Choose Dictionary from the Utilities menu to open the Dictionary 
window. 
<End Panel> 

<Define Panel> "AddWords3" 
<Panel Prompt> "doThisprompt" 

<Format> "Tag" 
Do This 
<Format> "Body" 
Type your word to add to the dictionary in the New Word text box. 
#for SurfWriter, you would use: 
#<Coach Mark> "DictionaryNewWord" 
#for an application similar to SimpleText: 
<Coach Mark> "DictionaryNewWordSimpleText" 
<End Panel> 

<Define Panel> "SWContinuePanel" 
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#open the dictionary for the user, by sending an Apple event to the 
# SurfWriter application requesting it to open the Dictionary window 
#Apple Guide sends this event to SurfWriter when it shows this panel 
#<On Panel Show> SWOpenDictionary( 11 Dictionary 11

) 

<Panel Prompt> 11 COntinuePrompt 11 

Please wait a moment. Apple Guide is assisting you by opening the 
dictionary. 

<3D Button> 1070, 1072, Center, GoBack() 
# 
#(For illustrative purposes, this example uses SimpleText instead of 
# SurfWriter.) 
<On Panel Show> DoAppleScript( 11 :SurfWriter Scripts 
src:OpenDictionarySimpleText .. ) 
<End Panel> 

<Define Panel> "AddWords4 11 

<Panel Prompt> .. YouAreDone .. 
Your word is now part of the SurfWriter dictionary. 
<End Panel> 

#Example of an Oops panel 
#(If you use Oops instead of Continue panel in the above sequence) 
<Define Panel> 11 SWOopsPanel 11 

<Panel Prompt> NONE 
<Format> "Tag .. 
Oops 
<Format> "Body .. 
You did not open the dictionary. Click OK for instructions (or open 
the dictionary, then click OK). 

<Standard Button> 11 0K 11
, Center, GoBack() 

<End Panel> 
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"How do I create a custom dictionary?" Panels 

SurfWriter Guide also includes the topic ~~How do I create a custom 
dictionary?" Figure C-5 and Figure C-6 show illustrations of the panels 
associated with this topic. Figure C-5 shows the panels a user views when 
using the automatic method, and Figure C-6 shows the panels a user views 
when using the manual method. 
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Figure C-5 "How do I create a custom dictionary?" panels (automatic branch) 

Which do you want to do? Click one: 

0 manually create a custom dictionary 
® automatically create a custom dictionary 

Make your choice, then click the right arrow. 

Do This Open the SurtWriter Scripts folder. For 
information about this folder, click Huh? 
below. 

Related Topics 

Do this step, then ctick the right arrow. 
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Figure C-6 "How do I create a custom dictionary?" panels (manual branch) 

rs:::::::::mmm::::m:::::::m::mmmmm:::::::::::::::::::::::::::::::::::::::::::::::::::: 13 am:::::::::::::::::::mmmmm:::mm::m:::::::::::::::mmmmm:::mm:::::::::m:: 1B 

How do I aeate a custom diclionary? How do I create a cUStom cOctlonary? 

You can create a custom dictionary manually or by Which do you want to do? Click one: 
using AP.P.leScrip_!. For a comparison of these two 
methods, click Huh? below. ®manually create a custom dictionary 
To begin, cHck the right arrow. 0 automatically create a custom dictionary 

I! Huh? 1;r::':~fiiJ~ ':':a;t;~~I;l;ti,;;:,;~:;::~:':nan)·r I> 1 ;;· :; ~~~$~i~~~l" JM I> J 

ra::::mm::::::m::::::m::::::::::::::::::::::::::::::::m:m:::::::::::::::::m::::::::::::::::; Iii 
HOw dol create a custom dictionary? 

DoTitis Choose Dictionary from the Utilities menu to 
open the Dictionary window. 

Do this step, then did( the right arrow. 

f5 :::mm:::m::::::::::::::::::::::::::::::m:m::m::::::::::::::::::::::::::::::::::::::::m:::~ e 13 ::::::::::::::::::::::::mmm:m;::::::::mm:mm:::m::m::::n:mmmm::m:mm::: w 
How do I create a custom dictionary? 

Do This Type your word in the New Word textbox of 
the Dictionary window. Repeat this step for all 
your words. For a shortcut, click the Tip 
button. 

Tip 

Do this step, then cfid( the right arrow. 

How do I create a CUstom dictionary? 

Your custom dictionary is now created. 

That's all, you're done! 

The panel definitions for this topic, shown in Listing C-16, show use of hot 
text with a Definition panel and also illustrate how to place radio buttons on 
a panel. In addition, Listing C-16 shows use of Huh?, Tip, and Related Topics 
panels. 
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Listing C-16 Panels for "How do I create a custom dictionary?" (from the 
-------~ "Panel Definitions.src" file) 

#To use styled text in a panel, you can either directly embed the 
# style information in the file (if you have the appropriate XTND 
# translator) or you can specify the style information 
# using format commands, as shown here. 
#introduction panel 
<Define Panel> "CreateCustomintro" 
#this panel has an active Huh? button 
<Dimmable Button Data> "Huh?", "HuhCompareManualAndAuto" 

<Panel Prompt> "introprompts" 
<Format> "PlainText" 
You can create a custom dictionary manually or by using 
<Format> "UnderlineText" 
<Hot Text> "AppleScript", FIRST, 
LaunchNewSequenceNewWindow("Defns:AppleScript") 
AppleScript. 
<Format> "PlainTextReset" 
For a comparison of these two 
<Format> "PlainTextNormal" 
methods, click Huh? below. 
<End Panel> 

#Alternatively to using format commands for styled text, you can 
# define the panels that contain styled text in a separate file 
# and save the file in a format for which you have an XTND translator, 
# to more easily assign style information to the hot text. 
#Here's an example (from a file saved in an appropriate format, 
# "Panels with Styleinfo.src") 
#<Define Panel> "CreateCustomintro" 
#this panel has an active Huh? button 
#<Dimmable Button Data> "Huh?", "HuhCompareManualAndAuto" 

#<Panel Prompt> "introprompts" 
#<Format> "Full2" 

Help Content C-31 



APPENDIX C 

SurfWriter Guide and Its Source Files 

#Here's the panel text: 
#You can create a custom dictionary manually 
#<Hot Text> "AppleScript", FIRST, 
LaunchNewSequenceNewwindow("Defns:AppleScript") 
#or by using AppleScript. For a comparison of these two 
#methods, click Huh? below. 
#<End Panel> 

#definition panel for AppleScript 
<Define Panel> "HotT AppleScript" 

<Panel Prompt> "Defn&HuhPrompts" 
AppleScript is a scripting language that lets you 
create sets of written instructions ("scripts") 
to automate tasks you perform in an application. 
<End Panel> 
#definition panel for Huh? panel that compares Auto vs Manual methods 
<Define Panel> "CompareManualAndAuto" 
<Panel Prompt> "Defn&HuhPrompts" 

You can create a custom dictionary by individually entering each word 
yourself or by using a script that searches an open document for 
tagged words and places them in the dictionary for you. 
<End Panel> 

#decision panel 
<Define Panel> "CreateCustomDecision" 
<Panel Prompt> "standard" 

Which do you want to do? Click one: 

#for <Radio Button> command, provide title of button, 
# default setting, and font 
<Radio Button> "manually create a custom dictionary", FALSE, ,,, 
APPLEGUIDE 
<Radio Button> "automatically create a custom dictionary", TRUE, 
APPLEGUIDE 
<End Panel> 
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#first panel for "manually create a custom dictionary" branch 
<Define Panel> "CreateCustomManual1" 
<Coach Mark> "UtilsOpenDictionary" 
<Panel Prompt> "doThisPrompt" 

<Format> "Tag" 
Do This 
<Format> "Body" 
Choose Dictionary from the Utilities menu to open the Dictionary 
window. 
<End Panel> 

#Continue panel for "CreateCustomManual1" panel 
<Define Panel> "SWContinuePanelCustomManual1" 
#open the Dictionary window for the user, by sending an Apple event to 
# the SurfWriter application requesting it to perform this action 
#[for example, <On Panel Show> SWOpenDictionary("Dictionary") ] 
#Apple Guide sends this event to SurfWriter when it shows this panel 
# 
<Panel Prompt> "continuePrompt" 
Please wait a moment. Apple Guide is assisting you by opening the 
Dictionary window. 

<3D Button> 1070, 1072, Center, GoBack() 
# 
#(For illustrative purposes, this example uses SimpleText instead of 
# SurfWriter.) 
<On Panel Show> DoAppleScript(":SurfWriter Scripts 
src:OpenDictionarySimpleText") 
<End Panel> 

#second panel for "manually create a custom dictionary .. branch 
<Define Panel> "CreateCustomManual2" 

<Panel Prompt> 11 doThisPrompt 11 

<Format> "Tag" 
Do This 
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<Format> "Body" 
Click the Create New Custom Dictionary button to create and name a 
new custom dictionary. 
#For SurfWriter, you would use: 
#<Coach Mark> "CustomDictionary" 
<Coach Mark> "CustomDictionaryButtonSimpleText" 
<End Panel> 

#third panel for "manually create a custom dictionary" branch 
<Define Panel> "CreateCustomManual3 11 

<Panel Prompt> "doThisPrompt" 
<Format> "Tag" 
Do This 
<Format> "Body" 
Type your word in the New Word textbox of the Dictionary window. 
Repeat this step for all your words. For a shortcut, click the Tip 
button. 

<Coach Mark> 11 DictionaryNewWordSimpleText 11 

<Standard Button> "Tip", RIGHT, 
LaunchNewSequenceNewWindow("Tip:CustomDictionary") 
<End Panel> 

#Tip panel for nmanually create a custom dictionary~~ branch 
<Define Panel> "TipForCustomDictionary" 

<Panel Prompt> "Defn&HuhPrompts" 
To quickly add a word to the dictionary, select the word in your 
document and then click the Add word button in the Dictionary window. 
<End Panel> 
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#first panel for "automatically create a custom dictionary" branch 
<Define Panel> 11 CreateCustomAutol" 
#this panel has an active Huh? button 
<Dinunable Button Data> "Huh?", "HuhScriptsFolder" 

<Panel Prompt> "doThisPrompt" 
<Format> "Tag" 
Do This 
<Format> "Body 11 

Open the SurfWriter Scripts folder. For information about this 
folder, click Huh? below. 

<Standard Button> 11 Related Topics", RIGHT, 
LaunchNewSequenceNewWindow("Related Topics:CustomDictionary") 
<End Panel> 

#Related Topics panel for "automatically create a custom dictionary" 
<Define Panel> "RelatedTopicsForCustomDictionary" 

<Panel Prompt> "Defn&HuhPrompts" 
Also see these topic areas: 

Scripting 
Writing excellent prose 

<End Panel> 

#Huh panel for "automatically create a custom dictionary" branch 
<Define Panel> "ScriptsFolder" 

<Panel Prompt> 11 Defn&HuhPrompts" 
The SurfWriter Scripts folder contains three scripts: Custom 
Dictionary, Create Glossary, and Create Bibliography. 
<End Panel> 

#Continue panel for "CreateCustomAutol" panel 
<Define Panel> "SWContinuePanelCustomAutol" 
#Open the SurfWriter Scripts folder for the user, 
# by providing a script that performs the action for the user. 
# Use the DoAppleScript event function to run the script. 
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<Panel Prompt> "continuePrompt" 
Please wait a moment. Apple Guide is assisting you by opening the 
SurfWriter Scripts folder. 

<3D Button> 1070, 1072, Center, GoBack() 
# 
<On Panel Show> DoAppleScript(":SurfWriter Scripts 
src:OpenSurfWriterScriptsFolder") 
<End Panel> 

#second panel for "automatically create a custom dictionary" branch 
<Define Panel> "CreateCustomAuto2" 

<Panel Prompt> "doThisPrompt" 
<Format> "Tag" 
Do This 
<Format> "Body" 
Double-click the Custom Dictionary script. 
<Coach Mark> "Custom Dictionary File" 
<End Panel> 

#closure panel for ,.creating a custom dictionary,. 
<Define Panel> "CreateCustomAllDone" 

<Panel Prompt> "standard2" 
~our custom dictionary is now created. 
<End Panel> 
# *******panels for Definition panels******* 
<Define Panel> "PanelDefineStandardDictionary" 
<Panel Prompt> "Defn&HuhPrompts" 
Placeholder for information that you supply. 
<End Panel> 
<Define Panel> "PanelDefineCustomDictionary" 
<Panel Prompt> "Defn&HuhPrompts" 
Placeholder for information that you supply. 
<End Panel> 
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Coach marks 
The file "CoachMarks SW.src" specifies the coachmarks for the guide file. 
Listing C-17 shows the contents of this file. The commands that define a 
coachmark first specify the name of the coachmark, the signature of the target 
application, and the coachmark style (red circle or red underline, for example). 
For menu coaches, the menu title and menu item to coach are also provided. 
For item coaches, the name of the dialog box and the dialog item to coach are 
also provided. For window coaches, the name of the window and location to 
coach are also provided. 

Listing C·17 Coachmarks ("CoachMarks SW. src" file) ---------------= 

#coach SurfWriter's Dictionary menu item in the Utilities menu 
<Define Menu Coach> "UtilsOpenDictionary", 'WAVE', REDCIRCLE, 
"Utilities", "Dictionary ... ", RED 

#coach dialog item 3 in SurfWriter's "Dictionary" dialog box 
<Define Item Coach> "DictionaryNewWord", 'WAVE', REDUNDERLINE, 
"Dictionary", DialogiD(3) 
#coach dialog item 8 in SurfWriter's "Dictionary" dialog box 
<Define Item Coach> "CustomDictionary", 'WAVE', REDCIRCLE, 
"Dictionary", DialogiD(B) 

#coach a specific area in a window opened by SimpleText 
<Define Window Coach> "DictionaryNewWordSimpleText", 'ttxt', 
REDUNDERLINE, "Dictionary", Rect(74,250,82,395) 

#coach a specific area in a window opened by SimpleText 
<Define Window Coach> "CustomDictionaryButtonSimpleText", 'ttxt', 
REDCIRCLE, "Dictionary", Rect(250,155,262,360) 

#coach a specific area in the SurfWriter Scripts folder 
<Define AppleScript Coach> "Custom Dictionary File", 
REDCIRCLE,":SurfWriter Scripts src:Finder Coach Surf Custom File" 
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Context Checks 

SurfWriter Guide uses context checks to dynamically adjust the sequence of 
display of its panels based on the state of the user's environment. For example, 
SurfWriter Guide verifies that a certain window is open and active before 
displaying a panel that coachmarks an item within the window. For panels that 
contain radio buttons, it also adjusts the display of panels that follow it. These 
panels are displayed based on the state of the radio buttons. 

SurfWriter Guide defines its condition functions (context checks) with the 
<Define Context Check> command. It then specifies that condition function in 
commands related to conditional execution, such as the <If>, <Skip If>, <Make 
Sure>, and <Start Making Sure> commands. 

This guide file uses the radioButtonState built-in condition function and 
also uses the ActiveWindow, OpenWindow, and ActiveAppis condition 
functions defined in the Standard Setup file. See Listing C-10 on page C-17 and 
Listing C-11 on page C-19 for examples of the use of these condition functions. 
The file 11DCC SW.src" on the CD-ROM shows additional examples of 
condition functions. 

Event Functions 

SurfWriter Guide uses event functions to perform some action for the 
user. SurfWriter Guide defines its event functions using the <Define Event> 
command and then specifies these event functions or built-in event functions 
when using the <Standard Button>, <Hot Text>, and <On Panel Show> 
commands. 

For example, SurfWriter Guide often uses a Tips or Related Topics button. 
SurfWriter Guide uses the LaunchNewSequenceNewWindow built-in event 
function to display a new sequence to the user when the user clicks the button. 

SurfWriter Guide also uses Continue panels. By using the <On Panel Show> 
command to associate an event function (such as the built-in event function 
DoAppleScript) with the display of a Continue panel, SurfWriter Guide 
performs an action for the user. 

See Listing C-16 on page C-31 for examples of the use of these event functions. 
The file "Event Functions SW.src" on the CD-ROM shows additional examples 
of event functions. 
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Index and Look For Content 

This section focuses on the files that specify the Index and Look For content 
for SurfWriter Guide. illustrations of SurfWriter Guide's access window when 
Index is active and when Look For is active are shown, along with explanatory 
text describing how SurfWriter Guide implements its Index and Look For 
content. 

SurfWriter Guide provides a list of its index terms. And to enhance Apple 
Guide's searching facility, in addition to its index terms, SurfWriter Guide 
provides three lists: the ignore list, exception list, and synonym list. 

Index Terms 
The file "Index Entries.src" specifies the index terms for SurfWriter Guide. 
Figure C-7 shows SurfWriter Guide's access window when Index is active. 

Figure C-7 

Apple menu 
clipboard 
closing 
copying 
custom 
deleting 
dictionary 

fonts 
formats 

The Index window 

v How dol 
save a document? 
open a document? 
close a document? 
print a document? 

Index and Look For Content 

OK 
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SurfWriter Guide's index terms, and the headers and topics associated with 
each index term, are shown in Listing C-18. 

Listing C-18 Index terms ("Index Entries.src" file) 
----------------~ 

<Index> "dictionary" #index entry 
# specify headers and topics for this index term 

<Header> "How do I" #header 
#topics 

<Topic> "add a word to the dictionary?","SequenceAddWords" 
<Topic> "look up a word in the dictionary?","SequenceGeneric" 
<Topic> "create a custom dictionary?","SequenCreatCustDictionry" 
<Topic> "add or remove a dictionary?","SequenceGeneric" 

<Header> "Why can't I" 
<Topic> "open the dictionary?","SequenceGeneric" 

<Header> "Definitions" 
<Topic> "custom dictionary","SequenceDefnCustomDictionary" 
<Topic> "standard dictionary","SequenceDefnStdDictionary" 

<Index> "toolbar" #index entry 
<Header> "How do I" 

<Topic> "use the tools in the toolbar?","Toolbar" 
<Index> "tools" #index entry 

<Header> "How do I" 
<Topic> "use the tools in the toolbar?","Toolbar" 

<Index> "pencil" #index entry 
<Header> "How do I" 

<Topic> "use the tools in the toolbar?","Toolbar" 
<Index> "hammer" #index entry 

<Header> "How do I" 
<Topic> "use the tools in the toolbar?","Toolbar" 
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<Index> "opening" 
<Header> "How do I" 

<Topic> "open a document?","SequenceGeneric" 
<Header> "Why can't I" 

<Topic> "open the dictionary?","SequenceGeneric" 

#index entry 

<Index> "custom.. #index entry 
<Header> "How do I .. 

<Topic> "create a custom dictionary? .. , .. SequenCreatCustDictionry .. 
<Header> "Definitions" 

<Topic> "custom dictionary","SequenceDefnCustomDictionary" 
<Index> .. standard" #index entry 

<Header> .. Definitions" 
<Topic> .. standard dictionary .. , .. SequenceDefnStdDictionary .. 

<Index> .. Utilities menu.. #index entry 
<Header> 11 How do I .. 

<Topic> 11 USe the dictionary? .. , .. SequenceGeneric .. 
<Topic> "use the thesaurus? .. , .. SequenceGeneric .. 

#specify invisible index terms. 
#invisible index terms do not appear in the index, but are included 
# when the user searches using the Look For feature 
<Index> "customizing", FALSE #index entry (invisible) 

<Header> .. How do I" 
<Topic> "add a word to the dictionary? 11

,
11 SequenceAddWords 11 

<Topic> .. add or remove a dictionary? 11

1
11 SequenceGeneric .. 

<Topic> 11 Create a custom dictionary? 11
, .. SequenCreatCustDictionry .. 

<Header> .. Definitions .. 
<Topic> .. custom dictionary .. , .. SequenceDefnCustomDictionary .. 

<Index> 11 Spell .. , FALSE #index entry (invisible) 
<Header> .. How do I .. 

<Topic> .. look up a word in the dictionary?", .. SequenceGeneric .. 
<Index> 11 bitmap .. , FALSE #index entry (invisible) 

<Header> .. How do I" 
<Topic> .. use bitmapped fonts? 11

1

11 SequenceGeneric" 
<Topic> .. create bitmapped graphics? .. , .. SequenceGeneric .. 
<Topic> .. placeholder for topic? .. , .. SequenceGeneric .. 
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<Index> "definitions", FALSE #index entry (invisible) 
<Header> "Definitions" 

<Topic> "custom dictionary","SequenceDefnCustomDictionary" 
<Topic> "standard dictionary","SequenceDefnStdDictionary" 

#other index terms (that use placeholders for now) 
<Index> "Apple menu" 

<Header> "How do I" 
#index entry 

<Topic> "placeholder for topic?","SequenceGeneric" 
<Index> "clipboard" #index entry 

<Header> "How do I" 
<Topic> "placeholder for topic?"," SequenceGeneric" · 

<Index> "closing" #index entry 
<Header> "How do I" 

<Topic> "close a document?","SequenceGeneric" 
<Index> "copying" 

<Header> "How do I" 
#index entry 

<Topic> "placeholder for topic?","SequenceGeneric" 
<Index> "deleting" #index entry 

<Header> "How do I" 
<Topic> "placeholder for topic? 11 ,"SequenceGeneric" 

<Index> "documents" #index entry 
<Header> "How do I" 

<Topic> "save a document?","SequenceGeneric" 
<Topic> "open a document?","SequenceGeneric" 
<Topic> "close a document?","SequenceGeneric" 
<Topic> "print a document?","SequenceGeneric" 

<Index> "fonts" 
<Header> "How do I" 

#index entry 

<Topic> "use bitmapped fonts?", 11 SequenceGeneric" 
<Topic> "placeholder for topic?","SequenceGeneric" 

<Index> "formats" #index entry 
<Header> "How do I" 

<Topic> "placeholder for topic?","SequenceGeneric" 
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<Index> "graphics" #index entry 
<Header> "How do I" 

<Topic> "create bitmapped graphics?","SequenceGeneric" 
<Topic> "placeholder for topic?","SequenceGeneric" 

<Index> "pasting" #index entry 
<Header> "How do I" 

<Topic> "placeholder for topic?","SequenceGeneric" 
<Index> "preferences" #index entry 

<Header> "How do I" 
<Topic> "placeholder for topic?","SequenceGeneric" 

<Index> "printing" #index entry 
<Header> "How do I" 

<Topic> "placeholder for topic?","SequenceGeneric" 
<Topic> "print a document?","SequenceGeneric" 

<Index> "replacing" 
<Header> "How do I" 

#index entry 

<Topic> "placeholder for topic?","SequenceGeneric" 
<Index> "saving" #index entry 

<Header> "How do I" 
<Topic> "save a document?","SequenceGeneric" 

<Index> "searching" #index entry 
<Header> "How do I" 

<Topic> "placeholder for topic?","SequenceGeneric" 
<Index> "selecting" #index entry 

<Header> "How do I" 
<Topic> "placeholder for topic?","SequenceGeneric" 

<Index> "styles" #index entry 
<Header> "How do Iu 

<Topic> "placeholder for topic?","SequenceGeneric" 
<Index> "writing" #index entry 

<Header> "How do In 

<Topic> "placeholder for topic?","SequenceGeneric" 

Note that several invisible index terms are defined in the ''Index Entries.src" 
file. Apple Guide does not display invisible index terms in the Index window. 
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However, Apple Guide includes both visible and invisible index terms when 
it searches the index as a result of the user entering a search phrase in the 
Look For window. 

The Ignore List 

The file "Ignore List.src" specifies the words in SurfWriter Guide's ignore list. 
When first parsing a search phrase entered by the user, Apple Guide removes 
from the phrase any words that appear on the ignore list. For example, if the 
user enters the phrase "how do i use dictionary?" Apple Guide removes 
"how", "do", "I", and "use" from the phrase, resulting in the phrase 
"dictionary". "Dictionary" is an index term and, after checking the exception 
and synonym list, Apple Guide reports a match, as shown in Figure C-8. 

Figure C-8 Matching a search phrase 

1. Click the arrow button to 
begin, then type one or 
more words to look for: 

rn ~~se -~.i~~-~!!:.1 

2. Click Search: 

~fr!( """'s"""'e"""'ar"""'ch~)J 

~mll 
Topics Index 

3. Click a phrase, then click OK: 
v How dol 

add a word to the dictionary? 
look up a word in the dictionary? 
create a custom dictionary? 
add or remove a dictionary? 

v Why can't I 
open the dictionary? 

v Definitions 
custom tictlonary 
standard dictionary 

OK 

Apple Guide automatically removes from the user's search phrase numerals 
and other special characters, such as"$","&","+", "o/o", "?",and "-". For 
example, Apple Guide reduces the phrase "32-bit addressing" to "bit address". 
Listing C-19 shows words on SurfWriter Guide's ignore list. 
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Listing C-19 Ignore words ("Ignore List.src" file) 

<ignore> "how" 
<ignore> "do" 
<ignore> "I" 

<ignore> "my" 
<ignore> "the" 
<ignore> "and" 
<ignore> "or" 
<ignore> "real" 
<ignore> "really" 
<ignore> "a" 
<ignore> "also" 
<ignore> "any" I 
<ignore> "in" 
<ignore> "into" 
<ignore> "on" 
<ignore> "an" 
<ignore> "as" 
<ignore> "by" 
<ignore> "for" 
<ignore> "from" 
<ignore> 11 0f" 
<ignore> 11 if" 
<ignore> "is" 
<ignore> "isn't" 
<ignore> "to" 
<ignore> "it" 
<ignore> "its" 
<ignore> 11 it's" 
<ignore> 11 look 11 

<ignore> uupu 

<ignore> 11 this" 
<ignore> "that" 
<ignore> "why" 

Index and Look For Content C-45 



APPENDIX C 

SurfWriter Guide and Its Source Files 

<ignore> "when" 
<ignore> "these" 
<ignore> "can" 
<ignore> "can't" 
<ignore> "cannot" 
<ignore> "won't" 
<ignore> "create" 
<ignore> "use" 
<ignore> "add" 
<ignore> "remove" 
<ignore> "lookup" 
<ignore> "word" 

The Exception List 
The file "Exception List.src" specifies the words in SurfWriter Guide's 
exception list. Listing C-20 shows the contents of this file. SurfWriter Guide 
places a word on its exception list only if the stemmed form of the word 
matches an existing index term. For example, SurfWriter Guide defines 
"custom" and "customizing" as two separate index terms. To prevent 
Apple Guide from stemming "customizing" to its root form ("custom"), 
"customizing" is included on the exception list. Thus, if the user enters 
"customizing" as a search phrase Apple Guide reports the correct matching 
index term. "Customize" is also placed on the exception list, to prevent 
stemming to "custom". In addition, "customize" is placed on the synonym list, 
associating it with the index term "customizing". 

Listing C-20 Words on the exception list ("Exception List.src" file) ----------------= 

C-46 

#you usually place an index term on the exception list 
# ONLY when the term would otherwise stem to another 
# index term or whose root form has an alternate meaning 
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<exception> .. customize .. 
<exception> .. customizing .. 
<exception> .. preferences .. 

The Synonym List 
The file ~~synonym List.src" specifies the words in SurfWriter Guide's synonym 
list. As you recall, when parsing a phrase, after removing words on the ignore 
list and stemming words except those on the exception list, Apple Guide then 
checks the synonym list. Apple Guide first checks whether the synonym list 
specifies the entire phrase as a synonym. If Apple Guide finds the phrase on 
the synonym list, it replaces the synonym with its associated phrase (usually 
its index term) then checks the index for a term matching this phrase. If it finds 
a matching index term, Apple Guide reports a match. 

For example, if the user enters "How do I create a site dictionary?" Apple 
Guide removes words on the ignore list and sterns words not on the exception 
list. This results in the phrase 11Site dictionary". Apple Guide then checks the 
synonym list and replaces the synonym 11Site dictionary" with its associated 
index term, "dictionary". Apple Guide then searches the index for this phrase 
and finds a matching index term. Also note that one index term can have many 
synonyms; for example, SurfWriter Guide defines "palette" and "tool bar" as 
synonyms for 1/toolbar". 

If Apple Guide does not find the phrase in the synonym list, then for each 
individual word, if the word is a synonym in the synonym list, it replaces the 
synonym with its index term. It then looks in the index for a term matching the 
parsed phrase (this time any words that are synonyms have been replaced by 
their equivalent index terms). If Apple Guide finds a match for the phrase, it 
displays the topics for the index term. If it doesn't find the phrase in the index, 
it looks in the list of index terms for each word. If Apple Guide finds a 
matching index term for more than one word in the phrase, Apple Guide 
intersects the results and displays any topics that are common to both words. 

For example, if the user enters the search phrase "customize dictionaries", 
Apple Guide stems "dictionaries" to II dictionary" (it does not stem 
"customize" because this word is on the exception list). Apple Guide then 
looks in the synonym list for the phrase "customize dictionary". Because 
"customize dictionary" is not on the synonym list, Apple Guide then checks 
the synonym list again, this time for each word in the phrase. ~~customize" 
is on the synonym list, so Apple Guide replaces it with the index term 

Index and Look For Content C-47 

I 
en 
c 

~ 
:!. 

~ 
G) 
c a: 
<1> 
I» 
:::::J 
a. 

6f 
en 
0 c 
a 
<1> 

::n 
m 
f/) 



C-48 

APPENDIX C 

SurfWriter Guide and Its Source Files 

"customizing". "Dictionary" is not on the synonym list so Apple Guide 
leaves "dictionary" as is. Next, Apple Guide looks in the index for the phrase 
"customizing dictionary". Because this phrase isn' t in the index, Apple Guide 
then looks in the index for the term "dictionary" and for the term 
"customizing", and finally displays the intersection of this list. Figure C-9 
shows the results of this search. Note that Apple Guide displays only those 
topics that are common to both index terms. 

Figure C-9 Results of an intersection between two index terms 

1. Click the arrow button to 
begin, then type one or 
more words to look for: 

2. Click Search: 
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"" Definitions 
custom dictionary 

OK 

Listing C-21 shows the words on the SurfWriter Guide's synonym list. 

Listing C-21 Words on the synonym list ("Synonym List.src" file) 

#specify the index term, then specify the synonym 

<syn> "clipboard", "clip" 

<syn> "clipboard", "show clipboard" 

<syn> "clipboard", "hide clipboard" 

<syn> "clipboard", "scrap" 
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<syn> 
<syn> 
<syn> 
<syn> 
<syn> 
<syn> 
<syn> 
<syn> 

"closing", 
"closing", 
"closing", 
"closing", 
"copying", 
"copying", 
"copying", 
"copying", 

"close" 
"closebox" 
"close bOX 11 

"close window" 
"clone" 
"copy" 
"copy command" 
"duplic" 

<syn> "customizing", "customize" 
<syn> "definitions", "definit" 
<syn> "deleting", "clear" 
<syn> "deleting", "clear command" 
<syn> "deleting", "cut" 
<syn> "deleting", "cut command" 
<syn> "deleting", "delet" 
<syn> "deleting", "delete" 
<syn> "dictionary", "site dictionary" 
<syn> "documents", "docum" 
<syn> "documents", "file" 
<syn> "fonts", "font" 
<syn> "fonts", "bitmap font" 
<syn> "fonts", "outline font" 
<syn> "formats", "format" 
<syn> "graphics", "graphic" 
<syn> "graphics", "bitmap graphic" 
<syn> "hammer", "hammer icon" 
<syn> "opening", "open" 
<syn> "opening", "open command" 
<syn> "opening", "double click" 
<syn> "pasting", "past" 
<syn> "pasting", "paste" 
<syn> "pencil", "pencil icon" 
<syn> "printing", "print" 
<syn> "printing", "print command" 
<syn> "printing", "printer" 
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<syn> "printing", 11 LaserWrit 11 

<syn> "printing", 11 ImageWrit" 
<syn> "printing", "spool" 
<syn> .. replacing", "replac" 
<syn> "replacing", "replace .. 
<syn> "saving", .. save" 

<syn> "saving", "save command" 
<syn> "saving", "save work" 
<syn> .. saving", "store .. 
<syn> "searching", "searche 11 

<syn> 11 Searching .. , 11 Search" 
<syn> "selecting", "select" 
<syn> 11 Styles", "style" 
<syn> .. styles", "bold" 
<syn> "styles .. , "ital" 
<syn> "styles", "underline" 
<syn> "styles", "shadow" 
<syn> "tools", "tool" 
<syn> "toolbar", "palette .. 
<syn> "toolbar", "tool bar" 
<syn> "utilities menu", "util" 
<syn> "utilities menu", 11 Util menu" 
<syn> "writing", "write" 
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This appendix is a checklist you can use to design, script, build, and test guide 
files; modify and localize them; and integrate them into your application. It 
consists of a series of actions for accomplishing the given tasks and includes 
page numbers referring you to information within the book. The first four 
sections show how to perform the tasks required to create a guide file­
designing, scripting, building, and testing-as shown in Figure 0-1. 

Figure D-1 Tasks required to create a guide file 
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The last section shows three tasks you can perform on your guide files after 
you complete them. These are 

• localizing your guide file 

• modifying your guide file using a mixin 

• integrating your guide file into your application 

Designing Your Guide File Content 

D-2 

You should perform these tasks before you begin scripting your guide file: 

• Determine which information is appropriate for your guide files (see 
page 3-4) 

• Decide which types of guide files you want to create (see page 2-5) 

• Find out how the following items should look: 

- access windows (see page 2-15) 

- topic areas and topics (see page 2-30) 

~ panels (see page 2-35 and page 2-50) 

- sequences (see page 2-66) 

branches (see page 2-67) 

" buttons (see page 2-70) 

c: hot areas (see page 2-77) 

" coachmarks (see page 2-79) 

context checks (see page 2-83) 

• Create your guide file topic areas and topics (see page 3-4) 

• Design your guide file in a hard-copy format (page 3-7) 

:::J Plan panels and sequences (see page 2-35, page 2-50, and page 2-66) 

_j Design navigation bar buttons (see page 2-71) 

' : Design content area buttons (see page 2-72) 

-~ Design prompt sets (see page 2-39) 

c Decide whether to use Oops or Continue panels for context checks (see 
page 2-85) 
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:· Design your context checks and associated panels (see page 2-83) 

• Design your access window features 

·- Design your application logo (see page 2-18) 

o Compose your howdy text, if used (see page 2-28) 

o Create a preliminary guide file index for the Index and Look For features 
in the Full Access window (see page 3-19) 

:1 Create preliminary ignore, exception, and synonym lists for the Look For 
feature in the Full Access window (see page 3-23 and page 3-24)) 

• Design your panel features 

tJ Plan the panel layout and format (see page 2-43 and page 2-45) 

L Compose your help instructions (see page 2-38) 

u Prepare your graphics (see page 2-46) 

u Determine all navigation and content buttons (see page 2-71 and 
page 2-72) 

:::1 Assign the appropriate prompt (see page 2-39) 

- Plan for localization (see page 2-91) 

Scripting Your Source Files 

After designing your guide file, script your source files as follows: 

• Set up the organization of your source files 

c1 Split your content into multiple source files (see page 5-3) 

11 Include the Standard Setup file (see page 5-4) 

c: Import resources from the Standard Resources file (see page 5-4) 

1 · Create your build file (see page 5-5) 

• Customize the information in the Standard Setup file 

Define your prompt sets (see page 10-35 and page 10-37) 

_1 Define your formats (see page 10-30 and page 10-85) 

·~ Define your navigation button sets (see page 10-32, page 10-71, and 
page 10-80) 
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• Provide basic information about your guide file 

::J Import your application logo (see page 10-25) 

::J Specify howdy text, if any (see page 10-24) 

o Specify the type of access window (see page 10-21) 

o Specify the menu item text that should appear in the Help menu when 
your guide is available (see page 10-14) 

o Specify help balloon text for your guide's item in the Help menu (see 
page 10-16) 

o Specify the application associated with your guide file (see page 10-8) 

o Specify WorldScript information (see page 10-13) 

o Specify version information for your guide file (see page 10-11) 

o Specify whether your guide is a mixin (see page 10-19) 

o Specify whether other guides can mix into your guide file or whether it 
can be mixed in with other guides (see page 10-20) 

• Specify your topic areas and topics (see page 10-125, page 10-135, and 
page 10-137) 

• For mixins, add or modify topic areas, index terms, and topics (see 
page 10-190) 

• Define your sequences (see page 10-39) 

c Specify the sequence prompt set (see page 10-42) 

L., Specify the sequence navigation button set (see page 10-43) 

L: Specify panels and conditional display of panels (see page 10-45, 
page 10-52, and page 10-152) 

o Provide condition functions for context checks (see page 10-172) 

• Provide the content of your panels 

::J Text (see page 10-52 and page 10-85) 

:::J Graphics (see page 10-95) 

n Movies (see page 10-98) 

o Standard buttons (see page 10-57) 

c::: Three-dimensional buttons (see page 10-60) 

o Radio buttons (see page 10-64) 

o Checkboxes (see page 10-69) 

ll Hot text (see page 10-122) 
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o Event functions (page 10-178) 

o Coachmarks (see page 10-118) 

o Prompts (see page 10-55) 

• Define your index tenns 

o Index terms (see page 10-128) 

o Associated help topics (see page 10-135) 

o Topics associated with headings (see page 10-137) 

• Define your Look For content 

n Ignore list (see page 10-145) 

c Exception list (see page 10-147) 

c Synonym list (see page 10-149) 

Building Your Guide File 

Compile your source files into a guide file by performing these tasks: 

• Open Guide Maker (see page 4-5) 

• Compile your source files (see page 5-6) 

• Save your guide file (see page 5-8) 

Testing Your Guide File 

Mter building your guide file, test it as follows: 

• Test your Look For content (see page 6-8) 

• Test your guide file's interface (see page 6-3) 

• Verify coachmarks, context checks, and event functions (see page 6-18) 

• Do user testing (see page 6-20) 

Building Your Guide File 

• 
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Additional Guide File Tasks 

D-6 

After you complete your guide file, at some point you will want to modify its 
contents; you do this using a mixin. Apple recommends that you also localize 
your guide file for other regions. In addition to making your guide file 
available from your application's Help menu, you can integrate help into 
your application. These three guide file tasks are listed next. 

• Localize your guide file 

[' Extract language-specific text strings from your source files using 
Guide Maker's Localize utility (see page 7-3) 

L Translate the text strings using various tools (see page 7-6) 

~ Merge the translated text strings back into your source files using 
Guide Maker's Localize utility (see page 7-6) 

.=J Localize any other elements of your guide file, such as pictures, as 
necessary (see page 7-6) 

c:::; Compile your translated source files into a new guide file (see page 5-6) 

• Modify a guide file by creating a mixin source file (see page 2-14) 

:::J Specify that the guide file is a mixin (see page 10-19) 

Indicate whether it can be mixed in with any guide or only a specific 
guide (see page 10-20) 

i~ Specify additions and modifications to the main guide file's content (see 
page 10-190) 

., Compile your mixin source files into a Mixin guide file (see page 5-6) 

Save your Mixin guide file (see page 5-8) 

• Integrate your guide file with your application 

Refer to Chapter 9 for a description of the complete set of functions that 
allow you to provide the user with context-sensitive help from within your 
application. 

Additional Guide File Tasks 



Glossary 

About Apple Guide A guide file 
included with system software that 
describes the help system· provided with 
the Macintosh computer. 

About guide file A type of guide file that 
describes the available help systems in an 
application. See also guide file, guide file 
types, and Macintosh Guide. 

access window The window-Full, 
Single List, or Simple-that appears 
whenever the user selects a guide file from 
the Help Menu and from where the user 
selects to view (or goes directly to view) 
help topics. See also Full Access window, 
Single List Access window, and Simple 
Access window. 

action panel A panel that presents a 
single step in a procedure (for example, 
to tell the user to open a menu). 

additions See Mixin guide file. 

Apple Guide A system extension 
provided with system software that 
provides an onscreen help system. 

Apple Guide API A set of functions, or 
application programming interface, that lets 
you start up, access, and work with Apple 
Guide from within your application. 

Apple Guide font The attributes, 
10-point Espy Serif Plain black, 
automatically applied by Apple Guide 
to text on the panel content area. 

AppleScript coach A coachmark for an 
object whose location is determined by a 
script. See also coachmark, item coach, 
menu coach, object coach, window coach. 

Balloon Help A System 7 (and higher) 
feature that provides users information 
about such objects on the Macintosh screen 
as icons, windows, and commands. 

Body format A format that provides a 
right column and that is designed for use 
with the Tag format. 

branch A panel sequence within another 
sequence. 

build To compile a help source file using 
Guide Maker. 

build file A file that contains only 
<Include> and <Resource> commands. 

Build utility The Guide Maker utility 
you use to build guide files. See build and 
guide file. 

closure panel At the end of a sequence, 
a panel that summarizes the information 
covered by that sequence. 

coachmark An onscreen graphic that 
circles or points to an item on the screen. 
See also coachmark types. 
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coachmark types The five different kinds 
of coaches-menu, item, object, window, 
and AppleScript-that you can create with 
Apple Guide. See also menu coach, item 
coach, object coach, window coach, and 
AppleScript coach. 

compile See build. 

content area The part of a panel between 
the panel sequence title area and the 
navigation bar that contains help 
instructions, possibly including text, 
control features (such as radio buttons 
and checkboxes), I PICT I graphics, and 
QuickTnne movies. See also sequence 
display title area and navigation bar. 

content area button Control features that 
appear in the content area of a panel and 
that are generally associated with an event 
or navigation route specific to that panel. 
See also content area. 

context checks Functions that verify the 
user's environment so that Apple Guide 
can dynamically skip or show certain 
panels to the user based on their 
appropriateness. 

Continue panel A panel that offers to 
complete for the user a condition that has 
not been met when the user attempts to 
continue to the next panel in the sequence. 
Compare Oops panel. 

Convert utility The Guide Maker utility 
you use to convert a Windows Help file to 
a Guide Script source file. 
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decision panel A panel from which the 
user can select one or more tasks by using 
radio buttons or checkboxes. Each button 
or checkbox has a distinct panel branch 
associated with it. 

default prompt set The prompt set that 
Apple Guide automatically applies to 
panels in a sequence unless you override it. 
See also prompt and prompt set. 

definition panel A panel that defines 
terminology appearing on a panel. 

"Definitions" heading A heading for 
term definitions that relate directly to the 
selected topic area. See also "How do I" 
heading and "Why can't I" heading. 

Diagnose utility The Guide Maker 
utility you use to step through the panels 
of a guide file. 

exception list A list of words that Apple 
Guide does not reduce to a root word if 
entered as a user search phrase with Look 
For features selected in the Full Access 
window. See also ignore list, synonym list, 
and Look For buttons. 

first-level panels In a sequence, the 
panels that lead the user directly through 
the task or concept of the associated topic. 
See also second-level panels. 
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first previous panel In a sequence, the 
panel that Apple Guide displays when the 
user clicks the OK button on an Oops panel 
without making the condition true. This 
panel is the first panel that Apple Guide 
finds, searching backward through the 
sequence, that meets one of two criteria: it 
does not have a <Make Sure> command 
specified for it, or it has a <Make Sure> 
command whose condition evaluates to 
true. See also Oops panel. 

Full Access window A window that 
includes three built-in buttons-Topics, 
Index, and Look For-from which the user 
makes selections or enters a search phrase. 
See also Simple Access window and Single 
List Access window. 

Full format A one-column format that 
Apple Guide applies by default to all 
panels. See also Tag and Body format. 

GoStart button A lightbulb-shaped 
button that appears in the navigation bar of 
a panel and that takes the user back to the 
access screen. See also navigation button. 

guide file A single file containing help 
content that conforms to one of five guide 
file types supported by Apple Guide. See 
also guide file types. 

guide file index A list of terms that point 
to the topics appearing in the right column 
of the Full Access window. Apple Guide 
uses the index to retrieve topics for the user 
when Look For or Index features are 
selected on the Full Access screen. See also 
Index button and Look For button. 

guide file types Five guide files specified 
by the Apple Guide Human Interface 
Guidelines-About, Tutorial, Help, 
Shortcuts, and Other-that each have 
a particular focus, content, naming 
convention, and Help menu location. See 
also About guide file, Help guide file, 
Shortcuts guide file, Tutorial guide file, 
and Other guide file. 

Guide Maker A tool for building and 
testing guide files. 

Guide Script An authoring language for 
developing guide files. 

Guide Script source files See help source 
files. 

Help guide file A type of guide file that 
provides the main information in a help 
system through a wide range of 
task-oriented information about an 
application. See also guide file, guide file 
types, and Macintosh Guide. 

help source files Files containing Guide 
Script commands that define the look, 
content, and navigation path of all panels 
in a guide file. See also Guide Script. 

hot area On a panel, the area containing 
a rectangle, object, or text that the user can 
click to view another panel containing 
related information. 

hot object On a panel, a hot area 
specified by the rectangle of the next object 
(either text or a graphic) in the panel 
definition. 

hot rectangle On a panel, a hot area that 
is a specific rectangle. 
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hot text On a panel, a hot area that 
consists of designated text. See also hot 
area, hot object, and hot rectangle. 
11How do I" heading In the Full Access 
window, a heading for topics that show the 
user how to accomplish a task. See also 
11De.finitions" heading and 11Why can't I" 
heading. 

howdy text Text that describes a guide 
file and that appears in the access window's 
instructions. 

Huh? button A button that appears in the 
navigation bar of a panel and that, when 
active, the user can click to view an 
associated panel with crucial information. 

ignore list A list of words you tell Apple 
Guide to remove from a user search phrase 
entered with Look For features selected in 
the Full Access window. See also Look For 
button, exception list, and synonym list. 

Index button On the Full Access screen, 
a built-in button that the user can click to 
display a list of index terms for the guide 
file contents. This list appears in the left 
column of the window. 

information panel A panel that provides 
brief conceptual explanations. 

introductory panel A panel that begins a 
panel sequence or branch and that describes 
its contents. 

invisible index term A term that does 
not correspond to a visible term in the Look 
For index but that Apple Guide uses to 
match a search phrase with guide file 
topics. See also visible index term. 
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item coach A coachmark for an item in 
a dialog box or other interface element 
in a window (or dialog box). See also 
coachmark, menu coach, object coach, 
window coach, and AppleScript coach. 

Localize utility The Guide Maker utility 
you use to localize all elements of your 
guide files that are language-specific, such 
as text strings and pictures. 

Look For button In the Full Access 
window, a built-in button that the user can 
click to access information in the guide file 
using a search phrase. 

Macintosh Guide A guide file included 
with system software that provides its main 
help through step-by-step instructions for a 
variety of tasks. 

Macintosh Guide additions Four guide 
files-PowerBook Guide, Speech Guide, 
Video Guide, Video Player-that add 
content to Macintosh Guide about a specific 
piece of hardware attached to the 
Macintosh computer or about certain 
system software features. 

main guide file A guide file containing 
help instructions that can be modified using 
a Mixin guide file. See also Mixin guide file. 

menu coach A coachmark for a specific 
menu or menu item. See also AppleScript 
coach, coachmark, item coach, object 
coach, and window coach. 

Mixin guide file A file you use to add to 
or modify the contents of a main guide file. 
See also main guide file. 
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navigation bar On the lower portion of 
a panel, the bar that displays the left and 
right navigation arrows that the user clicks 
to move between panels. This bar may 
contain additional navigation buttons (such 
as GoStart and Huh?). See also content area 
and sequence display title area. 

navigation button A button that always 
appears in the navigation bar of a panel that 
takes the user to different parts of the guide 
file. See also GoStart button and Huh? 
button. 

object coach A coachmark for an object 
based on a rectangle that an application 
returns for the named object. See also 
coachmark, menu coach, item coach, 
window coach, and AppleScript coach. 

Oops panel A panel that tells the user 
a condition specified on a previous panel 
was not met. The user needs to make the 
condition true to continue to the next panel. 
Compare Continue panel 

Other guide file A guide file that does 
not conform to the content guidelines for 
the four other Apple Guide guide files 
(About, Tutorial, Help, and Shortcuts) or 
that is a particularly advanced or 
specialized version of these other types. See 
also guide file types. 

panel An Apple Guide help window that 
describes a concept or step. 

panel associated with a Huh? button A 
panel that appears when the user clicks a 
Huh? button on a panel. This associated 
panel provides information crucial to 
understanding the original panel. 

panel branch See branch. 

panel height On a panel, the distance 
between the title area and the navigation 
bar. 

panel number The number appearing 
on a panel between the left and right 
navigation arrows. Guide Maker 
automatically assigns this number in a 
dynamic sequence. 

panel sequence See sequence. 

panel width The area across the panel, 
which is a fixed measurement of 344 pixels. 

presentation panel See panel. 

prompt The panel text that tells the user 
what to do and where to go (for example, 
click the right arrow to continue). 

prompt set A collection of four prompts 
that Apple Guide chooses to display based 
on what a panel's position in the sequence 
is (first, middle, or last) or whether it 
contains controls (radio buttons, 
checkboxes, or standard buttons). See also 
default prompt set and prompt. 

random access A method of access in 
which the user can select help topics in any 
order. 

related topics panel A panel that 
describes topics in a guide file pertaining to 
either a specific panel or sequence. 

ResetPen Format A format that resets the 
current format to the default format. 

second-level panels The panels that 
provide supplemental help, and Oops and 
Continue panels. See also first-level panels. 
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sequence A set of related panels that the 
user can access linearly using left and right 
navigation arrows. 

sequence display title area In the upper 
portion of a panel, the bar that contains the 
panel title. See also content area and 
navigation bar. 

sequential access A method of access in 
which the user can select help topics in a 
structured order. 

Shortcuts A guide file included with 
system software that provides Macintosh 
keyboard commands and tips. 

Shortcuts guide file A guide file that 
provides condensed reference material 
similar to that found on a quick reference 
card. See also guide file types and guide 
file. · 

Simple Access window A window that 
takes the user directly to the help 
information unless you provide your own 
access method. See also Full Access 
window and Single List Access window. 

Single List Access window A window 
that provides a single scrollable list of topics 
for the user to choose from. See also Full 
Access window and Simple Access 
window. 

standard button A two-dimensional 
button, drawn by the Macintosh toolbox, 
that has an event associated with it. See also 
content area button. 

standard panel types A set of panel 
designs that apply to and should be used 
for specific categories of help information. 
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stemming The process by which Apple 
Guide reduces common word variations to 
root words in search phrases entered by the 
user. 

synonym list A list containing words that 
have identical meaning to index terms but 
that do not appear in the index. See also 
exception list, ignore list, and Look For 
button. 

Tag In the left coluinn of a panel, a bold 
phrase that describes the Body text that 
appears in the right column of the panel. 
See also Tag and Body format. 

Tag and Body format A two-column 
format for panels created by two Guide 
Script commands. See also Full format, 
Tag, Tag format, and Body format. 

Tag format A format that provides a left 
column that you can use to format tags and 
that is designed for use with the Body 
format. 

three-dimensional button A button 
whose appearance is determined by a 
graphic that you place in it. See also content 
area button, navigation button, and 
standard button. 

tip panel A panel that gives a hint about 
how to perform an action or use an 
application feature. 

topic A category of help information in 
a guide file that the user views from an 
access window. 

topic area A broad category of help that 
breaks into one or more topics. It appears in 
the left column of the Full Access window 
when the user selects the Topics button. 
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Topics button A built-in button on the 
Full Access window that the user clicks to 
display topic areas in the left column of the 
window. 

transition panel A panel that connects 
parts of multipart panel sequences. 

Tutorial A guide file included with 
system software that provides training 
in Macintosh skills. 

Tutorial guide file A type of guide file 
that leads users through the basic features 
of an application. See also guide file types 
and guide files. 

visible index term A term that appears 
in the left column of the Full Access 
window with Index features selected. See 
also invisible index terms. 

"Why can't I" heading In the Full Access 
window, a heading for topics that explain 
why a certain action cannot be performed. 
See also "Definitions" heading and "How 
do I" heading. 

window coach A coachmark for a specific 
area of a window. See also coachmark, 
menu coach, item coach, object coach, and 
AppleScript coach. 
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Symbols 

#command 10-17 

Numerals 

<30 Button> command 10-60 to 10-64 

A 

About Apple Guide 1-5 
About guide files 2-7,2-9 to 2-10 
access windows 2-15 to 2-30 

features of 1-9 to 1-13 
Full 2-16 to 2-24 

creating Look For features for 3-12 to 3-26 
defined 2-15 
features of 2-16 to 2-19 
headings for 2-33 to 2-35 
for Help guide files 2-11 
howdy text on 2-28 to 2-30 
designing Index features for 2-20 to 2-21 
designing Look For features for 2-21 to 2-24 
topic areas for 2-31 to 2-32 
designing Topics features for 2-19 to 2-20 
topics for 2-31 to 2-32 

Simple 
buttons in 2-26 
defined 2-15 
features of 2-26 to 2-28 
howdy text on 2-28 to 2-30 
for Shortcuts guide files 2-14 
topics for 2-33 

Single List 
defined 2-15 

features of 2-25 to 2-26 
howdy text on 2-28 to 2-30 
topics for 2-32 to 2-33 

action panels 2-53 to 2-54 
additions. See Mixin guide files 
AGClose function 9-17 to 9-18 
AGFileGetDBCount function 9-9 
AGFileGetDBCountry function 9-28 to 9-29 
AGFileGetDBMenuName function 9-23 to 9-24 
AGFileGetDBType function 9-26 to 9-27 
AGFileGetDBVersion function 9-29 to 9-30 
AGFileGetHelpBalloonText function 9-24 

to 9-25 
AGFileGetHelpMenuAppCreator 

function 9-25 to 9-26 
AGFileGetindDB function 9-10 to 9-11 
AGFileGetMixinMatchSelector 

function 9-32 to 9-33 
AGFileGetSelectorCount function 9-30 
AGFileGetSelector function 9-31 
AGFileisMixin function 9-28 to 9-32 
AGFile library 9-3 
AGGeneral function 9-20 to 9-21 
AGGetAvailableDBTypes function 9-7 to 9-8 
AGGetFrontWindowKind function 9-19 to 9-20 
AGGetFSSpec function 9-22 
AGGetStatus function 9-6 to 9-7 
AGinstallCoachHandler function 9-34 to 

9-35 
AGinstallContextHandler function 9-36 to 

9-37 
AGisDatabaseOpen function 9-17 to 9-19 
AGOpen function 9-12 to 9-13 
AGOpenWithSearch function 9-14 to 9-15 
AGOpenWithSequence function 9-16 to 9-17 
AGOpenWithView function 9-13 to 9-14 
AGQui t function 9-6 
AGRemoveCoachHandler function 9-35 
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AGRemoveContextHandler function 9-37 to 
9-38 

AGStart function 9-5 
<Allow Prompts> command 10-34 to 10-35 
<App Creator> command 10-8 to 10-9 
Apple Guide 

compared with Balloon Help 1-5 
components of 1-4 to 1-5 
features of 1-3 to 1-8 
typical help session with 1-9 to 1-13 
uses of 1-8 

Apple Guide API 
functions in 9-5 to 9-38 

Apple Guide Debug extension 6-6, 9-4 
Apple Guide extension 9-4 

determining if installed 9-4 
Apple Guide font 2-48 
Apple Guide icon 2-19 
AppleScript 

and coachmarks 2-80 
determining location of coachmarks 

with 10-116 to 10-117 
localizing 2-95 
running a compiled script 10-189 

application creator 10-8 to 10-9 
application logo 2-18 to 2-19, 2-25, 10-25 to 10-26 
application programming interface for Apple 

Guide. See Apple Guide API 
application signature 10-8 to 10-9 
<App Logo> command 10-25 to 10-26 
<App Text> command 10-27 
authoring tips 2-5 to 2-95 
autosaving guide files, compile option 5-9 

8 

Balloon Help 1-5 
BallooniD function 10-110, 10-111 
<Balloon Menu Text> command 10-16 
Body format 2-44 
branches 2-67 to 2-69 
build files 

IN-2 

compiling 5-6 
creating 5-3 to 5-4 
and the <Include> command 10-18 

building 
source files into a guide file 5-6 to 5-8 

Build menu 4-7 
<Build Sequence> command 10-50 to 10-51 
Build utility 5-6 
Build window 5-6 
built-in event functions 10-188 to 10-190 
buttons 

c 

content area 2-55, 2-70, 2-72 
creating 10-57 to 10-82 
dimmable 2-72, 10-78 to 10-79 
formatting 2-72 to 2-74 
GoStart 2-71 
Huh? 2-71 
Index 2-17, 2-20 
localizing 2-94 
Look For 2-17,2-21 
navigation 2-70, 2-71 to 2-72, 10-71 to 10-82 
radio 2-76 to 2-77, 10-64 to 10-68 

on decision panels 2-52 
on related topics panels 2-58 
titles for 2-76 

standard 2-70, 2-74, 10-57 to 10-60 
three-dimensional 2-70, 2-74 to 2-76, 10-60 to 

10-64 
Topics 2-17,2-19 
in Tutorial guide file 2-13 
types of 2-70 

<Checkbox> command 10-69 to 10-71 
checkboxes 

on decision panels 2-52 
titles for 2-76 

checkBoxState context check 10-175 to 10-176 
closure panels 2-60 
<Coach Mark> command 10-118 to 10-119 
coachmarks 
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AppleScript 10-116 to 10-117 
associating with a panel 10-118 to 10-119 
item 10-108 to 10-111 
localizing 2-95 
menu 10-105 to 10-108 
object 10-111 to 10-113 
styles of 2-80 to 2-83 
testing 6-19 
types of 2-80 
window 10-113 to 10-115 

Column function 1Q-7, 1Q-85 
<Comment> command 10-17 
company name in access window 2-18, 2-25 
Compile arrow 5-7 
compile messages in Guide Maker 

errors 5-10 
interpreting 5-10 to 5-11 
warnings 5-11 

compile options 
autosaving guide files 5-9 
creating symbol files 5-9 
setting 5-8 to 5-9 
warning when panels split 5-9 

compiling help source files 5-6 to 5-11,5-14 
compiling help source files. See building help 

source files 
composing help instructions 2-39,2-54 
condition functions 

checkBoxState 10-175 to 10-176 
defining 10-172 to 10-175 
radioButtonState 10-176 to 10-177 

content area buttons 2-70,2-72 
content area of panel 2-39 
context checks 

and Continue panels 2-85, 2-87 
defining 10-172 to 10-175 
determining 2-85 to 2-88 
displaying branches based on 2-69 
evaluation of 2-89 to 2-91 
and first previous panels 2-89 to 2-90 
in flowcharts 3-12 
introduced 1-7 to 1-8 
localizing 2-95 
and Oops panels 2-85, 2-87 to 2-88, 2-91 

testing 6-19 
using 2-83 to 2-91 

Continue panels 2-65 to 2-66 
compared with Oops panels 2-66 
and context checks 2-85, 2-87 

control features. See buttons 
Convert arrow 8-6 
converting with Guide Maker 8-5 to 8-6 
Convert menu 4-7 
Convert utility 8-5 
Convert window 8-5 

D 

decision panels 2-52 to 2-53, 2-69 
<Default Format> command 1Q-30 to 1Q-32 
<Default Nav Button Set> command 10-32 to 

10-34 
default prompt set 2-40 to 2-43 
<Default Prompt Set> command 10-35 to 10-36 
<Define AppleScript Coach> command 10-116 

to 10-117 
<Define Context Check> command 10-172 to 

10-175 
<Define Event> command 10-178 to 10-181 
<Define Event List> command 10-181 to 10-182 
<Define Format> command 10-85 to 10-91 
<Define Item Coach> command 10-108 to 10-111 
<Define Menu Coach> command 10-105 to 

10-108 
<Define Nav Button> command 10-71 to 10-77 
<Define Nav Button Set> command 10-80 to 

10-82 
<Define Object Coach> command 10-111 to 

10-113 
<Define Panel> command 10-52 to 10-54 
<Define Prompt Set> command 10-37 to 10-39 
<Define Sequence> command 10-39 to 10-42 
<Define Text Block> command 10-82 to 1Q-83 
<Define Transparent Format> command 10-91 

to 10-92 
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<Define Window Coach> command 10-113 to 
10-115 

definition panels 2-56 to 2-58 
"Definitions" heading 2-57 
<Delete Index> command 10-201 to 10-202 
<Delete Index Header> command 10-202 to 

10-203 
<Delete Index Topic> command 10-203 to 10-204 
<Delete Topic Area> command 10-198 
<Delete Topic Area Header> command 10-199 to 

10-200 
<Delete Topic Area Topic> command 10-200 to 

10-201 
Diagnose menu 4-7 
Diagnose utility 6-3 to 6-7 
dialog boxes 

coaching items in 10-108 to 10-115 
DialogiD function 10-110, 10-111 
<Dimmable Button Data> command 10-78 to 

10-79 
DoAppleScript event function 10-189 
DoScript event function 10-189 

E 

<Else> command 10-156 to 10-158 
<End If> command 10-158 to 10-160 
<End Making Sure> command 10-171 to 10-172 
<End Panel> command 10-56 to 10-57 
<End Sequence> command 10-51 to 10-52 
<End Text Block> command 10-83 to 10-84 
Espy font 2-47 
event functions 

built-in 10-188 to 10-190 
defining 10-178 to 10-181 
testing 6-19 

event lists 
defining 10-181 to 10-182 

<Exception> command 10-147 to 10-148 
exception lists 3-13 
Export Guide File command 5-12 
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F 

Finder, and system help 1-5 
first-level panels 2-66 to 2-67 
first previous panel 2-89 to 2-90 
flowcharts, designing help content with 3-7 to 

3-12 
fonts 

Espy 2-47 
recommended 2-47 

footnotes in Wmdows Help files 8-4 
<Format> command 10-93 to 10-94 
formats 

Body 2-44 
creating 10-85 to 10-91 
default 10-30 to 10-32 
designing 2-45 to 2-46 
Full 2-43 to 2-45, 2-50 
localizing 2-93 
recommended 2-43 to 2-45 
specifying 10-93 to 10-94 
Tag 2-44 
Tag and Body 2-43 to 2-45 
transparent 10-91 to 10-92 

formatting 
buttons 2-72 to 2-74 
graphics 2-46 to 2-47 
panel text 2-47 to 2-48 

Full Access windows 
creating Look For features for 3-12 to 3-26 
defined 2-15 
features of 2-16 to 2-19 
headings for 2-33 to 2-35 
for Help guide files 2-11 
howdy text on 2-28 to 2-30 
designing Index features for 2-20 to 2-21 
designing Look For features for 2-21 to 2-24 
topic areas for 2-31 to 2-32 
designing Topics features for 2-19 to 2-20 
topics for 2-31 to 2-32 

Full format 2-43 to 2-45, 2-50 
for introductory panels 2-51 



INDEX 

G 

<Gestalt> command 10-10 to 10-11 
GoBack event function 10-163 to 10-167 
GoPanel event function 10-189 
GoStart button 

and the <Define Nav Button> command 10-71 
to 10-77 

using 2-71 
graphics in panels 

formatting 2-46 to 2-47 
green "X" character coachmarks 2-80 to 2-82 
guide file additions. See Mixin guide files 
guide file index 3-19 to 3-22 
Guide File Info report 6-16 to 6-18 
guide files 

About 2-7, 2-9 to 2-10 
compiling 5-6 to 5-11 
designing 2-5 to 2-6 
designing with flowcharts 3-7 to 3-12 
developing content for 3-3 to 3-26 
Help 2-7 
in Help menu 2-7 to 2-8 
inappropriate material for 3-4 
indexes. See indexes 
invoking 

from Help menu 1-10 to 1-11 
with Command key shortcuts 2-8 

localizing 7-3 to 7-14 
main 2-14 
Mixin 2-5,2-14 to 2-15 
navigating through 2-48 to 2-49 
Other 2-7,2-14 
Shortcuts 2-7,2-13 to 2-14 
system software 1-4 
testing 6-3 to 6-20 
Tutorial 2-7,2-11 to 2-13 
types of 2-6 to 2-7 
uses of 1-8 

Guide Maker 
Build utility 5-6 to 5-8 
Convert utility 8-3 to 8-10 
Diagnose utility 6-3 to 6-7 
introduction to 4-3 to 4-7 

Localize utility 7-3 to 7-14 
menus 4-6 to 4-7 
Reports feature 6-13 to 6-17 
Test Look For utility 6-8 to 6-12 

Guide Script 1-5 
Guide Script commands 

abbreviations A-1 to A-5 
descriptions 10-5 to 10-204 
quick reference to B-1 to B-6 

Guide Script source files. See help source files 

H 

<Header> command 10-135 to 10-137 
headings 2-33 to 2-35 
height 

of navigation buttons 10-74 
of panels 

default maximum 10-28 
default minimum 10-29 

of standard buttons 10-58 
help content 

deriving from reference documentation 3-4 to 
3-6 

designing with flowcharts 3-7 to 3-12 
inappropriate material for 3-4 

Help guide files 2-7 
Help menu 2-7 to 2-8 
<Help Menu> command 10-14 to 10-16 
help source files 2-6 
hot areas 2-77 
<Hot Object> command 10-119 to 10-120 
hot objects 2-77 to 2-78 
<Hot Rectangle> command 10-120 to 10-122 
hot rectangles 2-77 to 2-78 
hot text 2-77 to 2-79 

compared with panels associated with Huh? 
buttons 2-78 

on related topics panels 2-58 
<Hot Text> command 10-122 to 10-123 
"How do I" heading 2-33 
<Howdy> command 10-24 to 10-25 
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howdy text 2-16, 2-28 to 2-30 
Huh? button 

and the <Define Nav Button> command 10-71 
to 10-77 

and the <Dimmable Button Data> 
command 10-78 to 10-79 

panels associated with 2-61 to 2-63 
using a 2-71 

<If> command 10-153 to 10-156 
<Ignore> command 10-145 to 10-147 
ignore lists 3-12,3-23 to 3-24 
Import Resources command 5-12 
<Include> command 10-18 to 10-19 
Index button 2-17, 2-20 
<Index> command 10-128 to 10-130 
indexes 

designing 3-20 to 3-22 
terms in 

invisible 3-22 
visible 3-20 to 3-22 

testing 6-8 to 6-12 
<Index Instruction> command 10-127 to 10-128 
Index instructions 2-17 
<Index Sorting> command 10-132 to 10-133 
Index Sort Strings report 6-15 to 6-16 
index terms 

commands for 10-128 to 10-130, 10-130 to 
10-133 

invisible 3-22 
visible 3-20 to 3-22 

information panels 2-54 to 2-55 
<Insert Index Header> command 10-195 to 

10-196 
<Insert Index Topic> command 10-196 to 10-197 
<Insert Sequence> command 10-46 to 10-47 
<Insert Topic Area Header> command 10-192 to 

10-193 
<Insert Topic Area Topic> command 10-193 to 

10-194 

IN-6 

introducing users to help system 2-16, 2-28 to 
2-30 

introductory panels 2-51 
invisible index terms 3-22 
item coachmarks 10-108 to 10-111 

J, K 

<Jump Sequence> command 10-47 to 10-49 

L 

<Launch New Sequence> command 10-49 to 
10-50 

LaunchNewSequence event function 10-189 
LaunchNewsequenceNewWindowevent 

function 10-189 
Localize menu 4-7 
localizing 

AppleScript 2-95 
buttons 2-94 
coachmarks 2-95 
context checks 2-95 
formats 2-93 
panel text 2-92 to 2-93 
sequence display area 2-94 
source files 7-3 to 7-14 
and stemming 3-14 

Look For button 2-17, 2-21 
Look For features 

designing 2-21 to 2-24,3-12 to 3-26 
exception lists 3-13 
ignore lists 3-13, 3-23 to 3-24 
matching search phrases with topics 3-15 to 

3-19 
stemming 3-12 to 3-14 
synonym lists 3-13 
testing 6-8 to 6-12 

<Look For Instruction> command 10-141 to 
10-142 

Look For instructions 2-17 
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<Look For Results Instruction> 
command 10-144 to 10-145 

<Look For Search Btn Instruction> 
command 10-143 to 10-144 

<Look For String> command 10-143 

M 

Macintosh Guide 1-5 
Macintosh Guide additions 1-4 to 1-5 
Macintosh Operating System, and system 

help 1-5 
main guide files 2-14 
<Make Sure> command 10-162 to 10-168 
<Max Height> command 10-28 to 10-29 
Menu Appearance command 5-12 to 5-13 
menu coachmarks 2-80,10-105 to 10-108 
<Min Height> command 10-29 to 10-30 
<Mixin> command 10-19 to 10-20 
Mixin guide files 

additional commands for 10-19 to 10-20, 
10-190 to 10-204 

and topic areas and topics 2-31 
creating 5-13 to 5-14 
designing 2-14 to 2-15 
introduced 2-5 

<Mixin Match> command 10-20 to 10-21 
movies 

specifying 10-98 to 10-100 

N 

Names to IDs report 6-14 to 6-15 
navigation arrows 2-39 
navigation bar 2-39 
navigation buttons 2-70, 2-71 to 2-72 
navigation button set 

specifying 10-32 to 10-34, 10-43 to 10-44, 10-80 
to 10-82 

navigation methods 2-48 to 2-49 

0 

object coachmarks 2-80, 10-111 to 10-113 
<On Panel Create> command 10-183 to 10-184 
<On Panel Destroy> command 10-184 to 10-185 
<On Panel Hide> command 10-187 to 10-188 
<On Panel Show> command 10-185 to 10-187 
Oops panels 2-63 to 2-65 

compared with Continue panels 2-65 
and context checks 2-85, 2-87 to 2-88, 2-91 

Other guide files 2-7, 2-14 

p 

panel branches. See branches 
<Panel> command 10-45 to 10-46 
panel number 2-39 
<Panel Prompt> command 10-55 to 10-56 
panels 2-39 to 2-66 

buttons in 2-70 to 2-77 
characteristics of 2-35 to 2-39 
commands for creating 10-52 to 10-57 
content area of 2-39 
default features of 2-37 to 2-39 
features of 1-5 to 1-6 
first level 2-67 
first-level 2-66 to 2-67 
first previous 2-89 to 2-90 
formatting 2-43 to 2-48 
formatting text in 2-47 to 2-48 
graphics in 

formatting 2-46 to 2-47 
localizing 2-94 

height of 2-36 
navigating through 2-48 to 2-49 
navigation bar on 2-39 
numbering of 2-39 
prompts for 2-39 to 2-43 
second level 2-67 
second-level 2-67. See also standard panel 

types 
sequence display title area 2-38 

IN-7 
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panels (continued) 
width of 2-36 

panels associated with Huh? buttons 2-61 to 2-63 
compared with hot text 2-78 

panel sequences. See sequences 
<PICT> command 10-95 to 10-98 
I PICT I graphics 2-45 
pictures 

application logo 10-25 to 10-26 
specifying 10-95 to 10-98 

PlaySound event function 10-189 
Point function 10-7, 10-58, 10-59 
Power Book Guide 1-5 
presentation panels. See panels 
presenting help instructions. See panels 
presenting topics to users. See access windows 
prompts 

default 2-40 to 2-43 
defining 10-34 to 10-39, 10-55 to 10-56 
designing 2-39 to 2-43 
formatting 2-40 
overriding 2-42 to 2-43 
sets of 2-40 to 2-42 

Q 

<QuickTime> command 10-98 to 10-100 
QuickTime movies 2-45 

R 

<Radio Button> command 10-64 to 10-66 
<Radio Button Launch New Seq> 

command 10-66 to 10-68 
radio buttons 2-76 to 2-77 

in Simple Access windows 2-26 
on decision panels 2-52 
on related topics panels 2-58 
title for 2-76 

radioButtonState context check 10-176 to 
10-177 

IN-8 

random access 2-16 
RECT function 10-7 
red arrow coachmarks 2-80 to 2-81 
RedArrow function 10-109 
red circle coachmarks 2-80 to 2-81 
red underline coachmarks 2-80 to 2-82 
reference documentation, deriving help content 

from 3-4 to 3-6 
related topics panels 2-58 to 2-59 
<Replace Sequence> command 10-190 to 10-191 
reports 

generating from Guide Maker 6-13 to 6-17 
Reports menu 4-7 
<Resource> command 10-101 to 10-103 
resources 

importing 10-100 to 10-105 
movie 10-98 to 10-100 
picture 10-95 to 10-98 
script 10-189 
sound 10-189 
version 10-11 to 10-12 

resource types 
I PICT I 10-95 to 10-98 
I sept I 10-189 
I snd I 10-189 

RGBColor function 10-7, 10-86 

s 
saving guide files 5-8 
Scopes and Keys report 6-13 to 6-14 
second-level panels 2-67 
<Seq Nav Button Set> command 10-43 to 10-44 
sequence display title area 2-38 
<Sequence Prompt Set> command 10-42 to 10-43 
sequences 

commands for creating 10-39 to 10-52 
designing 2-66 to 2-69 
within other sequences 2-67 to 2-69 

sequential access 2-16 
Set Compile Options command 5-8 
Shortcuts 1-5 
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Shortcuts guide files 2-7,2-13 to 2-14 
Simple Access windows 

buttons in 2-26 
defined 2-15 
features of 2-26 to 2-28 
howdy text on 2-28 to 2-30 
for Shortcuts guide files 2-14 
topics for 2-33 

Single List Access windows 
defined 2-15 
features of 2-25 to 2-26 
howdy text on 2-28 to 2-30 
topics for 2-32 to 2-33 

<Skip If> command 10-160 to 10-162 
<Sorting> command 10-130 to 10-131 
sounds 

specifying 10-189 
source files 

compiling 5-6 
Speech Guide 1-5 
split panels 5-9 
<Standard Button> command 10-57 to 10-60 
standard buttons 2-70, 2-74 
standard panel types 

action 2-53 to 2-54 
closure 2-60 
Continue 2-65 to 2-66, 2-85 

and context checks 2-87 
decision 2-52 to 2-53,2-69 
definition 2-56 to 2-58 
information 2-54 to 2-55 
introductory 2-51 
Oops 2-63 to 2-65, 2-85 

and context checks 2-87 to 2-88, 2-91 
panels associated with Huh? buttons 2-61 to 

2-63,2-79 
related topics 2-58 to 2-59 
tip 2-55 to 2-56 
transition 2-59 to 2-60 

Standard Resources file 5-4, C-5 
Standard Setup file 5-4, C-4 to C-5 
<Starting Res Number> command 10-103 to 

10-105 
<Start Making Sure> command 10-168 to 10-171 

<Startup Window> command 10-21 to 1Q-23 
stemming 2-32,3-12 to 3-14 
strings 

specifying 10-6 
styled text 2-47. See also formats 
styles 2-47 
SurfWriter Guide 

source files for C-1 to C-50 
symbol files 

compile option 5-9 
creating 5-9 

<Synonym> command 10-149 to 10-152 
synonym lists 3-13 
system software guide files 1-4 

T 

Tag and Body format 2-43 to 2-45 
for action panels 2-51,2-54 
for long introductory panels 2-51 

Tag format 2-44 
tags 2-47, 2-54. See also Tag and Body format 
testing guide files 6-3 to 6-20 
Test Look For menu 4-7 
Test Look For utility 6-8 to 6-12 
text attributes 

and the <Define Format> command 10-85 to 
10-91 

default for panel text 10-84 
of checkboxes 10-69 
of radio buttons 10-64 to 10-65 
of standard buttons 10-57 to 10-58 

text blocks 
defining 10-82 to 10-84 

text in panels 
formatting 2-47 to 2-48 

<3D Button> command 10-60 to 10-64 
three-dimensional buttons 2-26, 2-70, 2-74 to 2-76 
tip panels 2-55 to 2-56 
title area 2-18 to 2-19, 2-25 
<Topic Area> command 10-125 to 10-126 
topic areas 2-30 to 2-35 

IN-9 
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<Topic Areas Instruction> command 10-124 
<Topic> command 10-137 to 10-139 
Topic instructions 2-17 
topics 2-30 to 2-35 
Topics button 2-17,2-19 
<Topics Instruction> command 10-134 to 10-135 
transition panels 2-59 to 2-60 
transparent formats 10-91 to 10-92 
Tutorial, component of Apple Guide 1-5 
Tutorial guide files 2-7,2-11 to 2-13 

u 
user interface 2-5 to 2-95 
utilities 

Build 5-6 
Convert 8-5 
Diagnose 6-3 to 6-8 
Localize 7-3 to 7-6 
Test Look For 6-8 to 6-12 

Utilities palette 4-5 to 4-7 

v 
<Version> command 10-11 to 10-12 
version resource 10-11 to 10-12 
Video Guide 1-5 
Video Player 1-5 
visible index terms 3-20 to 3-22 

W,X,Y,Z 

"Why can't I" heading 2-33 
window coachmarks 2-80 
windows 

coaching items in 10-108 to 10-113, 10-113 to 
10-115 

Windows Help files 
footnotes in 8-4 

IN-10 

preparing for conversion 8-3 
underlined hidden text in 8-3 

windows. See access windows 
<World Script> command 10-13 
<WorldScript> command 3-14 
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Also available from 
Addison-wesley and 

Apple Computet; Inc. 

Electronic 
Guide to 
Macintosh 
Human 
Interface 
IJesign 

Macintosh Human Interface Guidelines 
Apple Computer, Inc. 
This book provides authoritative information on the 
theory behind the Macintosh "look and feel" and the 
practice of using individual interface components. 
Anyone designing or creating a product for Macintosh 
computers needs to understand these core principles. 
Key topics address how people interact with computers, 
effective use of color, guidelines for using language 
clearly and consistently, and suggestions for creating 
an effective design process. 
0-201-62216-5 $29.95 paperback, 416 pages 

Electronic Guide to Macintosh Human 
Interface Design 
Apple Computer, Inc. 
This CD-ROM combines the full electronic text of the 
classic book, Macintosh Human Inteiface Design with 
the multimedia presentations of Making It Macintosh on 
one convenient and easy-to-use disc. This interactive 
guide contains more than l 00 animated examples that 
demonstrate the correct use of Macintosh interface 
elements, including visual examples illustrating the 
appearance and behavior of menus, windows, dialog 
boxes, and icons. 
0-201-409 7 6-X $49.95, Macintosh CD-ROM 



AppleScript 

Order Information 

AppleScript Finder Guide 
Apple Computer, Inc. 
The defmitive description of how the exciting new 
AppleScript scripting language works with the Finder, 
the application that controls the Macintosh desktop. 
You'll learn how to automate some of the most com­
monly performed activities on the Macintosh, such as 
opening and closing folders, and manipulating files. 
0-207-40970-0 $79.95 paperback, 776 pages 

AppleScript Language Guide 
Apple Computer, Inc. 
This invaluable introduction to AppleScript contains 
an exhaustive reference section that describes how to 
use the value classes, commands, object classes, refer­
ence forms, expressions, control statements, handlers, 
and script objects recognized by AppleScript. Three 
handy appendices summarize AppleScript terms, define 
terms understood by the Scriptable Text Editor, and 
detail error messages. 
0-207-40735-3 $29.95 paperback, 476 pages 

AppleScript Scripting Additions Guide 
Apple Computer, Inc. 
A companion to AppleScript Language Guide, this book 
provides all the information a programmer needs to 
begin writing effective scripting additions. Together 
with introductory material, this book shows how to 
install any scripting additions and invoke their com­
mands, write scripting additions, and use the standard 
scripting additions commands. 
0-207 -40736-7 $78.95 paperback, 744 pages 

Available wherever computer books are sold. Please calll-800-822-6339 for the location 
of your nearest booksto re or to place your order. If you would like information about bulk 
quantity discounts direct from the publisher, please call our Corporate, Government, and 
Special Sales Department at 1-800-238-9682. 



Addison-Wesley warrants the enclosed disc to be free of defects in materi­
als and faulty workmanship under normal use for a period of ninety days 
after purchase. If a defect is discovered in the disc during this warranty 
period, a replacement disc can be obtained at no charge by sending the 
defective disc, postage prepaid, with proof of purchase to: 

Addison-Wesley Publishing Company 
Editorial Department 

Trade Computer Books Division 
One Jacob Way 

Reading, MA 01867 

After the 90-day period, a replacement will be sent upon receipt of the 
defective disc and a check or money order for $10.00, payable to Addison­
Wesley Publishing Company. 

Addison-Wesley makes no warranty or representation, either express or 
implied, with respect to this software, its quality, performance, merchanta­
bility, or fitness for a particular purpose. In no event will Addison-Wesley, 
its distributors, or dealers be liable for direct, indirect, special, incidental, or 
consequential damages arising out of the use or inability to use the soft­
ware. The exclusion of implied warranties is not permitted in some states. 
Therefore, the above exclusion may not apply to you. This warranty pro­
vides you with specific legal rights. There may be other rights that you may 
have that vary from state to state. 



The CD contains essential tools and 
resources to develop guide files, including: 

• Guide Maker, the software you need to build, test, and 
localize guide files 

• sample guide files 

• sample source files 

• sample context checks 

• Apple Guide interface files 

• a searchable command reference to all Guide 
Script commands 


